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KATA PENGANTAR 
 

Android merupakan salah satu pemain besar dalam pasar ponsel, 
dimana pangsa pasarnya terus berkembang. Eksistensi Android ini 
terutama merupakan sebuah platform terbuka, lengkap dan 
menawarkan beragam kesempatan bagi para programmer untuk 
mengembangkan aplikasi berbasis mobile. 

Perangkat lunak yang digunakan untuk pengembangan aplikasi 
mobile dalam buku ini adalah Eclipse, karena telah disediakan sebuah 
bundle aplikasi dimana Eclipse telah terintegrasi dengan Android 
Development Tools (ADT) dan Android Sorftware Development Kit 
(SDK), sehingga proses instalasi dan konfigurasi dapat dilakukan 
dengan mudah. Di sisi lain salah satu faktor penting dalam 
pengembangan aplikasi mobile menggunakan Android adalah 
pemahaman terhadap konsep pemrograman berorientasi objek dengan 
bahasa pemrograman Java yang menjadi tulang punggung teknik 
penulisan kode program Android. 

Buku ini menyajikan pembahasan buku dalam beberapa bab yang 
berisi mengenai penggunaan komponen graphical user interface (GUI) 
untuk membangun aplikasi yang dapat berinteraksi dengan user. Hal ini 
dimaksudkan, supaya dalam pengembangan aplikasi basis data telah 
mampu menguasai bagaimana teknik menyajikan data, sehingga 
dengan mudah menampilkan data yang berasal dari basis data 
relasional. 

Buku ini disusun supaya dapat dikupas dalam satu semester 
perkuliahan untuk menunjang matakuliah pemrograman aplikasi mobile, 
pemrograman internet maupun matakuliah  lain yang menggunakan 
pemrograman Android sebagai salah satu materi dalam perkuliahan. 

Banyak hal yang masih perlu digali dalam upaya menjadikan isi dari 
buku ini menjadi semakin berbobot. Untuk itu saran dan masukan yang 
membangun penulis terima dengan tangan terbuka, demi perbaikan di 
masa yang akan datang. Buku ini didedikasikan bagi orang – orang di 
sekelilingku yang telah memberikan doa, cinta, dukungan serta 
persahabatan yang tulus. 

Palembang, Mei 2019 

Penulis
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BAB 1 
PENGANTAR PEMROGRAMAN ANDROID 

1.1 SEJARAH ANDROID 

Android merupakan sebuah sistem operasi yang bersifat 
terbuka (open) dan gratis (free) yang berjalan pada beragam 
device seperti handphone, tablet, jam tangan dan televisi. 
Android Inc. didirikan di Silicon Valley, California, pada bulan 
Oktober 2003, dengan gagasan menyediakan platform mobile 
yang lebih sadar lokasi pengguna dan preferensi. Kemudian 
pada tahun 2005 Google melakukan akuisisi Android. Tujuan 
utama Google adalah untuk menyediakan platform yang 
terbuka penuh, dengan didukung oleh teknologi Google, baik 
untuk para pengguna  maupun pengembang aplikasi 
(programmer). Kemudian pada bulan November 2007, Open 
Handset Alliance didirikan sebagai konsorsium yang 
bertujuan mengembangkan standar terbuka untuk perangkat 
mobile. Open Handset Alliance memulai debutnya dengan 
mengumumkan platform Android. Dalam waktu kurang dari 
satu tahun, banyak anggota baru mulai bergabung dalam 
konsorsium ini. 

Android merupakan salah satu pemain utama di pasar 
ponsel. Berdasarkan analisis pasar, rata-rata 700 ribu 
perangkat Android diaktifkan setiap hari, dan lebih dari 200 
juta perangkat yang sudah diaktifkan. Android menurut survey 
yang dilakukan tahun 2012 memiliki 48% dari pangsa pasar 
ponsel, dan terus berkembang pesat (Cinar, 2012). Android 
merupakan sebuah susunan perangkat lunak yang terdiri dari 
sistem operasi, middleware dan seperangkat Application 
Programming Interface (API) yang menyediakan 
fungsionalitas bagi pengembangan aplikasi mobile berbasis 
Java. Kernel yang digunakan oleh Android merupakan sistem 
operasi Linux (Shah, 2013). 

File Installer sebagai aplikasi yang siap dieksekusi dalam 
Android dikenal dengan .apk (android package). Platform 
Android menyediakan kerangka kerja API yang menyediakan: 
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• paket dan class yang siap digunakan dalam lingkungan 
pemrograman aplikasi Android; 

• seperangkat elemen XML untuk mendefinisikan file 
manifest, mendeklarasikan dan mengakses resources; 

• separangkat pendefinisian intent; 

• separangkat permission untuk bekerja dengan perangkat 
eksternal. 

Android merupakan sebuah sistem operasi mobile yang 
berbasis kernel linux dengan melakukan sedikit modifikasi. 
Sebagai sistem operasi, Android menyediakan beberapa fitur 
seperti layaknya sistem operasi pada umumnya seperti 
berikut: 

• Storage, menyediakan database SQLite sebagai sebuah 
relational database untuk penyimpanan data. 

• Connectivity, mendukung komunikasi GSM/EDGE, IDEN, 
CDMA, EV-DO, UMTS, Bluetooth, Wi-fi, LTE, dan WiMax. 

• Messaging, mendukung MMS dan SMS. 

• Web browser, dengan menggunakan Web kit dan 
Chrome yang tersedia di dalamnya. 

• Multimedia, mendukung beragam format data multimedia 
seperti H.263, H.264 (dalam 3GP ataupun MP4 container), 
MPEG-4 SP, AMR, AMR-WB (dalam 3GP container), 
AAC, HE-AAC (di dalam MP4 atau 3GP container), MP3, 
MIDI, Ogg Vorbis, WAV, JPEG, PNG, GIF, dan BMP. 

• Hardware, mendukung penggunaan perangkat keras 
external sebagai sensor seperti Accelerometer, Camera, 
Digital Compass, Proximity Sensor, dan GPS. 

• Multi-touch, mendukung multi touch layar sentuh. 



 

3 
 

• Multi-tasking, mendukung pengembangan aplikasi multi-
tasking. 

• Thetering, mendukung koneksi internet yang berfungsi 
sebagai wired/wireless hotspot. 

Dengan beragam fungsionalitas dukungan yang 
disediakan oleh Android menjadikan daya tarik bagi 
pengembang aplikasi (programmer). Selain itu di pasar 
elektronika, Android juga terpasang pada beberapa device 
seperti smartphone, tablet, e-reader device, netbook, MP4 
player, dan internet TV. 

1.2 ARSITEKTUR ANDROID 

Sistem operasi Android adalah tumpukan komponen 
software yang dibagi menjadi lima bagian dan empat lapisan 
utama seperti yang ditunjukkan dalam diagram arsitektur 
seperti Gambar 1.1. 

KERNEL LINUX 

Pada lapisan paling bawah terdapat kernel linux yang 
menyediakan dasar  fungsionalitas sistem seperti manajemen 
proses, manajemen memori, manajemen perangkat keras 
seperti keypad, display, kamera dan sebagainya. Kernel linux 
ini juga berhubungan dengan beberapa hal yang memastikan 
Android dapat bekerja dengan baik, seperti fungsionalitas 
yang berhubungan dengan jaringan, dan driver yang 
berhubungan dengan beberapa perangkat keras eksternal. 

KUMPULAN LIBRARY 

Pada lapisan berikutnya yang berada di atas kernel linux 
terdapat kumpulan library yang berhubungan dengan library 
open source seperti web kit, library untuk menyimpan basis 
data menggunakan SQLite, library untuk merekam dan 
memainkan audio/video, library SSL yang berhubungan 
dengan komunikasi internet secara aman, dan sebagainya. 
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ANDROID RUNTIME 

Android Runtime merupakan bagian ketiga pada arsitektur 
Android yang berada satu level dengan kumpulan library. 
Bagian ini terdapat komponen yang disebut Dalvik Virtual 
Machine (DVM), yang berperan seperti Java Virtual Machine 
(JVM) yang secara khusus dirancang dan digunakan untuk 
mengoptimalkan kinerja Android. Dalvik VM memanfaatkan 
fitur inti Linux seperti manajemen memori dan multi-threading, 
yang intrinsik dalam bahasa Java. Dalvik VM memungkinkan 
setiap aplikasi Android untuk berjalan dalam prosesnya 
sendiri. Android Runtime juga menyediakan satu set inti 
perpustakaan yang memungkinkan pengembang aplikasi 
Android untuk menulis aplikasi Android menggunakan standar 
bahasa pemrograman Java. 

APPLICATION FRAMEWORK 

Lapisan Application Framework menyediakan berbagai 
layanan tingkat tinggi untuk aplikasi dalam bentuk kelas Java. 
Pengembang aplikasi Android diperbolehkan untuk 
memanfaatkan layanan ini dalam aplikasi yang 
dikembangkan. 

APPLICATION 

Lapisan Application merupakan lapisan paling atas, 
dimana semua aplikasi Android dapat dijalankan oleh user 
seperti aplikasi daftar kontak, browser internet, game, dan 
sebagainya. 
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Gambar 1.1 Arsitektur Android 

1.3 KOMPONEN APLIKASI 

Komponen aplikasi merupakan blok bangunan penting 
dari aplikasi Android. Komponen ini berhubungan erat dengan 
pengaturan yang terdapat di dalam file AndroidManifest.xml, 
sebagai tempat untuk mendeskripsikan masing-masing 
komponen dan bagaimana antar komponen tersebut saling 
berinteraksi. Terdapat beberapa komponen utama dalam 
mengembangkan sebuah aplikasi Android, yaitu: 

• Activity, berubungan dengan rancangan graphical user 
interface (GUI) untuk berinteraksi dengan user. Activity 
dapat dipahami seperti layaknya sebuah form atau 
halaman web, dimana  user dapat melakukan aktifitas 
untuk mengisi nilai ke dalam sebuah teks isian, memilih 
sebuah item dari daftar yang sediakan, ataupun mengklik 
sebuah tombol untuk melakukan proses tertentu. 

• Services, yang berhubungan dengan pemrosesan 
sebuah aplikasi yang bekerja di belakang layar. Contoh 
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dari sebuah services adalah pada saat user memainkan 
musik di latar belakang pada saat berada dalam aplikasi 
yang berbeda, atau mungkin mengambil data melalui 
jaringan tanpa menghalangi interaksi dengan aktivitas 
yang sedang dilakukan. 

• Broadcast Receivers, yang bertugas untuk melakukan 
komunikasi antara sistem operasi Android dengan 
aplikasi. Sebagai contoh misalnya aplikasi dapat 
memberitahu bahwa proses download file telah selesai 
dilakukan dan memberikan saran aplikasi yang dapat 
digunakan untuk membuka file yang bersesuaian. 

• Content Providers, komponen ini berhubungan dengan 
pemrosesan data. 

• Fragment, yang berhubungan dengan porsi ataupun 
ukuran display dan perilakunya terkait dengan Activity. 

• View, berhubungan dengan komponen graphical user 
interface (GUI) yang nantinya digunakan dalam 
membangun aplikasi. 

• Layout, berhubungan dengan bagaimana teknik 
menyusun dan menempatkan beragam komponen user 
interface dalam sebuah Activity. 

• Intent, merupakan teknik untuk saling berkirim data dan 
informasi yang melibatkan lebih dari satu Activity. 

• Resources, berhubungan dengan file XML yang menjadi 
bagian penting dari penyediaan data aplikasi, seperti 
kumpulan teks untuk judul, berbagai ukuran satuan 
dimensi, daftar spesifikasi warna, dan informasi penting 
lainnya. 

• Manifest, setiap aplikasi Android pasti memiliki file 
AndroidManifest.xml sebagai tempat untuk melakukan 
konfigurasi bagaimana sebuah aplikasi Android bekerja 
nantinya, seperti pengaturan Activitiy mana yang akan 
dimuat pertama kali pada saat aplikasi Android 
dijalankan, pengaturan aplikasi yang dapat berhubungan 
dengan koneksi internet, izin aplikasi untuk mengakses 
kamera maupun media penyimpanan luar, dan 
pengaturan penting lainnya. 
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1.4 PERSIAPAN PENGEMBANGAN APLIKASI 

Hal penting yang perlu dipersiapkan sebelum melakukan 
pengembangan aplikasi Android adalah melakukan instalasi 
dan konfigurasi perangkat lunak yang diperlukan selama 
pembuatan aplikasi. Semua paket aplikasi yang diperlukan 
telah dikemas dalam CD yang disertakan dalam buku ini, 
sehingga memudahkan untuk melakukan persiapan 
pembuatan aplikasi. Beberapa software yang diperlukan 
diantaranya: 

• Java versi 1.5 ke atas 

• Eclipse 4.2 (Juno) 

• Android SDK 

1.4.1 INSTALASI JDK 

Sebelum dapat menggunakan Eclipse, maka dalam 
komputer harus terlebih dahulu terinstall JDK versi 1.5 ke 
atas. Di dalam komputer harus terinstall Java Run Time 
Environment (JRE), karena Eclipse merupakan program yang 
dikembangkan berbasis Java sehingga memerlukan JRE 
tersebut untuk menjalankan aplikasi. Jika instalasi JDK ini 
belum dilakukan, maka pada saat pertama kali menjalankan 
Eclipse akan ditemui pesan kesalahan seperti tampilan pada 
Gambar 1.2. 

 

Gambar 1.2 Pesan Error Perlunya JRE 
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Paket instalasi JDK tersedia di dalam CD yang disertakan 
dalam buku ini ataupun dapat langsung mengunjungi alamat 
web 
http://www.oracle.com/technetwork/java/javase/downloads/ind
ex.html. Sun Java SE diperlukan untuk melakukan kompilasi 
aplikasi Android yang dikembangkan. Untuk memastikan 
bahwa versi Java telah diinstal di komputer dapat dilakukan 
dengan mengetikkan perintah melalui command DOS prompt 
seperti pada tampilan Gambar 1.3. 

 

Gambar 1.3 Versi Java Yang Terinstall di Komputer 

1.4.2 INSTALASI ECLIPSE 

Program Eclipse sudah dikemas dan telah terdapat 
Android Development Tools (ADT) di dalamnya, yang 
tentunya hal ini untuk memudahkan proses instalasi. File 
installer Eclipse telah disediakan di dalam CD yang menyertai 
buku ini dan dapat dengan mudah diekstrak kemudian 
dijalankan file Eclipse.  

 

Gambar 1.4 File Instaler Eclipse 
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Lokasi ekstrak file dapat ditempatkan di mana saja, 
karena pada dasarnya kita memerlukan file Eclipse.exe untuk 
dijalankan yang ada dalam folder Eclipse. Pada Gambar 1.5 
diperlihatkan file hasil ekstrak Eclipse ADT bundle, yang 
didalamnya terdapat folder Eclipse, SDK serta file SDK 
Manager.exe ditempatkan pada folder D:\DBAndroid\. Sampai 
tahap ini proses instalasi Eclipse telah selesai dilakukan dan 
siap untuk menjalankan Eclipse. Sedangkan folder SDK berisi 
platform SDK Android yang dapat diupdate dengan 
menggunakan file SDK Manager.exe. 

 

Gambar 1.5 Hasil Ekstrak File Instaler Eclipse 

1.4.3 MENGHUBUNGKAN ANDROID SDK DENGAN ECLIPSE 

Untuk memulai pemrograman Android diperlukan tahapan 
menghubungkan Eclipse dengan Android SDK yang bertujuan 
menentukan project Android dengan target platform level API 
tertentu. Hal ini dapat dilakukan melalui menu 
Window>Preferences, selanjutnya akan dimunculkan 
window seperti pada Gambar 1.6. Dengan memilih Android 
pada panel bagian kiri, maka dimunculkan SDK Location, 
dengan mengklik tombol Browse tentukan lokasi folder SDK 
dan pilih sebagai sumber preferensi. Selanjutnya secara 
otomatis akan dimunculkan daftar level API yang sudah 
diupdate melalui SDK Manager. Teknik update penggunaan 
SDK Manager akan dibahas pada sub bab selanjutnya pada 
bagian lingkungan kerja Eclipse. 

Pada Gambar 1.6 terlihat bahwa lokasi Android SDK 
berada di alamat D:\DBAndroid\adt-bundle-windows-x86-
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20140702\sdk yang di dalamnya telah terdapat Level API 19 
(Android 4.4.2). Lokasi file SDK ini dapat di tempatkan 
dimana saja, sehingga sewaktu-waktu dapat diatur lokasinya, 
jika di kemudian hari akan mencoba menggunakan Level API 
yang berbeda dan lokasi file yang berbeda. 

 

Gambar 1.6 Window Preferences 

1.5 LINGKUNGAN KERJA ECLIPSE 

Salah satu aspek penting dalam pengembangan aplikasi 
adalah mengenal lingkungan kerja pengembangan perangkat 
lunak. Dalam pemrograman aplikasi Android, buku ini 
menggunakan IDE Eclipse 4.2 (versi Juno). Sehingga 
pemahaman terhadap lingkungan kerja Eclipse menjadi salah 
satu faktor penting keberhasilan pembuatan program Android. 

1.5.1 PROJECT EXPLORER 

Window Project Explorer merupakan perangkat yang 
digunakan untuk melihat seluruh folder dan file yang menjadi 
bagian dari sebuah project. Secara default sebuah project 
dalam Eclipse akan disimpan dalam sebuah folder yang 
ditempatkan di dalam folder workspace yang didefinisikan 
pada saat pertama kali menjalankan Eclipse. Konfirmasi 
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mengenai lokasi penyimpanan workspace dapat dilihat pada 
Gambar 1.7. Lokasi workspace dapat diubah dengan 
mengklik tombol Browse pada bagian kanan alamat 
workspace. Kemudian untuk menentukan lokasi penyimpanan 
workspace secara permanen dapat diklik centang pada 
pilihan Use this as the default and do not ask again, dan 
dengan sendirinya pada saat Eclipse dimuat pertama kali 
window ini tidak akan dimunculkan lagi. 

 

Gambar 1.7 Penempatan Workspace 

Pada saat pembuatan sebuah project di dalam Eclipse, 
secara otomatis akan dibuat oleh Android Development 
Tools (ADT) beberapa buah folder dan file untuk 
kelengkapan aplikasi. Gambar 1.8 memperlihatkan struktur 
folder dan file dari sebuah Project Android. 
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Gambar 1.8 Tampilan Project Explorer 

Table 1.1 memberikan penjelasan singkat mengenai fungsi 
dari masing-masing folder dan berkas yang ada dalam 
sebuah Project. 

Tabel 1.1 Deskripsi Folder dan File Project Eclipse 

Folder Fungsi 

/src Dalam folder inilah terdapat file 
program java 

/gen Berisi file yang secara otomatis di-
generate oleh Eclipse yang berisi file 
BuildConfig.java serta R.java. 
Kedua file ini sangat penting untuk 
dapat mengembangkan aplikasi 
Android. Pada saat pertama kali 
pembuatan project, pastikan kedua 
file ini telah berhasil di-generate di 
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dalam project. Untuk mengaktifkan 
supaya kedua file ini di-generate oleh 
Eclipse, dapat diaktifkan fitur Build 
Automatically, dengan melakukan 
centang pada menu Project > Build 
Automatically. Pembahasan 
mengenai kedua file ini dapat 
ditemukan pada pembahasan di 
dalam sub bab ini pada topik 
penanganan error. 

/assets Tempat untuk menempatkan font, 
video, audio. Dalam folder ini dapat 
juga ditempatkan file css, javascript 
dan file lainnya. 

/libs Untuk menempatkan file library 
eksternal yang biasanya berupa file 
dengan ekstensi .jar 

/res Tempat untuk menempatkan gambar, 
layout dan variable global 

/drawable-xhdpi Folder untuk menyimpan objek 
gambar yang digunakan oleh 
perangkat mobile extra high 
specification devices seperti tablet, 
Galaxy SIII, HTC One X 

/drawable-hdpi Folder untuk menyimpan objek 
gambar yang digunakan oleh 
perangkat mobile high specification 
devices seperti SGSI dan SGSIII 

/drawable-mdpi Folder untuk menyimpan objek 
gambar yang digunakan oleh 
perangkat mobile medium 
specification devices seperti Galaxy 
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W, HTC Desire 

/drawable-ldpi Folder untuk menyimpan objek 
gambar yang digunakan oleh 
perangkat mobile low specification 
devices seperti Galaxy Y, HTC 
WildFire 

/layout Folder ini berisi file yang dikemas 
dalam bentuk XML, sebagai 
representasi tampilan graphical user 
interface (GUI) untuk berinteraksi 
dengan user 

/menu Folder untuk menyimpan file XML 
yang digunakan untuk membuat 
menu dalam display 

/values Berisi konstanta global  

/values-v11 Untuk mendefinisikan style device 
pada level API 11 dengan codename 
Honeycomb 

/values-v14 Untuk mendefinisikan style device 
pada level API 14 

AndroidManifest.XML Merupakan salah satu file paling 
penting dalam aplikasi Android. 
Merupakan file yang akan dikenali 
oleh Android pada saat pertama kali 
sebuah project aplikasi akan 
dijalankan. File ini berisi property dari 
aplikasi, deklarasi Activity dan 
sejumlah permission untuk 
mendefinisikan hubungan dengan 
device dan koneksi eksternal. 
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1.5.2 CODE EDITOR 

Sesuai dengan namanya, bagian ini merupakan tempat 
penulisan kode program Java seperti diperlihatkan pada 
Gambar 1.9. Di dalam Code Editor ini akan dimunculkan 
pesan-pesan kesalahan jika pada saat penulisan kode 
program terjadi syntax error, auto list yang muncul ketika 
melakukan penulisan program, dan beragam fitur lainnya 
yang tujuan utamanya adalah membantu programmer untuk 
menghasilkan kode program yang benar dari sisi penulisan 
kode program. 

Untuk mengubah tampilan dari Code Editor ini dapat 
dilakukan dari menu Window > Preference, kemudian pada 
menu Preference pilih General > Appearance > Colors and 
Fonts, kemudian klik Edit To Customize seperti dapat dilihat 
pada Gambar 1.10. 

 

Gambar 1.9 Tampilan Code Editor 
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Gambar 1.10 Mengubah Tampilan Code Editor 

1.5.3 Editor Layout GUI 

Desain tampilan graphical user interface (GUI) merupakan 
tampilan layar yang nantinya terlihat di aplikasi Android. 
Halaman layar ini dikenal dengan istilah Activity. File desain 
GUI ini disimpan di folder /res/layout dengan ekstensi file 
XML. 

Gambar 1.11 dan dan Gambar 1.12 memperlihatkan 
tampilan GUI dalam mode desain/grafis dan mode kode 
program XML. Untuk berpindah mode tampilan ini, cukup 
dilakukan dengan cara mengklik Tab Graphical Layout 
ataupun pilihan file XML. 
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Gambar 1.11 Mode Tampilan Desain 

 

Gambar 1.12 Mode Tampilan Kode XML 
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1.5.4 Palette Window 

Menu ini menyediakan objek-objek yang akan digunakan 
pada lembaran Activity dalam mode tampilan desain layout. 
Tampilan Palette Window seperti dapat dilihat pada Gambar 
1.13. 

Untuk menempatkan komponen GUI, cukup dilakukan 
dengan cara klik dan drag objek yang ada dalam palette 
window kemudian tempatkan pada layout GUI, dan secara 
otomatis akan dihasilkan kode dalam bentuk XML pada file 
XML yang telah ditambahkan komponen. 

 

Gambar 1.13 Tampilan Palette Window 

1.5.5 Properties Window 

Menu ini digunakan untuk mendefinisikan property yang 
melekat pada sebuah objek, tampilan Properties Window 
diperlihatkan pada Gambar 1.14. Untuk mengubah nilai 
property cukup dilakukan dengan mengklik tombol bertuliskan 
tanda titik sebanyak tiga (…) dan akan ditampilkan window 
untuk memberikan nilai property tersebut. 
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Gambar 1.14 Properties Window 

1.5.6 Outline Window 

Menu ini berisi objek-objek apa saja yang telah ditampilkan 
dalam sebuah Activity, sehingga akan memudahkan 
pengembang aplikasi untuk melihat dan menginventarisir 
objek-objek yang menjadi bagian dari sebuah aplikasi yang 
sedang dibangun. Tampilan Outline Window seperti 
diperlihatkan pada Gambar 1.15. 

 

Gambar 1.15 Tampilan Outline Window. 
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1.5.7 Debugging Pane 

Menu ini digunakan untuk melihat jika terdapat salah 
penulisan kode program (syntax error), adanya pesan penting 
berupa peringatan (warning), pesan jika terjadi error pada 
saat eksekusi sebuah aplikasi (runtime-error) dan window 
LogCat yang dapat digunakan untuk menelusuri kejadian 
yang mengiringi sebuah Activity pada saat aplikasi dijalankan 
di dalam emulator ataupun real device. Tampilan jendela 
Debug Pane dapat dilihat pada Gambar 1.16 dan posisinya 
berada tepat di bawah Code Editor. 

 

Gambar 1.16 Tampilan Debug Pane 

1.5.8 Android SDK Manager 

Untuk melakukan Update Android SDK dapat 
mengaktifkan menu SDK Manager dengan memilih menu 
Window > SDK Manager atau melalui tool bar yang ada tepat 

di bawah menu bar dengan mengklik icon . Tampilan 
jendela Android SDK Manager dapat dilihat seperti Gambar 
1.17. Perlu menjadi catatan, bahwa akan lebih baik jika 
semua paket dalam sebuah level API dalam contoh ini adalah 
level API 16 didownload semua terutama pada item system 
image yang digunakan untuk membuat sebuah Android 
Virtual Device (AVD). 
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Gambar 1.17 Jendela Android SDK Manager 

1.5.9 Android Virtual Device Manager 

Menu ini digunakan untuk membuat sebuah emulator 
sebagai pengganti perangkat smartphone yang berjalan di 
komputer. Emulator akan bekerja layaknya sebuah perangkat 
smartphone, tanpa menggunakan perangkat fisik. Setelah 
sebuah emulator dijalankan, maka aplikasi Android yang telah 
dibuat dapat dijalankan sebagaimana menggunakan 
smartphone secara fisik, bedanya pada penggunaanya 
dilakukan dengan klik mouse seperti untuk memilih menu 
maupun menulis melalui keyboard internal dalam emulator. 
Untuk mengaktifkan menu Android Virtual Device Manager 
dapat dilakukan melalui menu Window > Android Virtual 

Device Manager, atau dengan mengklik icon  pada 
toolbar, kemudian ditampilkan menu seperti Gambar 1.18. 
Sedangkan Gambar 1.19 merupakan tampilan Emulator yang 
telah aktif. 
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Gambar 1.18 Tampilan Android Virtual Device Manager 

 

Gambar 1.19 Tampilan Emulator Aktif 
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1.5.10 Dalvik Debug Monitor Server (DDMS) 

DDMS dapat digunakan untuk melihat property ataupun 
informasi yang melekat pada Emulator maupun Device yang 
terhubung dengan komputer pada saat melakukan 
pengembangan aplikasi Android. Untuk mengaktifkan fitur 
DDMS dalam Eclipse dapat dilakukan melalui Windows > 
Open Perspective > Other > pilih DDMS. Kemudian akan 
ditampilkan window DDMS seperti pada Gambar 1.20. 

Secara fisik file ddms.exe dapat ditemukan pada folder 
sdk/tools/ddms.exe. Informasi yang melekat pada DDMS 
diantaranya Device yang berisi daftar device yang terhubung 
dengan komputer pada saat pengembangan aplikasi, baik 
emulator maupun real device. Informasi penting lainnya yang 
perlu diperehatikan adalah File Explorer yang berisi informasi 
file system dalam sebuah device. 

 

Gambar 1.20 Window DDMS 

1.5.11 Menjalankan Aplikasi 

Untuk menjalankan aplikasi Android yang telah selesai 
dikembangkan, dapat memilih dari menu Run > Run. Atau 
dengan klik kanan pada nama Project yang ada dalam 
Window Explorer > Run As > Run Configuration untuk 
menentukan setting eksekusi aplikasi. 
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Dalam menu Run Configurations terdapat bagian penting, 
yaitu di sebelah kiri terdapat daftar project android yang telah 
dibuat, kemudian dengan memilih salah satu project, 
berpindah ke menu Tab Target, pilih option Always Prompt to 
Pick Device. Pilihan ini akan mengkonfirmasi setiap 
menjalankan aplikasi android untuk memilih device mana 
yang akan dijadikan sebagai target untuk menampilkan 
aplikasi seperti dapat dilihat pada Gambar 1.21. 

 

Gambar 1.21 Tampilan Run Configurations 

1.6 MEMPERBAIKI ERROR DI ECLIPSE 

Setelah semua proses persiapan pengembangan aplikasi 
selesai dilakukan, terkadang terdapat beberapa kesalahan 
dan pesan error yang muncul. Kesalahan tersebut 
dikarenakan adanya proses instalasi yang tidak sempurna, 
ataupun karena perilaku dari lingkungan Eclipse sendiri yang 
mengakibatkan terjadinya error. 

1.6.1 MEMPERBAIKI ERROR appcompatv7 

Setiap membuat project baru menggunakan IDE Eclipse 
(adt-bundle-windows-x86-20140702) secara otomatis akan 
ditambahkan folder project appcompat_v7 dalam window 
Project Explorer. Tujuannya untuk memberikan compatibility 
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terhadap versi Android sebelumnya, mulai dari API Level 8 
(Android 2.2 Froyo) sampai dengan Level API 13. Hal ini 
terjadi jika pada saat pembuatan sebuah project, pada pilihan 
Minimum Required SDK dipilih android level API 13 ke 
bawah. Jika yang dipilih level API 14 ke atas, folder ini tidak 
akan dimunculkan. Konsekuensi dari proses ini adalah 
terdapat pesan error pada folder project seperti dapat dilihat 
pada Gambar 1.22. 

 

Gambar1.22 Pesan Error Terkait Kompatibilitas 

 

Folder project appcompat_v7 secara 
otomatis akan disertakan setiap kali 
Eclipse membuat project dengan 
minimum required SDK sampai level 
API 13. Jika pada proses pembuatan 
project minimum required SDK diganti 
level API 14 (IceCream Sandwich) 
maka folder project appcompat_v7 
tidak akan diikut sertakan. 

Untuk memperbaiki error yang terjadi, dapat dilakukan 
beberapa langkah seperti berikut: 

1. Pastikan telah melakukan download extras terbaru 
yaitu: Android Support Repository, Google Play 
services, Google Repository, dan Android 4.4.2 SDK 
(API 19) Platform melalui SDK Manager seperti dapat 
dilihat pada Gambar 1.23. 
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Gambar 1.23 Download Extras SDK Manager 

2. Pastikan fitur Build Automatically dalam keadaan aktif, 
dengan cara mencentang dari menu Project > Build 
Automatically. 

3. Selanjutnya buka project, klik kanan > Project Properties 
yang ada pada file appcompat_v7 atau android-support-
v7-appcompat, lalu ubah nilai target menjadi 
target=android-16 seperti diperlihatkan pada Gambar 1.23. 
pastikan centang pada Is Library, karena project ini 
merupakan sebuah library. 

4. Kemudian berpindah ke bagian Java Build Path seperti 
pada Gambar 1.24, masuk pada bagian Tab Order and 
Export, pilih dan centang pada Android 4.4.2. setelah itu 
klik tombol OK. 
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Gambar 1.24 Memilih Level API 

 

Gambar 1.25 Memilih Level API Java Build 
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5. Jika fitur Build Automatically dalam kondisi aktif, maka 
dengan sendirinya file project appcompat_v7 tidak ada 
indikator error. 

6. Jika fitur Build Automatically dalam keadaan off, lakukan 
clean project dengan mengaktifkan pilihan menu Projects 
>Clean 

 

 

Untuk menghindari terjadinya error 
dengan disertakannya folder 
appcompat_v7 pada project, maka 
pada pemilihan minimum required 
SDK pada saat pembuatan project 
dapat dipilih level API 14 ke atas, 
seperti level API 14,15,16 dan 
seterusnya. Maka secara otomatis, 
hanya folder project yang dibuat yang 
ditambahkan dalam window package 
explorer. 

 

1.6.2 GAGAL GENERATE FILE R.Java 

Gejala ini ditandai dengan munculnya pesan “R cannot 
be resolved to a variable”, idealnya pada saat pertama kali 
sebuah project dibuat oleh Eclipse, maka file dengan nama 
R.Java akan dibuat otomatis dan ditempatkan di folder /gen di 
dalam project. Kondisi munculnya error dapat dilihat seperti 
pada Gambar 1.26. file R ini merupakan file untuk merujuk 
seluruh resource yang ada di dalam project yang secara fisik 
disimpan dalam folder /res meliputi layout, values dan 
resource yang lain. 
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Gambar 1.26 Folder /gen Gagal Membentuk File Java 

 

Gambar 1.27 Gagal Generate File Java 

Untuk mengatasi gagal dalam generate file java dapat 
dilakukan dengan langkah-langkah berikut: 

1. Klik kanan pada Project yang mengalami masalah, 
kemudian pilih Properties sehingga dimunculkan window 
seperti pada Gambar 1.28. Pilih panel bagian kiri, 
kemudian pilih Java Build Path, kemudian pada Tab 
Order and Export pilih dan centang Android 4.1.2 (level 
API 16 yang digunakan dalam Eclipse), kemudian klik 
tombol OK. 
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Gambar 1.28 Window Project Properties 

2. Kemudian dari menu Project>pilih Build All supaya 
berpengaruh terhadap semua project yang ada dalam 
package explorer, atau pilih Project > Build Project untuk 
project yang sedang terpilih. 

3. Setelah itu dari menu Project > Clean. Jika proses berjalan 
dengan normal maka secara otomatis di dalam folder 
project di bawah folder /gen terdapat dua buah file R.Java 
dan BuildConfig.Java. Dalam kode program yang 
sebelumnya terdapat pesan kesalahan akan berjalan 
dengan normal tanpa ada pesan error. 

 

Gambar 1.29 Build Project 
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• Jika pilihan Project > Build All, ataupun 
Project > Build Project tidak aktif, hal 
ini disebabkan karena pilihan Build 
Automatically diaktifkan secara 
otomatis. Untuk menghilangkan build 
secara otomatis, tinggal non aktifkan 
pilihan centang pada Build 
Automatically. 

• Lakukan Project>Clean secara 
berulang-ulang, sampai peringatan 
error yang ada dalam project menjadi 
hilang. 

• Jika setelah langkah-langkah 
Project>Build Project, dan 
Project>Clean dilakukan secara 
berulang dan file BuildConfig.java 
serta R.java tidak terbentuk pada 
folder /gen, maka lakukan 
pembuatan project baru dengan 
catatan sebelum melakukan 
apapun atau setelah project 
terbentuk lakukan langkah-langkah 
penanganan error seperti sub bab 
ini. Karena jika project telah 
terbentuk, dan beberapa bagian 
project telah diubah-ubah/dibuka 
bagian tertentu, hal ini 
mengakibatkan project menjadi 
tidak dapat membentuk file R.java 
dan BuildConfig.java. 

• Alternatif lain dapat dilakukan 
dengan terlebih dahulu 
mengaktifkan fitur Build 
Automaticllay, dari menu Project > 
centang Build Automatically. 
Kemudian baru melakukan proses 
pembuatan project. Hal ini dalam 
upaya menggenerate otomatis file 
BuildConfig.java serta R.java. 
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1.6.3 ANDROID VIRTUAL DEVICE (AVD) MANAGER 
TIDAK TERBENTUK 

Kejadian yang seringkali muncul adalah gagal dalam 
membuat Android Virtual Device, hal ini terjadi karena level 
API yang digunakan belum sepenuhnya didownload yaitu 
system image yang menjadi bagian penting dalam proses 
pembuatan AVD. Jika system image belum didownload, maka 
pada proses pembuatan AVD tombol OK juga tidak aktif 
seperti dapat dilihat pada Gambar 1.30. 

Oleh karena itu untuk menangani error seperti ini 
diperlukan proses download system image melalui SDK 
Manager. Lihat Gambar 1.17 untuk melihat daftar item yang 
perlu didownload pada SDK Manager. 

 

Gambar 1.30 Gagal dalam Pembuatan AVD 

1.7 SIMPULAN 

Pada bab ini telah dikupas sejarah dan perkembangan 
platform Android, persiapan yang harus dilakukan untuk 
mengembangkan aplikasi Android dan lingkungan kerja yang 
patut dipahami oleh para pengembang aplikasi Android untuk 
memudahkan bekerja menggunakan IDE Eclipse. Pada Bab 
selanjutnya akan dikupas bagaimana membangun sebuah 
project dalam pemrograman Android. 
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BAB 2  
MEMBUAT PROJECT ANDROID 

2.1 MEMBUAT PROJECT BARU 

Menjalankan Eclipse dapat dilakukan dengan cara double 
klik file Eclipse.exe seperti diperlihatkan pada Gambar 2.1. 

 

Gambar 2.1 Lokasi Penyimpanan File Eclipse 

Setiap Eclipse mulai dimuat ke dalam memori kerja sistem 
operasi, terlebih dahulu ditampilkan window splash screen 
yang memberitahu versi Eclipse yang digunakan. Selanjutnya 
akan dimunculkan window untuk memilih direktori kerja, pada 
tahap ini pilih lokasi direktori yang telah disediakan 
sebelumnya yang beralamat di D:\DirektoriKerja. Pada 
window pemilihan workspace arahkan lokasi penyimpanan ke 
alamat tersebut dengan mengklik tombol Browse di sebelah 
kanan teks isian workspace seperti diperlihatkan pada 
Gambar 2.2. Jika dalam proses berikutnya lokasi ini dijadikan 
lokasi penyimpanan dalam pembuatan project yang lain, 
berikan centang pada pilihan Use this as default and do not 
ask again yang ada di sebelah kiri. Setelah itu klik tombol 
OK. Selanjutnya window menu utama dari Eclipse akan 
ditampilkan. 
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Gambar 2.2 Lokasi Pemilihan Workspace 

Untuk membuat project baru di Android dapat dilakukan 
dengan memilih menu File>New>Android Application 
Project. Namun perlu diingat bahwa setiap mulai membuat 
project baru, dianjurkan untuk mengaktifkan fitur Build 
Automatically. Sebagaimana dibahas pada bab 1, fitur ini 
diperlukan dalam proses generate file BuildConfig.Java dan 
R.Java pada folder /gen di dalam pembuatan project yang 
dilakukan oleh Eclipse. 

Bagi yang baru memulai membuat program menggunakan 
Android, mungkin akan mengalami beberapa kebingungan 
pada saat berhadapan dengan window New Project ini. 
Karena terdapat beberapa informasi yang perlu dimasukkan 
ke dalamnya. Beberapa informasi yang perlu dimasukkan 
pada saat pembuatan project, diantaranya: 

• Application Name : merupakan informasi mengenai nama 
aplikasi. Nama yang kita masukkan di sini nantinya akan 
menjadi nama folder tempat menyimpan file-file aplikasi. 

• Project Name : mirip dengan Application Name, pada 
umumnya memiliki nama yang sama dengan Application 
Name. Informasi yang dimasukkan disini akan menjadi 
judul aplikasi pada aplikasi Android pada saat dijalankan. 

• Package Name : merupakan nama paket dari aplikasi 
yang dikembangkan. Nama paket digunakan sebagai 
identitas (ID) pada saat aplikasi dipublish pada Google 



 

35 
 

Play Store. Lazimnya nama paket menggunakan pola 
penamaan seperti pada domain name system, seperti 
nama perusahaan, instansi, dan nama unik lainnya. Nama 
paket ini juga merupakan lokasi tempat file kode program 
Java disimpan. Sebagai contoh pada pembuatan project 
dengan nama id.ac.polsri.sapaprogrammer, maka file 
java akan ditempatkan pada <lokasi penyimpanan 
project>/src/id/ac/polsri/sapaprogrammer. 

• Minimum Required SDK : merupakan informasi level API 
yang nantinya akan menjalankan aplikasi yang dibuat. 
Sebagai contoh jika level API yang dipilih minimum adalah 
level API 14, maka aplikasi yang dikembangkan nanti 
dapat dijalankan pada Android level 14 ke atas, tapi tidak 
sebaliknya. 

• Target SDK : merupakan level API yang akan menjadi 
fokus aplikasi. Sebagai contoh jika level API yang dipilih 
adalah level API 16 (Jelly Bean), maka aplikasi akan 
berjalan dengan optimal untuk menggunakan seluruh 
fungsionalitas dan fitur yang ada pada level API 16. 

• Compile With : merupakan level API yang nantinya 
digunakan untuk mengkompilasi project. Lazimnya sama 
dengan level API yang menjadi target. 
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Gambar 2.3 Window Pembuatan Project Baru 

Pada Gambar 2.3 diperlihatkan informasi yang perlu 
dimasukkan pada saat pembuatan project. Pemilihan 
Minimum Required SDK dengan level API 14 dimaksudkan 
supaya folder appcompat_v7 tidak disertakan pada saat 
pembuatan project, yang terkadang mengakibatkan terjadinya 
Error. Setelah itu klik tombol Next, yang akan memunculkan 
window untuk memilih lokasi penyimpanan direktori project 
seperti dapat dilihat pada Gambar 2.4. Lokasi penyimpanan 
pada project ditempatkan di lokasi 
D:\DBAndroid\DirektoriKerja\SapaProgrammer.  Selanjutnya 
dapat mengklik tombol Next untuk berpindah ke window 
berikutnya. 
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Gambar 2.4 Lokasi Penyimpanan Project 

Pada Gambar 2.5 merupakan tahapan untuk membuat 
launcher icon, yaitu icon untuk mewakili aplikasi yang 
dikembangkan. Untuk tahap ini dapat dibiarkan saja, karena 
fokus pada pembahasan kali ini adalah pembuatan project. 
Selanjutnya klik tombol Next. 

 

Gambar 2.5 Window Pembuatan Launcher Icon 
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Pada Gambar 2.6 memperlihatkan proses untuk 
pembuatan Activity yang berperan sebagai display/form di 
dalam aplikasi Android. Centang pada bagian Create 
Activity, kemudian pilih Blank Activity, setelah itu klik 
tombol Next. 

 

Gambar 2.6 Window Pembuatan Activity 

Window selanjutnya yang ditampilkan adalah window 
pembuatan nama Activity seperti dilihat pada Gambar 2.7. 
Pembuatan Activity secara otomatis akan menghasilkan 2 
buah file, MainActivity merupakan file kode program java 
tempat untuk menuliskan logika program, dan file 
activity_main yang merupakan file XML yang berfungsi 
sebagai layout aplikasi. Layout merupakan desain 
halaman/form yang akan digunakan untuk berinteraksi 
dengan user.  Setelah semua tahapan proses pembuatan 
project selesai dilakukan, setelah itu klik tombol Finish untuk 
mulai membuat project. 
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Gambar 2.7 Pemberian Nama Activity 

Proses pembuatan project ini akan menyita waktu 
beberapa saat disesuaikan dengan spesifikasi komputer yang 
digunakan. Demikian juga dipengaruhi oleh level API yang 
digunakan sebagai target SDK, semakin tinggi level API maka 
proses pembuatan project juga akan bertambah karena 
semakin kompleksnya fitur aplikasi yang disediakan. Setelah 
proses pembuatan project selesai, maka akan ditampilkan 
seperti Gambar 2.8. 

Bagian penting yang perlu diperhatikan setelah proses 
pembuatan project selesai dilakukan adalah mengecek 
apakah di dalam folder /gen di bawah nama dalam project 
terdapat 2 buah file penting, yaitu BuildConfig.java dan 
R.java. Kedua file ini memiliki peran untuk menghubungkan 
antara desain layout Acitivity dalam format XML dengan file 
program java. Pastikan kedua file tersebut berhasil di-
generate oleh Eclipse pada saat pembuatan project. 
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Gambar 2.8 Project Folder 

 

Proses pembuatan project pada 
pembahasan di bab-bab selanjutnya 
tidak akan diulas kembali, karena 
tahapannya akan sama. Jadi 
diasumsikan setelah membaca bab ini, 
tidak akan mengalami kesulitan dalam 
pembuatan project. 

2.2 MENYIAPKAN FILE STRING 

Setelah sebuah project selesai dibuat, langkah 
selanjutnya adalah menyiapkan file string untuk memberikan 
keterangan dan deskripsi setiap objek yang nantinya 
dimunculkan di dalam user interface pada layar android 
seperti untuk memberi judul label, keterangan pada tombol, 
informasi aplikasi dan informasi lainnya yang berhubungan 
dengan teks. Terkait dengan penyediaan informasi teks ini 
dikenal 2 model penulisan, yaitu: 
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• Soft code, merupakan teknik memberikan informasi teks 
yang melekat pada setiap komponen user interface 
dengan terlebih dahulu menyimpan informasinya di dalam 
file /res/values/strings.xml. 

• Hard code, teknik ini lebih sederhana dengan meletakkan 
langsung informasi teks yang melekat pada komponen 
graphical user interface langsung di dalam kode program, 
tanpa menyimpannya terlebih dahulu di file 
/res/values/strings.xml. Jika teknik ini digunakan dalam 
penulisan program, maka dalam kode program akan diberi 
tanda berwarna kuning pada bagian kiri baris program. 

Cara manapun dapat dipilih oleh seorang programmer 
dalam pengembangan aplikasi Android, tetapi untuk 
dokumentasi yang baik dalam pembuatan program cara 
pertama yaitu soft code lebih dianjurkan, dalam upaya 
dokumentasi kode program yang baik. 

Pada tahapan ini dapat dicoba menggunakan teknik soft 
code. Ada 2 model pembuatan dokumentasi string (string 
resources) yaitu melalui graphical user interface (GUI) dan 
dengan menuliskannya secara langsung melalui file XML. 
Pada dasarnya file strings.xml ini berisi pasangan key-value. 
Informasi yang dapat disimpan dalam file strings.xml ini 
beragam seperti untuk menyimpan informasi warna, judul 
teks, nama, bahkan data dengan tipe array. 

Lakukan klik dua kali pada file /res/values/strings.xml 
yang ada di window package explorer, maka akan 
dimunculkan window seperti pada Gambar 2.9. Perhatikan 
pada bagian bawah window terdapat tab Resources untuk 
bekerja dengan mode GUI, dan di sebelah kanannya terdapat 
tab strings.xml untuk bekerja pada mode kode program 
dengan format file XML. Pada panel bagian tengah mode GUI 
terdapat 4 buah tombol, diantaranya: 

• Add, untuk menambah item data string. Setiap kali selesai 
melakukan penambahan pada item string, simpan dengan 
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cara menekan toolbar bergambar disket atau dari menu 
File > Save. 

• Remove, untuk menghapus item data string 

• Up, untuk memindahkan posisi item string ke posisi di atas 

• Down, untuk memindahkan posisi item string ke posisi 
bawah 

 

Gambar 2.9 Window String Resources 

Pada mode GUI klik tombol Add…, maka akan 
ditampilkan window untuk memilih jenis string yang akan 
dibuat seperti diperlihatkan pada Gambar 2.10, setelah itu klik 
tombol OK. 
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Gambar 2.10 Memilih Jenis String 

Tambahkan beberapa item data string seperti 
diperlihatkan pada Tabel 2.1. Pemberian nama dalam 
menuliskan kode program diusahakan bersifat mnemonic 
artinya sebuah nama mengandung arti yang spesifik dan 
relevan dengan nama tersebut. Sebagai contoh nama 
s_tvNama dimaknai sebagai pemberian nama dengan tipe 
string (awalan “s”) diperuntukkan untuk komponen GUI 
TextView (tv) sebagai judul bagi informasi Nama. 

Tabel 2.1 Pasangan Nilai String 

Variabel String  Nilai 

judul Sapa Programmer 

ucapan Selamat Datang 

s_tvNama Masukkan Nama Anda 

s_btnTampil Tampilkan Nama 
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Untuk melihat bagaimana tampilan dari String Resources 
dalam mode file XML, dapat mengklik tab strings.xml 
sehingga diperlihatkan seperti tampilan Gambar 2.11. 

 

Gambar 2.11 Mode Tampilan dalam Format XML 

2.3 MENDESAIN LAYOUT GUI 

Tahapan merancang antar muka grafis (graphical user 
interface, GUI) merupakan tahapan penting karena berisi 
informasi untuk berinteraksi dengan user. Tahapan ini 
menyita waktu yang cukup panjang, karena diusahakan 
mendesain tampilan sesederhana mungkin untuk 
memudahkan tahapan yang harus dilakukan oleh user 
nantinya, dan seindah mungkin sehingga tampilan yang 
menarik menjadikan seorang user nyaman dengan antar 
muka yang sedang dihadapinya. 

Tahapan ini dapat dilakukan dengan cara drag and drop 
komponen GUI yang ada pada bagian palette untuk 
ditempatkan pada form yang dalam konteks android lebih 
dikenal dengan istilah view. Sedangkan alternatif lain dalam 
membuat layout dapat dilakukan dengan menuliskan melalui 
kode program. Namun kombinasi kedua cara tersebut dapat 
saling melengkapi proses pembuatan layout dan sering 
dilakukan oleh programmer Android. 
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Untuk membuka layout, double-click file 
/res/layout/activity_main.xml dari project explorer. Pada 
bagian kiri aplikasi terdapat kumpulan Palette yang di 
dalamnya terdapat banyak sekali jenis komponen GUI sesuai 
dengan fungsinya. 

• Lakukan klik kemudian drag widget/kontrol TextView dan 
tempatkan ke bagian layout. 

• Ubah property ID dengan menekan tombol …, pada 
bagian kanan property id, pada saat dimunculkan window 
string Editor isi dengan  “@+id/tvNama” (tanpa tanda petik) 
setelah itu klik tombol OK untuk mengakhiri pemberian 
nama, perhatikan Gambar 2.12. Pemberian nama di awali 
dengan menggunakan “@+id/” yang merupakan 
representasi dari ADT. 

 

Gambar 2.12 Mengisi Property ID 

• Kemudian ubah property Text, pada properties window klik 
tombol … di sebelah kanan property Text, arahkan pada 
resources window dan pilih s_tvNama sesuai dengan yang 
sudah dibuat pada tahapan sebelumnya. Setelah itu klik 
tombol OK, kemudian simpan project sehingga perubahan 
yang telah dilakukan akan ditampilkan. 
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Gambar 2.13 Memberi Judul TextView 

• Langkah berikutnya tambahkan widget dengan EditText 
kemudian beri nama ID txtNama, letakkan di sebelah 
kanan label/TextView yang telah ditambahkan sebelumnya 
seperti dapat dilihat pada Gambar 2.14. Perhatikan pada 
property kelompok Layout Parameter > To Right Of dan 
Align Top berisi ID yang menunjuk pada @+id/tvNama. 
Pengaturan ini menempatkan objek/widget EditText 
berada di sebelah kanan dan rata atas dengan widget 
TextView yang bernama TvNama. 

 

Gambar 2.14 Menempatkan Posisi EditText 

• Selanjutnya tambahkan widget Button, kemudian 
tempatkan pada posisi tepat di bawah txtNama, perhatikan 
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pada property Below. Demikian juga untuk property rata 
kiri dan rata kanan, sehingga button melebar dari kiri ke 
kanan. Selanjutnya ubah property Text pada button … di 
sebelah kanan property text isi dengan s_btnTampil yang 
telah dibuat pada string resources, perhatikan Gambar 
2.15. 

 

 

Gambar 2.15 Menempatkan Posisi Button 

• Untuk melihat kode program yang telah dilayout dengan 
menggunakan teknik drag and drop dapat dilihat pada 
listing program berikut. 
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/res/layout/activity_main.xml 

<RelativeLayoutxmlns:android="http://schemas.android.com/apk/res/android" 
xmlns:tools="http://schemas.android.com/tools" 
android:layout_width="match_parent" 
android:layout_height="match_parent" 
android:paddingBottom="@dimen/activity_vertical_margin" 
android:paddingLeft="@dimen/activity_horizontal_margin" 
android:paddingRight="@dimen/activity_horizontal_margin" 
android:paddingTop="@dimen/activity_vertical_margin" 
tools:context="id.ac.polsri.sapaprogrammer.MainActivity"> 
 
<TextView 
android:id="@+id/tvNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/s_tvNama"/> 
 
<EditText 
android:id="@+id/txtNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignParentRight="true" 
android:layout_alignTop="@+id/tvNama" 
android:layout_toRightOf="@+id/tvNama" 
android:ems="10" 
android:inputType="textPersonName"> 
 
<requestFocus/> 
</EditText> 
 
<Button 
android:id="@+id/btnTampil" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignLeft="@+id/tvNama" 
android:layout_alignRight="@+id/txtNama" 
android:layout_below="@+id/txtNama" 
android:text="@string/s_btnTampil"/> 
 
</RelativeLayout> 

 

2.4 MENULIS KODE PROGRAM JAVA 

Layout yang telah dibuat sebelumnya baik menggunakan 
teknik drag and drop, maupun melalui kode program xml tidak 
secara otomatis dapat berinteraksi dengan user. Untuk itu 
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diperlukan satu tahap lagi, dengan membuat program java 
yang berada di /res/src/<nama package>. Dalam contoh kita 
ini dapat dilakukan dengan double click file 
/res/src/id.ac.polsri.sapaprogrammer/MainActivity.java yang 
berisi kode program untuk memuat layout main_activity.xml 
yang berisi rancangan GUI sebagaimana telah dibuat 
sebelumnya. Pertama kali kode program java dimuat, akan 
dibuat beberapa kode program seperti berikut. 

/res/layout/activity_main.xml 

package id.ac.polsri.sapaprogrammer; 
 
import android.app.Activity; 
import android.os.Bundle; 
import android.view.Menu; 
import android.view.MenuItem; 
 
 
publicclass MainActivity extends Activity { 
 
@Override 
protectedvoid onCreate(Bundle savedInstanceState) { 
super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
    } 
 
@Override 
publicboolean onCreateOptionsMenu(Menu menu) { 
// Inflate the menu; this adds items to the action bar if it is present. 
        getMenuInflater().inflate(R.menu.main, menu); 
returntrue; 
    } 
 
@Override 
publicboolean onOptionsItemSelected(MenuItem item) { 
// Handle action bar item clicks here. The action bar will 
// automatically handle clicks on the Home/Up button, so long 
// as you specify a parent activity in AndroidManifest.xml. 
int id = item.getItemId(); 
if (id == R.id.action_settings) { 
returntrue; 
        } 
returnsuper.onOptionsItemSelected(item); 
    } 
} 
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Perhatikan pada bagian kode 
setContentView(R.layout.activity_main); yang 

berfungsi untuk memuat rancangan GUI yang berada pada 
lokasi file /res/layout/activity_main.xml sebagai file GUI yang 
nantinya akan dijalankan dan ditampilkan pertama kali pada 
saat program Android dijalankan. 

Tidak semua kode program digunakan nantinya, terutama 
pada bagian yang berhubungan dengan pembuatan menu. 
Ubah kode program seperti yang tertera pada listing berikut. 

/res/layout/activity_main.xml 

package id.ac.polsri.sapaprogrammer; 
 
import android.app.Activity; 
import android.os.Bundle; 
 
//namespacetambahan 
import android.view.View; 
import android.view.View.OnClickListener; 
import android.widget.Button; 
import android.widget.EditText; 
import android.widget.Toast; 
 
publicclass MainActivity extends Activity implements OnClickListener { 
 private EditText txtNama; 
 private Button btnTampil; 
 
 @Override 
protectedvoid onCreate(Bundle savedInstanceState) { 
super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
txtNama = (EditText)findViewById(R.id.txtNama); 
btnTampil = (Button)findViewById(R.id.btnTampil); 
btnTampil.setOnClickListener(this); 
    } 
 
publicvoid onClick(View tombol){ 
 if(tombol.getId()==R.id.btnTampil){ 
  String pesan = "Selamat Datang, " + 
txtNama.getText().toString(); 
  Toast.makeText(getApplicationContext(),  
    pesan,  
    Toast.LENGTH_SHORT).show(); 
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 } 
    } 
} 

 

PERAN FILE R.JAVA 

Pernah terbayang bagaimanakah rancangan GUI yang 
telah dibuat dalam bentuk file XML yang disimpan di 
/res/layout/activity_main.xml dapat berhubungan dengan file 
java yang tersimpan di /src/<nama 
package>/MainActivity.java, sedangkan kedua file tersebut 
terpisah satu sama lain, perhatikan ilustrasi pada Gambar 
2.16. 

ButtonTextView

activity_main.xml

Didefinisikan 

menggunakan XML

onClick

MainActivity.java

Didefinisikan 

menggunakan program 

Java

Bagaimana saling 

dapat 

berkomunikasi?

Gambar 2.16 Komunikasi Antar File 

Pada saat project Android dibuat, maka sistem akan 
membuat file dalam folder /gen/<nama package> dengan 
nama R.java, yang didalamnya terdapat semua referensi 
berupa nilai konstanta merujuk pada semua definisi yang 
dibuat pada file activity_main.xml dan juga termasuk semua 
file resources yang didefinisikan dalam file 
/res/values/strings.xml, perhatikan Gambar 2.17. 
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MainActivity.java

R.java

Gambar 2.17 Komunikasi Melalui File R.java 

Sebagai contoh pada Gambar 2.17 bahwa pada saat 
sebuah method onCreate() dalam file MainActivity.java 
dieksekusi, pada baris perintah 
setContentView(R.layout.activity_main) untuk 

menampilkan layout yang didefinisikan pada file 
/res/layout/activity_main.xml, maka sebenarnya program java 
merujuk pada referensi yang ada di dalam file R.java,  
demikian juga dengan komponen GUI yang lain. Jadi tanpa 
ada file R.java di dalam project, maka program Android yang 
dibuat tidak dapat melakukan komunikasi dan tentunya 
menghasilkan error. Begitu pentingnya peran yang dimainkan 
oleh file R.java, pastikan file tersebut berhasil di-generate 
pada saat project pertama kali dibuat. 
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Kedua file tersebut yaitu Java dan XML merupakan 
perekat dalam mengembangkan aplikasi Android. Sehingga 
dapat dikatakan file Java sebagai tempat menuliskan 
algoritma dan logika program, sedangkan file XML 
merupakan desain antar muka aplikasi. 

Dalam aplikasi Android terdapat beberapa cara untuk 
merujuk beragam resources dengan cara yang berbeda jika 
dilakukan melalui file XML dan Java, hal ini dikarenakan 
perbedaan syntax penulisan kode program. Pada Tabel 2.2 
diperlihatkan bagaimana cara merujuk beragam resources. 

Tabel 2.2 Teknik Merujuk Resources 

Resource Teknik Java Teknik XML 

res/layout/activity_main
.xml 

R.layout.activity_m
ain 

@layout/main 

res/drawable-
hdpi/icon.png 

R.drawable.icon @drawable/ic
on 

@+id/btnTampil R.id.btnTampil @id/btnTampi
l 

<string name=”hello”> R.string.hello @string/hello 

 

TOAST MESSAGE 

Fungsional pesan menggunakan Toast digunakan untuk 
menampilkan pesan kepada pengguna tetapi berjalan dalam 
satu arah, yaitu dari sistem Android kepada pengguna tanpa 
ada feedback dari pengguna. Pesan Toast ini hanya 
dimunculkan beberapa detik saja. Untuk dapat menggunakan 
Toast, maka di bagian atas dari kode program diperlukan 
proses untuk melakukan import android.widget.Toast, 
kemudian dengan menggunakan method makeText 
diperlukan 3 buah parameter, yaitu: 

• Parameter pertama berisi Context dari aplikasi, 
berisi informasi layar/display dimana pesan akan 
ditampilkan sehingga cukup diisi dengan 
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getApplicationContext(). 
• Parameter kedua berisi pesan yang akan 

ditampilkan, dalam contoh berisi informasi Selamat 
Datang ditambah dengan informasi yang diperoleh 
dari teks isian yang dimasukkan oleh user. 

• Parapeter ketiga berisi durasi berapa lama pesan 
akan ditampilkan, dapat berisi pilihan dari 
kontanta Toast.LENGTH_* pada saat penulisan 
kode program. 

2.5 MENJALANKAN EMULATOR 

Emulator diperlukan untuk menjalankan program Android 
yang telah dibuat sebelumnya. Emulator tersebut dijadikan 
sebagai output aplikasi. Jika aplikasi akan langsung 
dihubungkan dengan perangkat Android (real device) maka 
dapat dilakukan dengan menghubungkan perangkat dengan 
laptop/pc menggunakan kabel data. Tetapi jika real device 
tidak tersedia, maka emulator dapat digunakan sebagai output 
tujuan bagi aplikasi yang telah selesai dikembangkan. 

Tahapan untuk membuat Emulator telah dibahas pada bab 
1, sehingga pada tahap ini cukup melakukan proses 
menjalankan emulator. Dari menu Window > Android Virtual 
Device Manager, maka akan dimunculkan window seperti 
pada Gambar 2.18. Pilih AVD yang telah muncul didaftar, 
kemudian klik tombol Start yang ada pada panel sebelah 
kanan. Tunggu beberapa saat, sampai proses memuat 
emulator berhasil tampil sempurna. Kemudian tutup kembali 
window AVD. 
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Gambar 2.18 Window Android Virtual Device (AVD) Manager 

2.6 MENJALANKAN PROGRAM 

Klik kanan nama Project > Run As > Android Application, 
atau dari menu bar Run > Run ketika muncul pilihan window 
pilih Android Application. Perhatikan pada Gambar 2.19 
sebagai hasil dari menjalankan program. Pada saat program 
pertama kali dimuat dalam Emulator, teks isian nama masih 
dalam keadaan kosong, selanjutnya sistem menunggu user 
untuk memasukkan nama ke dalam teks isian. Setelah nama 
terisi, maka user dapat mengklik tombol Beri Ucapan dan 
sistem akan memberikan sebuah respon berupa ucapan 
selamat datang. Informasi yang muncul beberapa saat 
tersebut dihasilkan dari widget Toast, yang akan lebih detail 
dibahas pada bab Menu dan Dialog. 
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Gambar 2.19 Menjalankan Program di Emulator 

2.7 SIMPULAN 

Sampai di sini telah dikupas tahapan bagaimana cara 
membuat project sampai menjalankan program melalui 
emulator. Pada bab-bab berikutnya, diasumsikan pembaca 
sudah memahami tahapan yang harus dilakukan dalam 
pengembangan program Android, mulai dari membuat project, 
membuat rancangan GUI berbasis drag and drop maupun 
kode program xml, menulis kode program java, menjalankan 
emulator, dan menjalankan program dengan sempurna. 
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BAB 3  
MANAJEMEN LAYOUT 

3.1 PENTINGNYA LAYOUT 

Sebagaimana dalam kehidupan sehari-hari, layout 
berperan penting dalam mengatur tata letak untuk menjadikan 
segala sesuatu menjadi menarik. Dalam konteks aplikasi 
Android, layout berperan dalam menjadikan aplikasi Android 
terlihat keren dan menarik. Dalam tahap ini diperlukan 
keterampilan penempatan komponen GUI atau dikenal 
dengan istilah widget di Android, sehingga terlihat enak untuk 
dilihat. Supaya mahir dalam mendesain layout ini diperlukan 
pemahaman yang baik tentang kode XML. Secara fisik file 
XML yang berisi desain layout terletak di lokasi 
project_android > res > layout. Pengetahuan layout menjadi 
penting karena ukuran layar device Android sangat beragam, 
sehingga teknik meletakkan posisi widget secara presisi 
sangat penting untuk dilakukan. 

3.2 LAYOUT RELATIVE 

Relative Layout merupakan penempatan widget diatur 
secara relatif terhadap komponen widget yang lain. Dalam 
kehidupan sehari-hari teknik ini digunakan untuk tujuan 
fleksibilitas. Relative disini diartikan bahwa penempatan 
widget diletakkan mengikuti arah atau posisi seperti menyebut 
istilah sebelah atas, bawah, kanan, dan kiri. Sebagai contoh 
si B ditempatkan di sebelah kanan si A, si C diletakkan di 
sebelah bawah si A. Jika menggunakan teknik Relative 
Layout, maka dalam kode XML nantinya juga mengikuti pola 
tersebut. 

Dalam penempatan widget Layout Relative ini 
menggunakan beberapa aturan sebagai attribute yang 
melekat pada sebuah widget. Beberapa attribute tersebut 
dapat diatur melalui kode program java maupun xml, seperti 
dapat dilihat pada Tabel 3.1. 
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Tabel 3.1 Attribute Penempatan Widget 

Aturan 
Relative 
Layout 

Kode XML Kode Java 

Menempatka
n sebuah 
widget 
relative 
terhadap 
posisi widget 
yang lain 

layout_above 
layout_below 
layout_toRightOf 
layout_toLeftOf 

ABOVE 
BELOW 
RIGHT_OF 
LEFT_OF 

Menempatka
n sebuah 
widget 
menjadi rata 
dilihat dari 
posisi widget 
yang lain 

layout_alignTop 
layout_alignBottom 
layout_alignRight 
layout_alignLeft 

ALIGN_TOP 
ALIGN_BOTTOM 
ALIGN_RIGHT 
ALIGN_LEFT 

Meratakan 
text widget 
dengan 
posisi text 
widget yang 
lain 

layout_alignBaseline ALIGN_BASELINE 

Meratakan 
widget dilihat 
dari posisi 
widget 
parent(biasa
nya dilihat 
dari 
layar/display
) 

layout_alignParentT
op 
layout_alignParentB
ottom 
layout_alignParentRi
ght 
layout_alignParentL
eft 

ALIGN_PARENT_TO
P 
ALIGN_PARENT_BO
TTOM 
ALIGN_PARENT_RIG
HT 
ALIGN_PARENT_LEF
T 

Menempatka
n widget rata 
tengah 
dilihat dari 
posisi widget 

layout_centerInPare
nt 
layout_centerHorizo
ntal 
layout_centerVertical 

CENTER_IN_PAREN
T 
CENTER_HORIZONT
AL 
CENTER_VERTICAL 
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parent 
(biasaya 
layar/display
) 

 

Untuk mengimplementasikan beberapa aturan 
penempatan widget secara relative seperti property pada 
Tabel 3.1, maka akan dibuat layout dengan tampilan seperti 
desain Gambar 3.1. 
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Gambar 3.1 Rancangan Layout Relative 

Jika diperhatikan desain pada Gambar 3.1, maka terdapat 
9 widget yang nantinya ditempatkan secara rapi 
menggunakan layout relative. Untuk memudahkan melakukan 
pengaturan pada kode XML, maka dibuat analisis 
penempatannya seperti pada Tabel 3.2. 

Tabel 3.2 Analisis Penempatan Widget 

Widg
et 

Deskripsi Pengaturan 
Property 

Nilai 

1
 

Pemberian 
nama ID 

Id @+id/tvJudul 

Lebar 
widget 

layout_width wrap_content 
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sesuai 
dengan 
lebar tulisan 
teksnya 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 
teksnya 

layout_height wrap_content 

Posisinya 
sejajar 
dengan tepi 
atas layar 
Android 

layout_alignParentT
op 

True 

Menempatk
an teks 
tepat di 
posisi 
tengah 
layar 
Android 

layout_centerHorizo
ntal 

True  

Judul teks  text Form Registrasi 
Member 

2
 

Pemberian 
nama ID 

Id @+id/tvEmail 

Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 

layout_height wrap_content 
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tulisan 
teksnya 

Posisi 
widget rata 
kiri dengan 
posisi layar 
Android 

layout_alignParentL
eft 

true 

Posisi 
widget 
berada di 
sebelah 
bawah judul 

layout_below @+id/tvJudul 

Judul teks text Email 

3
 

Pemberian 
nama ID 

Id @+id/edtEmail 

Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 
teksnya 

layout_height wrap_content 

Posisi 
widget 
berada di 
sebelah 
kanan 
tvEmail 

layout_toRightOf @+id/tvEmail 

Posisi 
widget rata 
atas 
dengan 

layout_alignTop @+id/tvEmail 
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tvEmail 

Posisi 
widget rata 
kanan 
dengan 
layar 
Android 

layout_alignParentR
ight 

true 

Posisi 
widget 
berjarak 
60dp dari 
sisi kiri 
layar 
Android 

layout_marginLeft 60dp 

4
 

Pemberian 
nama ID 

Id @+id/tvPasswo
rd 

Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 
teksnya 

layout_height wrap_content 

Posisi 
widget 
berada 
sejajar dari 
arah kiri 
dengan 
layar 
Android 

layout_alignParentL
eft 

true 

Posisi layout_below @+id/edtEmail 
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widget di 
sebelah 
bawah teks 
isian email 

Judul teks text Password 

5
 

Pemberian 
nama ID 

Id @+id/edtPassw
ord 

Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 
teksnya 

layout_height wrap_content 

Posisi teks 
isian 
password 
sejajar dari 
arah 
sebelah kiri 
dengan 
teks isian 
email 

layout_alignLeft @+id/edtEmail 

Posisi teks 
isian 
password 
sejajar atas 
dengan 
judul 
password 

layout_alignTop @+id/tvPasswo
rd 

6
 

Pemberian 
nama ID 

Id @+id/tvNama 
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Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 
teksnya 

layout_height wrap_content 

Posisi 
widget rata 
kiri dengan 
judul 
password 

layout_alignLeft @+id/tvPasswo
rd 

Posisi 
widget 
berada di 
bawah teks 
isian 
password 

layout_below @+id/edtPassw
ord 

7
 

Pemberian 
nama ID 

Id @+id/edtNama 

Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 

layout_height wrap_content 
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teksnya 

Posisi 
widget 
sejajar kiri 
dengan 
teks isian 
password 

layout_alignLeft @+id/edtPassw
ord 

Posisi 
widget 
sejajar atas 
dengan 
posisi judul 
nama 

layout_alignTop @+id/tvNama 

8
 

Pemberian 
nama ID 

Id @+id/btnSubmit 

Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 
teksnya 

layout_height wrap_content 

Posisi 
widget rata 
kiri dengan 
layar 
Android 

layout_alignParentL
eft 

true 

Posisi 
widget di 
sebelah 
bawah teks 
isian nama 

layout_below @+id/edtNama 
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Judul teks text Submit 

9
 

Pemberian 
nama ID 

Id @+id/btnSubmit 

Lebar 
widget 
sesuai 
dengan 
lebar tulisan 
teksnya 

layout_width wrap_content 

Tinggi 
widget 
sesuai 
dengan 
tinggi 
tulisan 
teksnya 

layout_height wrap_content 

Posisi 
tulisan judul 
widget 
sejajar 
dengan 
tulisan judul 
yang ada di 
tombol 
Submit 

layout_alignBaselin
e 

@+id/btnSubmit 

Posisi 
widget rata 
bawah 
dengan 
tombol 
Submit 

layout_alignBottom @+id/btnSubmit 

Posisi 
widget di 
sebelah 
kanan 
tombol 
Submit 

layout_toRightOf @+id/btnSubmit 

Judul teks text Reset 
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Setelah seluruh analisa terkait dengan desain dari layout 
dirasa sudah cukup, maka tahapan berikutnya dilanjutkan 
dengan membuat sebuah project untuk 
mengimplementasikan desain yang telah selesai 
direncanakan. Berikut merupakan deskripsi dari project yang 
akan dibuat untuk mengimplementasikan desain layout 
relative. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama LayoutRelative, minimal required 
SDK API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string teks judul yang nantinya 
digunakan untuk memberikan judul teks bagi 
widget. 

3. Mendefinisikan isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, edittext, 
dan button 

4. Mendefinisikan isi src/com.example. 
layoutrelative/MainActivity.java 

5. Menjalankan Aplikasi 

 
Langkah 1 Membuat Project 
Application Name : LayoutRelative 
Project Name : LayoutRelative 
Package Name : com.example.layoutrelative 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan String 
/res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 
<resources> 
 
<stringname="app_name">LayoutRelative</string> 
<stringname="hello_world">Hello world!</string> 
<stringname="action_settings">Settings</string> 
<stringname="stvjudul">Form Registrasi Member</string> 
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Langkah 3 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
layout relative. Kemudian ubah isi layout file  XML berisi kode 
program seperti berikut. 
/res/layout/activity_main.xml 

<?xmlversion="1.0"encoding="utf-8"?> 
<RelativeLayoutxmlns:android="http://schemas.android.com/apk/res/android" 
android:layout_width="match_parent" 
android:layout_height="match_parent" 
android:padding="10dp"> 
 
<TextView 
android:id="@+id/tvJudul" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
 
android:layout_alignParentTop="true" 
android:layout_centerHorizontal="true" 
android:text="@string/stvjudul"/> 
 
<TextView 
android:id="@+id/tvEmail" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignParentLeft="true" 
android:layout_below="@+id/tvJudul" 
android:text="@string/stvemail"/> 
 
<EditText 
android:id="@+id/edtEmail" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_toRightOf="@+id/tvEmail" 
android:layout_alignTop="@+id/tvEmail" 
android:layout_alignParentRight="true" 
android:layout_marginLeft="60dp" 
android:ems="10" 
android:inputType="textEmailAddress"/> 

<stringname="stvemail">Email</string> 
<stringname="stvpwd">Password </string> 
<stringname="stvnama">Nama </string> 
<stringname="sbtsubmit">Submit </string> 
<stringname="sbtreset">Reset </string> 
 
</resources> 
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<TextView 
android:id="@+id/tvPassword" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignParentLeft="true" 
android:layout_below="@+id/edtEmail" 
android:text="@string/stvpwd"/> 
 
<EditText 
android:id="@+id/edtPassword" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignLeft="@+id/edtEmail" 
android:layout_alignTop="@+id/tvPassword" 
android:ems="10" 
android:inputType="textPassword"/> 
 
<TextView 
android:id="@+id/tvNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignLeft="@+id/tvPassword" 
android:layout_below="@+id/edtPassword" 
android:text="@string/stvnama"/> 
 
<EditText 
android:id="@+id/edtNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignLeft="@+id/edtPassword" 
android:layout_alignTop="@+id/tvNama" 
android:ems="10" 
android:inputType="textPersonName"/> 
 
<Button 
android:id="@+id/btnSubmit" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:layout_alignParentLeft="true" 
android:layout_below="@+id/edtNama" 
 
android:text="@string/sbtsubmit"/> 
 
<Button 
android:id="@+id/cmdReset" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
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android:layout_alignBaseline="@+id/btnSubmit" 
android:layout_alignBottom="@+id/btnSubmit" 
android:layout_toRightOf="@+id/btnSubmit" 
android:text="@string/sbtreset"/> 
 
</RelativeLayout> 
 

Langkah 3 Mendefinisikan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.layoutrelative/MainActivity.java cukup 
didefinisikan kode program berikut. 

/src/com.example.layoutrelative/MainActivity.java 

package com.example.layoutrelative; 
 
import android.app.Activity; 
import android.os.Bundle; 
 
publicclass MainActivity extends Activity { 
 
@Override 
protectedvoid onCreate(Bundle savedInstanceState) { 
super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
    }     
} 

Langkah 4 Menjalankan Aplikasi 

Selanjutnya untuk melihat desain yang telah ditulis dalam 
kode XML, klik Tab Graphical Layout sehingga diperlihatkan 
tampilan seperti Gambar 3.3, selanjutnya Gambar 3.4 
merupakan tampilan setelah program dijalankan melalui 
emulator. 



 

71 
 

 

Gambar 3.3 Hasil Desain Relative Layout 

 

Gambar 3.4 Hasil Menjalankan Program 
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3.3 LAYOUT LINEAR 

Linear Layout merupakan layout yang memberikan 
susunan tata letak komponen secara garis lurus baik vertikal 
maupun horizontal. Gambar 3.5 menunjukkan ilustrasi model 
orientasi LinearLayout. 

1

2

3

4

5

1 2 3 4 5

Vertical Horizontal
 

Gambar 3.5 Model Layout Linear 

Jika desain pada layout relative sebelumnya akan diubah 
menjadi desain layout linear vertical, maka dapat digunakan 
model seperti Gambar 3.6. 
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Gambar 3.6 Desain Layout Linear Vertical 
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Berikut deskripsi dari project Android yang akan 
digunakan untuk mengimplementasikan desain layout linear. 
Berikut merupakan langkah – langkah dalam pembuatan 
project untuk mengimplementasikan konsep Layout Linear. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama LayoutLinear, minimal required 
SDK API 14, target dan compile with 
menggunakan API 16. 

2. Mendefnisikan string teks judul yang berada di 
res/values/strings.xml 

3. Mendefinisikan isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, edittext, 
dan button 

4. Mendefinisikan isi 
src/com.example.layoutlinear/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : LayoutLinear 
Project Name : LayoutLinear 
Package Name : com.example.layoutlinear 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 
 
Langkah 2 Mendefinisikan String 

/res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 
<resources> 
 
<stringname="app_name">LayoutLinear</string> 
<stringname="hello_world">Hello world!</string> 
<stringname="action_settings">Settings</string> 
<stringname="stvjudul">Form Registrasi Member</string> 
<stringname="stvemail">Email</string> 
<stringname="stvpwd">Password </string> 
<stringname="stvnama">Nama </string> 
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<stringname="sbtsubmit">Submit </string> 
<stringname="sbtreset">Reset </string> 
 
</resources> 

 
Langkah 3 Mendefinisikan Layout 

Kemudian layout file  XML berisi kode program seperti 
berikut. 

/res/layout/activity_main.xml 

<LinearLayoutxmlns:android="http://schemas.android.com/apk/res/android" 
android:layout_width="fill_parent" 
android:layout_height="fill_parent" 
android:padding="15dp" 
android:orientation="vertical"> 
  
<TextView 
android:id="@+id/tvJudul" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:gravity="center_horizontal" 
android:text="@string/stvjudul"/> 
 
<TextView 
android:id="@+id/tvEmail" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvemail"/> 
 
<EditText 
android:id="@+id/edtEmail" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:ems="10" 
android:inputType="textPersonName"/> 
 
<TextView 
android:id="@+id/tvPassword" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvpwd"/> 
 
<EditText 
android:id="@+id/edtPassword" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
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android:ems="10" 
android:inputType="textPassword"/> 
 
<TextView 
android:id="@+id/tvNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvnama"/> 
 
<EditText 
android:id="@+id/edtNama" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:ems="10" 
android:inputType="textPersonName"/>  
 
 <Button 
 android:id="@+id/btnSubmit" 
 android:layout_width="match_parent" 
 android:layout_height="wrap_content" 
 
 android:text="@string/sbtsubmit"/> 
 
 <Button 
 android:id="@+id/btnReset" 
 android:layout_width="match_parent" 
 android:layout_height="wrap_content" 
 android:text="@string/sbtreset"/> 
 
</LinearLayout> 

Langkah 4 Mendefinisikan Kode 
ProgramMainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.layoutlinear/MainActivity.java cukup 
didefinisikan kode program berikut. 

/src/com.example.layoutrelative/MainActivity.java 

package com.example.layoutlinear; 
 
import android.app.Activity; 
import android.os.Bundle; 
 
publicclass MainActivity extends Activity { 
 
@Override 
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protectedvoid onCreate(Bundle savedInstanceState) { 
super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
   }     
} 

Langkah 5 Menjalankan Aplikasi 

Selanjutnya untuk melihat desain yang telah ditulis dalam 
kode XML, klik Tab Graphical Layout sehingga diperlihatkan 
tampilan seperti Gambar 3.7, selanjutnya Gambar 3.8 
merupakan tampilan setelah program dijalankan melalui 
emulator. 

 

Gambar 3.7 Hasil Desain Relative Layout 



 

77 
 

 

Gambar 3.8 Hasil Menjalankan Program 

Layout linear yang telah dibuat dapat dikombinasikan 
untuk memperoleh performa yang maksimal untuk 
menempatkan komponen GUI dengan presisi. Gambar 3.9 
memberikan gambaran bagaimana melakukan kombinasi 
penempatan komponen GUI, pada bagian tombol 
ditempatkan ditempatkan secara horizontal sehingga tampilan 
kedua buah tombol sejajar. 
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Gambar 3.9 Desain Kombinasi 

Berikut kode progam XML yang perlu diubah, dengan 
menambahkan satu buah layout linear dengan orientasi 
horizontal. 

/res/layout/activity_main.xml 

<LinearLayoutxmlns:android="http://schemas.android.com/apk/res/android" 
android:layout_width="fill_parent" 
android:layout_height="fill_parent" 
android:padding="15dp" 
android:orientation="vertical"> 
  
<TextView 
android:id="@+id/tvJudul" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:gravity="center_horizontal" 
android:text="@string/stvjudul"/> 
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<TextView 
android:id="@+id/tvEmail" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvemail"/> 
 
 
<EditText 
android:id="@+id/edtEmail" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:ems="10" 
android:inputType="textPersonName"/> 
 
<TextView 
android:id="@+id/tvPassword" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvpwd"/> 
 
<EditText 
android:id="@+id/edtPassword" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:ems="10" 
android:inputType="textPassword"/> 
 
<TextView 
android:id="@+id/tvNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvnama"/> 
 
<EditText 
android:id="@+id/edtNama" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:ems="10" 
android:inputType="textPersonName"/> 
 
 <LinearLayout 
 android:layout_width="fill_parent" 
 android:layout_height="wrap_content" 
 android:orientation="horizontal"> 
 
 <Button 
 android:id="@+id/btnSubmit" 
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 android:layout_width="wrap_content" 
 android:layout_height="wrap_content" 
 android:layout_weight="0.5" 
 android:text="@string/sbtsubmit"/> 
 
 <Button 
 android:id="@+id/btnReset" 
 android:layout_width="wrap_content" 
 android:layout_height="wrap_content" 
 android:layout_weight="0.5" 
 android:text="@string/sbtreset"/> 
 </LinearLayout> 
 
</LinearLayout> 

Pada Gambar 3.10 dan Gambar 3.11 memperlihatkan 
hasil modifikasi dengan mengkombinasikan Layout Vertical 
dan Horizontal. 

 

Gambar 3.10 Hasil Desain 
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Gambar 3.11 Hasil Running 

3.4 LAYOUT FRAME 

Frame Layout merupakan layout yang memberikan 
susunan tata letak komponen yang bertumpuk. Bedanya 
antara layout ini dengan RelativeLayout adalah jika di 
RelativeLayout, kita dapat menempatkan sebuat widget 
posisinya di sebelah kanan/kiri/atas/bawah, sedangkan pada 
FrameLayout, widget yang ditulis lebih akhir akan diletakkan 
di DEPAN widget sebelumnya, sehingga akan menutupi 
widget di bawahnya, kecuali jika warnanya transparan. 
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Berikut merupakan langkah – langkah dalam pembuatan 
project untuk mengimplementasikan konsep Layout Frame. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama LayoutFrame, minimal required SDK 
API 14, target dan compile with menggunakan API 
16. 

2. Mendefinisikan isi dari res/values/strings.xml untuk 
menyediakan teks judul yang digunakan dalam 
aplikasi. 

3. Mendefinisikan isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, edittext, 
dan button. 

4. Mendefinisikan isi 
src/com.example.layoutframe/MainActivity.java 

5. Menjalankan Aplikasi. 

Langkah 1 Membuat Project 

Application Name : LayoutFrame 
Project Name : LayoutFrame 
Package Name : com.example.layoutframe 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan String 

Selanjutnya untuk menyediakan teks judul yang nantinya 
digunakan dalam aplikasi, dapat didefinisikan nilai string pada 
file /res/values/strings.xml. 

/res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 
<resources> 
<stringname="app_name">LayoutFrame</string> 
<stringname="hello_world">Hello world!</string> 
<stringname="action_settings">Settings</string> 
 
</resources> 
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Langkah 3 Mendefinisikan Layout 

Kemudian layout file  XML berisi kode program seperti 
berikut. 

/res/layout/activity_main.xml 

<FrameLayoutxmlns:android="http://schemas.android.com/apk/res/android" 
android:layout_width="fill_parent" 
android:layout_height="fill_parent"> 
 
<ImageView 
android:src="@drawable/ic_launcher" 
android:scaleType="fitCenter" 
android:layout_gravity="center_vertical" 
android:layout_height="match_parent" 
android:layout_width="match_parent"/>" 
 
<TextView 
android:text="Frame Demo" 
android:textSize="30px" 
android:textStyle="bold" 
android:layout_height="fill_parent" 
android:layout_width="fill_parent" 
android:gravity="center"/> 
</FrameLayout> 

Langkah 4 Mendefinisikan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.layoutframe/MainActivity.java cukup 
didefinisikan kode program berikut. 

/src/com.example.layoutframe/MainActivity.java 

package com.example.layoutframe; 
 
import android.app.Activity; 
import android.os.Bundle; 
 
publicclass MainActivity extends Activity { 
 
@Override 
protectedvoid onCreate(Bundle savedInstanceState) { 
super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
    } 
} 
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Langkah 5 Menjalankan Aplikasi 

Selanjutnya untuk melihat desain yang telah ditulis 
dalam kode XML, klik Tab Graphical Layout sehingga 
diperlihatkan tampilan seperti Gambar 3.12, selanjutnya 
Gambar 3.13 merupakan tampilan setelah program dijalankan 
melalui emulator. 

 

Gambar 3.12 Hasil Desain Relative Layout 

 

Gambar 3.13 Hasil Menjalankan Program 
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3.5 LAYOUT SCROLL 

Dalam pengembangan aplikasi android biasanya 
sering terkendala dengan ukuran tampilan layar yang kecil 
dan terbatas. Konten yang ingin dimasukkan cukup banyak 
sehingga layar tidak dapat menampilkannya dalam satu layar 
utuh. ScrollView digunakan untuk mengatasi masalah 
tersebut.  

Bayangkan bahwa kita akan menampilkan 
sekumpulan gambar yang disusun secara vertical 
menggunakan layout linear vertical, kemudian dengan jumlah 
gambar yang melebihi ruang tayang pada layar Android, 
maka digunakan Layout Scrollview untuk membantu 
menampilkan gambar secara bertahap sesuai dengan ukuran 
layar seperti diperlihatkan pada Gambar 3.14. Sebagaimana 
ilustrasi yang digambarkan, layar Android hanya mampu 
menampilkan 3 buah objek gambar, sehingga objek gambar 
yang lain perlu dilakukan proses untuk menggulung layar dari 
atas ke bawah ataupun sebaliknya. 



86 
 

Gambar 1

Teks 1

Gambar 2

Teks 2

Gambar 3

Teks 3

Gambar 4

Teks 4

Gambar 5

Teks 5

Gambar 6

Teks 6

Gambar 7

Teks 7

Layar

o
rie

n
ta

tio
n

=
”
v

e
rtic

a
l”

<LinearLayout> 

<
S

c
ro

llv
ie

w
>

 

Gambar 3.14 Desain Layout Scrollview 

Sebagai sebuah contoh penggunaan layout 
scrollview, akan dibuat program untuk menampilkan daftar 
gambar Presiden Republik Indonesia pertama sampai dengan 
ke – 7 menggunakan widget ImageView. 

Berikut merupakan langkah – langkah dalam 
pembuatan project untuk mengimplementasikan konsep 
Layout Scroll. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama LayoutScroll, minimal required SDK 
API 14, target dan compile with menggunakan API 
16. 
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2. Mendefinisikan isi dari res/values/strings.xml 
untuk menyediakan teks judul yang digunakan 
dalam aplikasi. 

3. Menyediakan file Image/Gambar yang akan 
ditempatkan pada widget ImageView. 

4. Mendefinisikan isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, edittext, 
dan button. 

5. Mendefinisikan isi 
src/com.example.layoutscroll/MainActivity.java 

6. Menjalankan Aplikasi. 

Langkah 1 Membuat Project 

Application Name : LayoutScroll 
Project Name : LayoutScroll 
Package Name : com.example.layoutscroll 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan String Judul 

Setelah project selesai dibuat, langkah berikutnya 
mendefinisikan sekumpulan string sebagai teks judul yang 
akan digunakan oleh beberapa komponen widget yang ada 
dalam layout. 

/res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 
<resources> 
 
<stringname="app_name">LayoutScroll</string> 
<stringname="hello_world">Hello world!</string> 
<stringname="action_settings">Settings</string> 
<stringname="judul">DAFTAR PRESIDEN RI</string> 
<stringname="p1">Ir. Soekarno</string> 
<stringname="p2">H.M. Soeharto</string> 
<stringname="p3">Prof. Dr. BJ. Habibie</string> 
<stringname="p4">KH. Abdurrahman Wahid</string> 
<stringname="p5">Megawati Soekarno Putri</string> 
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<stringname="p6">Dr. Soesilo Bambang Yudoyono</string> 
<stringname="p7">Ir. Joko Widodo</string> 
 
</resources> 
 

Langkah 3 Menyedikan Resources Berupa File Gambar 

Selanjutnya foto Presiden yang nanti akan 
ditampilkan dalam layar Android, maka kopikan file sejumlah 
7 buah foto Presiden RI, dan tempatkan pada folder 
/res/drawable-hdpi/ seperti dapat dilihat strukturnya pada 
Gambar 3.15. 

 

Gambar 3.15 Menambahkan File Gambar 
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Langkah 4 Mendefinisikan Layout 

Kosongkan dengan menghapus isi file 
/res/layout/activity_main.xml, kemudian tarik ScrollView ke 
dalam display Android seperti dapat dilihat pada Gambar 
3.16. 

 

Gambar 3.16 Menempatkan Scrollview pada Layar 

Kemudian layout file  XML berisi kode program seperti 
berikut. 

/res/layout/activity_main.xml 

<ScrollViewxmlns:android="http://schemas.android.com/apk/res/android" 
android:id="@+id/scrollView1" 
android:padding="20dp" 
android:layout_width="fill_parent" 
android:layout_height="fill_parent"> 
 
<LinearLayout 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:orientation="vertical"> 
  
<TextView 
android:id="@+id/textView0" 
android:layout_width="fill_parent" 
android:layout_height="wrap_content" 
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android:gravity="center_horizontal" 
android:text="@string/judul"/> 
 
<ImageView 
android:id="@+id/imageView1" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:src="@drawable/ri1sukarno"/> 
 
<TextView 
android:id="@+id/textView1" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/p1"/> 
 
<ImageView 
android:id="@+id/imageView2" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:src="@drawable/ri2suharto"/> 
 
 
 
 
<TextView 
android:id="@+id/textView2" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/p2"/> 
 
<ImageView 
android:id="@+id/imageView3" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:src="@drawable/ri3habibi"/> 
 
<TextView 
android:id="@+id/textView3" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/p3"/> 
 
<ImageView 
android:id="@+id/imageView4" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:src="@drawable/ri4gusdur"/> 
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<TextView 
android:id="@+id/textView4" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/p4"/> 
 
<ImageView 
android:id="@+id/imageView5" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:src="@drawable/ri5megawati"/> 
 
<TextView 
android:id="@+id/textView5" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/p5"/> 
 
<ImageView 
android:id="@+id/imageView6" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:src="@drawable/ri6sby"/> 
 
<TextView 
android:id="@+id/textView6" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/p6"/> 
 
<ImageView 
android:id="@+id/imageView7" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:src="@drawable/ri7jokowi"/> 
 
 
 
<TextView 
android:id="@+id/textView7" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/p7"/> 
 
</LinearLayout> 
 
</ScrollView> 
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Langkah 5 Mendefinisikan Kode Program Java 

Kode program java ini berisi perintah untuk 
menampilkan layout scroll yang telah dibuat sebelumnya ke 
layar Android. 

/res/com.example.layoutscroll/MainActivity.java 

package com.example.layoutscroll; 
 
import android.app.Activity; 
import android.os.Bundle; 
 
publicclass MainActivity extends Activity { 
 
@Override 
protectedvoid onCreate(Bundle savedInstanceState) { 
super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
    }     
} 

Langkah 6 Menjalankan Aplikasi 

Selanjutnya untuk melihat desain yang telah ditulis 
dalam kode XML, klik Tab Graphical Layout sehingga 
diperlihatkan tampilan seperti Gambar 3.17, selanjutnya 
Gambar 3.18 merupakan tampilan setelah program dijalankan 
melalui emulator. 

 

Gambar 3.17 Desain Layout Scrollview 
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Gambar 3.18 memperlihatkan bagaimana perilaku dari 
Layout Scrollview, pada bagian kanan terdapat sebuah slider 
untuk menggerakkan layar ke atas dan ke bawah mengikuti 
jumlah data yang tersedia. 

 

Gambar 3.18 Tampilan Layout Scrollview 

3.6 LAYOUT TABLE 

Table Layout merupakan layout yang memberikan 
susunan tata letak komponen berdasarkan susunan tabel 
(baris dan kolom) mirip dengan struktur tabel pada 
pemrograman web menggunakan kode HTML.Baris berurutan 
dari atas kebawah sedangkan kolom berurutan menyamping 
dari kiri ke kanan. Berikut beberapa karakteristik penggunaan 
TableLayout, yaitu: 

• TableLayout di Android secara default tidak 
menampilkan garis batas untuk masing-masing baris dan 
kolom.  

• Tiap baris tabel dapat memiliki satu atau banyak sel.  
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• Tiap sel hanya diperbolehkan memiliki satu objek 
widget/view. 

Form Registrasi Member

Email

Password

Nama

Submit Reset

 

Gambar 3.19 Model Layout Table 

Gambar 3.19 memperlihatkan desain layout table untuk 
menempatkan beberapa komponen GUI mengikuti pola baris 
dan kolom.  Berikut merupakan langkah – langkah dalam 
pembuatan project untuk mengimplementasikan konsep 
Layout Table. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama LayoutTable, minimal required 
SDK API 14, target dan compile with 
menggunakan API 16. 

2. Mendefinisikan isi dari res/values/strings.xml 
untuk menyediakan teks judul yang digunakan 
dalam aplikasi. 

3. Mendefinisikan isi dari 
res/layout/activity_main.xml untuk menambahkan 
komponen textview, edittext, dan button. 

4. Mendefinisikan isi 
src/com.example.layouttable/MainActivity.java 

5. Menjalankan Aplikasi. 
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Langkah 1 Membuat Project 

Application Name : LayoutTable 
Project Name : LayoutTable 
Package Name : com.example.layouttable 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan String 

Langkah selanjutnya yang perlu dilakukan adalah 
mempersiapkan string teks judul yang akan digunakan oleh 
komponen widget. Hal ini dilakukan dengan mengubhan isi 
dari file /res/values/strings.xml 

res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 
<resources> 
 
<stringname="app_name">LayoutTable</string> 
<stringname="hello_world">Hello world!</string> 
<stringname="action_settings">Settings</string> 
<stringname="stvjudul">Form Registrasi Member</string> 
<stringname="stvemail">Email</string> 
<stringname="stvpwd">Password </string> 
<stringname="stvnama">Nama </string> 
<stringname="sbtsubmit">Submit </string> 
<stringname="sbtreset">Reset </string> 
 
</resources> 

 

Langkah 3 Mendefinisikan Layout 

Setelah teks judul selesai disiapkan, langkah berikutnya 
melakukan desain layout Tabel seperti berikut. 

res/layout/activity_main.xml 

<?xmlversion="1.0"encoding="utf-8"?> 
<TableLayoutxmlns:android="http://schemas.android.com/apk/res/android" 
android:id="@+id/tableLayout1" 
android:layout_width="match_parent" 
android:layout_height="match_parent" 
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android:padding="10dp" 
android:shrinkColumns="*" 
android:stretchColumns="*"> 
 
<!-- Baris 1 Kolom 1 --> 
 
<TableRow 
android:id="@+id/tableRow1" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:gravity="center_horizontal"> 
 
<TextView 
android:id="@+id/tvJudul" 
android:layout_width="match_parent" 
android:layout_height="wrap_content" 
android:layout_span="2" 
android:gravity="center_horizontal" 
android:text="@string/stvjudul" 
android:textStyle="bold"/> 
 
</TableRow> 
 
<!--Baris 2 Kolom 2 --> 
 
<TableRow 
android:id="@+id/tableRow2" 
android:layout_width="match_parent" 
android:layout_height="wrap_content"> 
 
<TextView 
android:id="@+id/tvEmail" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvemail" 
android:textSize="16dp"/> 
 
<EditText 
android:id="@+id/edtEmail" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:ems="10"/> 
 
</TableRow> 
 
<!-- Baris 3 Kolom 3 --> 
 
<TableRow 
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android:id="@+id/tableRow3" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content"> 
 
<TextView 
android:id="@+id/tvPassword" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvpwd" 
android:textSize="16dp"/> 
 
<EditText 
android:id="@+id/edtPassword" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:ems="10" 
android:inputType="textPassword"> 
</EditText> 
</TableRow> 
<!-- Baris 4 Kolom 4 --> 
 
<TableRow 
android:id="@+id/tableRow4" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content"> 
 
<TextView 
android:id="@+id/tvNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/stvnama" 
android:textSize="16dp"/> 
 
<EditText 
android:id="@+id/edtNama" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:ems="10" 
android:inputType="textPassword"> 
</EditText> 
</TableRow> 
 
<!-- Baris 4 Kolom 1 --> 
 
<TableRow 
android:id="@+id/tableRow5" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
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android:gravity="right"> 
 
<Button 
android:id="@+id/btnSubmit" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/sbtsubmit"/> 
 
<Button 
android:id="@+id/btnReset" 
android:layout_width="wrap_content" 
android:layout_height="wrap_content" 
android:text="@string/sbtreset"/> 
 
</TableRow> 
 
</TableLayout> 

Langkah 4 Mendefinisikan Kode Program Java 

Setelah layout selesai didefinisikan, langkah selanjutnya yang 
perlu dilakukan adalah membuat kode program Java. 

res/layout/activity_main.xml 

package com.example.layouttable; 
 
import android.app.Activity; 
import android.os.Bundle; 
 
publicclass MainActivity extends Activity { 
 
@Override 
protectedvoid onCreate(Bundle savedInstanceState) { 
super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
    } 
} 
 

Langkah 5 Menjalankan Aplikasi 

Gambar 3.20 memperlihatkan desain dari kode XML yang 
telah dibuat sebelumnya. Tampak bahwa komponen GUI 
tersusun dengan rapi mengikuti baris dan kolom yang telah 
ditentukan. Sedangkan Gambar 3.21 memperlihatkan tampilan 
program yang dijalankan pada emulator. 
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Gambar 3.20 Desain Layout Table 

 

Gambar 3.21 Tampilan Layout Table 
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3.7 SIMPULAN 

Sampai pada pembahasan di bab ini, diharapkan telah 
mampu memahami bagaimana menyusun komponen widget 
dalam layar Android. Berbagai jenis layout yang disediakan 
membuat programmer Android memiliki banyak pilihan dalam 
mengembangkan aplikasi Android sesuai dengan kasus yang 
akan diselesaikan. 
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BAB 4 
PEMROGRAMAN GUI DAN EVENT 

4.1 ANTAR MUKA PENGGUNA 

Dalam Android, antar muka pengguna dibangun 
menggunakan objek View dan ViewGroup. View merupakan 
sebuah objek yang dapat berinteraksi dengan user, 
sedangkan ViewGroup merupakan sebuah objek yang 
mengandung View di dalamnya. Sehingga dengan adanya 
View dan ViewGroup menyediakan kontrol masukan seperti 
tombol dan inputan teks, dan juga berbagai layout. Gambar 
4.1 memberikan ilustrasi hubungan antara View dan 
ViewGroup. 

 

Gambar 4.1 Ilustrasi Hubungan View dan ViewGroup 

4.2 PEMROGRAMAN EVENT DRIVEN 

Konsep pemrograman event driven lahir pada era 
pemrograman visual. Hal ini dapat dilihat dari sejarah 
pemrograman, dimana perkembangan awal pemrograman 
berupa command line interface (CLI) dimana user berinteraksi 
dengan sistem melalui cara mengetikkan perintah secara 
langsung ke layar komputer untuk mendapatkan respon dari 
sistem. Selanjutnya lahir pemrograman visual, dimana user 
berinteraksi dengan sistem melalui sejumlah objek grafis yang 
cukup dilakukan dengan menekan klik mouse, drag and drop, 
dan sedikit melakukan penulisan teks dalam interaksinya. 
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Konsep event-driven yaitu suatu program yang 
pengeksekusiannya didasarkan atas kejadian (event) tertentu, 
seperti ketika sebuah tombol diklik, sebuah item dipilih dari 
sekumpulan daftar item dan ketika kursor berpindah fokus. 
Kejadian-kejadian tersebut, mempunyai kode program sendiri 
yang disimpan dalam sebuah fungsi (yang dirancang untuk 
melaksanakan tugas khusus). 

4.3 KONTROL MASUKAN 

Komponen GUI digunakan sebagaian besar sebagai antar 
muka untuk menyediakan input data bagi pengguna. 
Beragam komponen disediakan oleh Android, diantaranya 
tombol, teks isian, teks pencarian, check box, radio button, 
tombol zoom dan masih banyak lagi komponen pendukung 
lainnya. Tabel 4.1 memperlihatkan beragam komponen GUI 
untuk input data yang disediakan dalam Android. 

Tabel 4.1 Kontrol Masukan 

Tipe 
Kontrol 

Gambar Kontrol Keterangan Kelas 
Terkait 

Tombol 
 

Tombol tekan 
yang dapat 
ditekan atau diklik 
oleh pengguna 
untuk melakukan 
suatu aksi. 

Button 

Teks 
isian 

 

Bidang teks yang 
dapat diedit. Bisa 
menggunakan 
widget 
AutoCompleteTex
tView untuk 
membuat widget 
entri teks yang 
menyediakan 
saran 
pelengkapan 

EditText, 
AutoComp
leteTextVi

ew 
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otomatis. 

Kotak 
centang 

 

Tombol 
aktif/nonaktif yang 
bisa dialihkan oleh 
pengguna. 
Menggunakan 
kotak centang 
saat menampilkan 
sekumpulan 
pilihan yang dapat 
dipilih 
pengguna,dan 
memungkinkan 
pemilihan item 
lebih dari satu 
kali. 

CheckBox 

Tombol 
radio 

 

Mirip dengan 
kotak centang, 
hanya saja cuma 
satu opsi yang 
bisa dipilih dalam 
kumpulan 

tersebut. 

RadioGrou
p, 
RadioButt
on 

Tombol 
toggle 

 

Tombol 
aktif/nonaktif 
dengan indikator 
lampu. 

ToggleButt
on 
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Spinner 

 

Daftar tarik-turun 
yang 
memungkinkan 
pengguna memilih 
salah satu dari 
serangkaian nilai. 

Spinner 

Picker 

 

Dialog bagi 
pengguna untuk 
memilih satu nilai 
dari satu 
kumpulan dengan 
menggunakan 
tombol naik/turun 
atau dengan 
isyarat 
menggesek. 
Gunakan widget 
DatePickercode> 
untuk 
memasukkan nilai 
tanggal (bulan, 
hari, tahun) atau 
widget TimePicker 
untuk 
memasukkan nilai 
waktu (jam, menit, 
AM/PM), yang 
akan diformat 
secara otomatis 
untuk lokasi 
pengguna 
tersebut. 

DatePicker
, 
TimePicke
r 
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4.4 MENGGUNAKAN BUTTON 

Sebuah tombol (button) merupakan objek yang terdiri dari 
teks atau icon, maupun kombinasi antara keduanya, yang 
berguna untuk mendeteksi tindakan apa yang akan dilakukan 
oleh sistem atau aplikasi pada saat user menekan tombol 
tersebut.Berikut merupakan beberapa teknik membuat tombol 
dengan menurunkan dari class Button: 

1. Tombol berisi teks 

Dengan menggunakan kode xml <Button … /> dan 
menyertakan property android:text sebagai judul teks 
yang akan ditempatkan pada tombol. Nilai teks yang akan 
ditampilkan pada tombol dapat langsung diisikan pada nilai 
property atau dapat mengambil dari file 
/res/values/strings.xml. 

<Button 

android:layout_width="wrap_content" 

android:layout_height="wrap_content" 

android:text="@string/button_text" 

... /> 

2. Tombol berisi icon 
Dapat dilakukan dengan menggunakan kode xml 
<ImageButton … /> dan menyertakan property 
android:src sebagai isi icon/gambar yang akan 
ditampilkan pada tombol. Gambar yang akan ditampilkan 
pada tombol dapat disimpan di dalam folder 
/res/drawable-hdpi. 
<ImageButton 

android:layout_width="wrap_content" 

android:layout_height="wrap_content" 

android:src="@drawable/button_icon" 

... /> 
3. Tombol berisi icon dan teks 

Tombol jenis ini sering digunakan dalam aplikasi Android 
untuk memperindah tampilan aplikasi. Untuk property teks 
menggunakan android:text, sedangkan untuk gambar 
icon menggunakan property android:drawableLeft, 



106 
 

dengan catatan file gambar tersebut sudah diletakkan di 
alamat /res/drawable-hdpi. 
<Button 

android:layout_width="wrap_content" 

android:layout_height="wrap_content" 

android:text="@string/button_text" 

android:drawableLeft="@drawable/button_icon" 

... /> 

Dalam project guiButton yang dibuat ini, diperagakan 
teknik menggunakan Button dengan beragam variasi seperti 
yang telah dijelaskan sebelumnya. Selanjutnya ditunjukkan 
teknik untuk mengkombinasikan event click pada tombol 
dengan aksi berupa pesan dalam bentuk Toast, yaitu dialog 
pesan yang dimunculkan dalam waktu beberapa detik saja. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiButton, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 

3. Menyiapkan resources berupa gambar yang akan 
ditampilkan pada Button. Hal ini dilakukan 
dengan meletakkan gambar pada folder 
/res/drawable-hdpi 

4. Ubah isi dari res/layout/activity_main.xml untuk 
menambahkan komponen textview, radiogroup 
dan edittext 

5. Mengubah isi 
src/com.example.guibutton/MainActivity.java 

6. Menjalankan Aplikasi 

 
Langkah 1 Membuat Project 

Application Name : guiButton 
Project Name : guiButton 
Package Name : com.example.guibutton 
Min. Required SDK : API 14 
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Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 
Langkah ini digunakan untuk menyediakan judul teks yang 

nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 

<resources> 

 

<stringname="app_name">guiButton</string> 

<stringname="hello_world">Hello world!</string> 

<stringname="action_settings">Settings</string> 

<stringname="sbthome">Home</string> 

<stringname="sbthelp">Help</string> 

 

</resources> 

Langkah 3 Menyiapkan Resources Gambar 
Beberapa gambar perlu dipersiapkan dengan 

meletakkannya pada folder /res/drawable-hdpi. Perhatikan 
Gambar 4.2. 

 
Gambar 4.2 Resources Gambar 
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Langkah 4 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
linear layout dengan orientasi vertical, sehingga memudahkan 
dalam penyusunan komponen yang dimuat dalam 
Activity.Kemudian layout file  XML berisi kode program seperti 
berikut.  
/res/layout/activity_main.xml 

<LinearLayoutxmlns:android="http://schemas.android.com/ap

k/res/android" 

android:layout_width="fill_parent" 

android:layout_height="fill_parent" 

android:orientation="vertical" 

android:padding="10dp"> 

 

<Button 

android:id="@+id/btnHome" 

android:layout_width="match_parent" 

android:layout_height="wrap_content" 

android:text="@string/sbthome"/> 

 

<Button 

android:id="@+id/btnHelp" 

android:layout_width="match_parent" 

android:layout_height="wrap_content" 

android:drawableLeft="@drawable/help" 

android:text="@string/sbthelp"/> 

 

<ImageButton 

 android:id="@+id/btnExit" 

 android:layout_width="match_parent" 

 android:layout_height="wrap_content" 

 android:src="@drawable/exit" 

 /> 

</LinearLayout> 

Langkah 5 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guibutton/MainActivity.java cukup 
ditambahkan beberapa method seperti yang telah 
didefinisikan pada file /res/layout/activity_main.xml yaitu 
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pesanHome, pesanHelp, dan pesanExit. Perhatikan kode 
program berikut. 

/src/com.example.guibutton/MainActivity.java 

package com.example.guibutton; 

 

import android.app.Activity; 

import android.os.Bundle; 

import android.widget.Button; 

import android.widget.ImageButton; 

import android.widget.Toast; 

import android.view.View; 

 

public class MainActivity extends Activity { 

 Button btnHome, btnHelp; 

 ImageButton btnExit; 

 

 protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

        btnHome = (Button) findViewById(R.id.btnHome); 

        btnHelp = (Button) findViewById(R.id.btnHelp); 

        btnExit = (ImageButton) 

findViewById(R.id.btnExit); 

 

    btnHome.setOnClickListener(new View.OnClickListener() 

{      

    public void onClick(View arg0) { 

          Toast.makeText(MainActivity.this, "Tombol Home 

Diklik", 

              Toast.LENGTH_LONG).show(); 

        } 

     }); 

 

    btnHelp.setOnClickListener(new View.OnClickListener() 

{      

        public void onClick(View arg0) { 

              Toast.makeText(MainActivity.this, "Tombol 

Help Diklik", 

                  Toast.LENGTH_LONG).show(); 

            } 

         }); 

 

    btnExit.setOnClickListener(new View.OnClickListener() 

{      

        public void onClick(View arg0) { 

              Toast.makeText(MainActivity.this, "Tombol 

Exit Diklik", 
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                  Toast.LENGTH_LONG).show(); 

            } 

         }); 

 

} 

} 

Langkah 6 Menjalankan Aplikasi 

Dari kode program terlihat teknik untuk memberikan 
Listener kepada Button untuk menangkap event pada saat 
Button diklik dengan syntax setOnClickListener. Kemudian 
dibuat View.OnClickListener untuk membaca event klik atau 
touch yang dilakukan oleh user. Selanjutnya method yang 
akan dijalankan dimasukkan ke dalam blok program, untuk 
menjalankan Toast dengan menampilkan pesan bagi setiap 
tombol yang diklik. Selanjutnya ketika program dijalankan 
maka akan diperoleh tampilan seperti Gambar 4.3. 

 

(a) Tombol Home     (b) Tombol Help    c) Tombol Exit 

Gambar 4.3 Respon Event Klik pada Tombol 

4.5 BUTTON DENGAN EVENT ONCLICK 

Supaya tombol yang telah dibuat tersebut dapat merespon 
event klik yang dilakukan oleh user, ada beberapa teknik 
yang dapat dilakukan yaitu dengan memberikan event 
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onClickListener yang sudah diperagakan sebelumnya, 
alternatif lain dapat dilakukan dengan memberikan nilai pada 
attribute android:onClickdengan nilai berupa sebuah 
method. 

Teknik onClick ini sangat mudah dilakukan dengan cara 
menambahkan attribute android:onClick pada elemen 
Button dalam file XML yang dibuat. Nilai yang diisikan pada 
attribute android:onClick merupakan sebuah method yang 
nantinya didefinisikan pada file Java. Untuk 
mengimplementasikan respon event klik pada tombol, cukup 
melakukan modifikasi pada masing-masing elemen <Button 
… /> dan <ImageButton … /> dengan menambahkan attribute 
android:onClick. Pada contoh berikut, dilakukan teknik event 
onClick. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiButton1, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 

3. Menyiapkan resources berupa gambar yang 
akan ditampilkan pada Button. Hal ini dilakukan 
dengan meletakkan gambar pada folder 
/res/drawable-hdpi 

4. Ubah isi dari res/layout/activity_main.xml untuk 
menambahkan komponen textview, radiogroup 
dan edittext 

5. Mengubah isi 
src/com.example.guibutton1/MainActivity.java 

6. Menjalankan Aplikasi 

 
Langkah 1 Membuat Project 

Application Name : guiButton1 
Project Name : guiButton1 
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Package Name : com.example.guibutton1 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 
 
Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 

<resources> 

 

<stringname="app_name">guiButton</string> 

<stringname="hello_world">Hello world!</string> 

<stringname="action_settings">Settings</string> 

<stringname="sbthome">Home</string> 

<stringname="sbthelp">Help</string> 

 

</resources> 

 
Langkah 3 Menyiapkan Resources Gambar 

Beberapa gambar perlu dipersiapkan dengan 
meletakkannya pada folder /res/drawable-hdpi. Perhatikan 
Gambar 4.4. 
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Gambar 4.4 Resources Gambar Button 

Langkah 4 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
linear layout dengan orientasi vertical, sehingga memudahkan 
dalam penyusunan komponen yang dimuat dalam Activity. 
Kemudian layout file  XML berisi kode program seperti 
berikut. 
/res/layout/activity_main.xml 

<LinearLayoutxmlns:android="http://schemas.android.com/ap

k/res/android" 

android:layout_width="fill_parent" 

android:layout_height="fill_parent" 

android:orientation="vertical" 

android:padding="10dp"> 

 

<Button 

android:id="@+id/btnHome" 

android:layout_width="match_parent" 

android:layout_height="wrap_content" 

android:text="@string/sbthome" 

       android:onClick="pesanHome"/> 

 

<Button 

android:id="@+id/btnHelp" 

android:layout_width="match_parent" 
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android:layout_height="wrap_content" 

android:drawableLeft="@drawable/help" 

android:text="@string/sbthelp" 

       android:onClick="pesanHelp"/> 

 

<ImageButton 

 android:id="@+id/btnExit" 

 android:layout_width="match_parent" 

 android:layout_height="wrap_content" 

 android:src="@drawable/exit" 

     android:onClick="pesanExit" /> 

</LinearLayout> 

 
Langkah 5 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guibutton1/MainActivity.java cukup 
ditambahkan beberapa method seperti yang telah 
didefinisikan pada file /res/layout/activity_main.xml yaitu 
pesanHome, pesanHelp, dan pesanExit. Perhatikan kode 
program berikut. 

/src/com.example.guibutton1/MainActivity.java 

package com.example.guibutton1; 

 

import android.app.Activity; 

import android.os.Bundle; 

 

import android.widget.Button; 

import android.widget.ImageButton; 

import android.widget.Toast; 

import android.view.View; 

 

publicclass MainActivity extends Activity { 

 Button btnHome, btnHelp; 

 ImageButton btnExit; 

 

protectedvoid onCreate(Bundle savedInstanceState) { 

super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

btnHome = (Button) findViewById(R.id.btnHome); 

btnHelp = (Button) findViewById(R.id.btnHelp); 

btnExit = (ImageButton) findViewById(R.id.btnExit); 

    } 

publicvoid pesanHome(View pesan){ 
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 Toast.makeText(MainActivity.this, "Tombol Home 

Diklik", 

   Toast.LENGTH_LONG).show(); 

    } 

publicvoid pesanHelp(View pesan){ 

 Toast.makeText(MainActivity.this, "Tombol Help 

Diklik", 

   Toast.LENGTH_LONG).show(); 

    } 

 

publicvoid pesanExit(View pesan){ 

 Toast.makeText(MainActivity.this, "Tombol Exit 

Diklik", 

   Toast.LENGTH_LONG).show(); 

    } 

 

} 

Langkah 6 Menjalankan Aplikasi 

Dalam project yang dibuat digunakan 2 buah jenis tombol 
yaitu Button dan ImageButton, maka diperlukan 2 proses 
import, yaitu: 

import android.widget.Button; 

import android.widget.ImageButton; 

Selanjutnya import android.widget.Toast; 

digunakan untuk mengimplementasikan pesan yang akan 
ditampilkan beberapa detik di dalam aplikasi. Sedangkan 
import android.view.View; digunakan untuk 

mengimplementasikan method di dalam aplikasi.Setiap objek 
yang didefinisikan pada aplikasi diinisialisasi sebagai objek 
yang diturunkan dari Class Button dan ImageButton seperti 
notasi berikut. 

Button btnHome, btnHelp; 

ImageButton btnExit; 

Sedangkan supaya setiap tombol yang didefinisikan pada 
layout XML dapat dikenali oleh program Java perlu diberikan 
definisi seperti pada kode program berikut. 

btnHome = (Button) findViewById(R.id.btnHome); 
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btnHelp = (Button) findViewById(R.id.btnHelp); 

btnExit = (ImageButton) findViewById(R.id.btnExit); 

Selanjutnya jalankan aplikasi sehingga diperoleh tampilan 
seperti pada Gambar 4.5, pada 4.5. (a) merupakan respon 
ketika tombol Home diklik, 4.5. (b) merupakan respon ketika 
tombol Help diklik, dan 4.5 (c) merupakan respon ketika 
tombol Exit diklik.  

 

(a) Tombol Home     (b) Tombol Help     (c) Tombol Exit 

Gambar 4.5 Respon Event Klik pada Tombol Button 

4.6 MENYEDERHANAKAN EVENT KLICK PADA BUTTON 

Dari kedua contoh program yang telah dibuat sebelumnya 
sudah cukup efektif jika tombol yang digunakan jumlahnya 
sedikit. Jika suatu saat kode program yang digunakan dalam 
aplikasi lumayan banyak, maka kedua cara yang telah 
dilakukan dapat disederhanakan dengan menggunakan teknik 
berikut. Buatlah sebuah project aplikasi Android dengan nama 
guiButton3.    

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiButton3, minimal required SDK 
API 14, target dan compile with menggunakan 
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API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 

3. Menyiapkan resources berupa gambar yang akan 
ditampilkan pada Button. Hal ini dilakukan 
dengan meletakkan gambar pada folder 
/res/drawable-hdpi 

4. Ubah isi dari res/layout/activity_main.xml untuk 
menambahkan komponen textview, radiogroup 
dan edittext 

5. Mengubah isi 
src/com.example.guibutton3/MainActivity.java 

6. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiButton3 
Project Name : guiButton3 
Package Name : com.example.guibutton3 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 
Langkah ini digunakan untuk menyediakan judul teks yang 

nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xmlversion="1.0"encoding="utf-8"?> 

<resources> 

 

<stringname="app_name">guiButton3</string> 

<stringname="hello_world">Hello world!</string> 

<stringname="action_settings">Settings</string> 

<stringname="sbthome">Home</string> 

<stringname="sbthelp">Help</string> 

 

</resources> 
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Langkah 3 Menyiapkan Resources Gambar 

Beberapa gambar perlu dipersiapkan dengan 
meletakkannya pada folder /res/drawable-hdpi. Perhatikan 
Gambar 4.6. 

 

Gambar 4.6 Resources Gambar Button Modifikasi 

Langkah 4 Mendefinisikan Layout 
Selanjutnya pada layout XML, definisikan beberapa buah 

tombol dengan layout linear seperti pada kode berikut. 
Perhatikan pada setiap tombol diberikan satu buah attribute 
dengan isian yang sama yaitu 
android:onClick="tampilPesan", yang bertujuan 

apapun tombol yang nantinya diklik oleh user akan 
menjalankan method yang sama. 

/res/layout/activity_main.xml 

<LinearLayoutxmlns:android="http://schemas.android.com/ap

k/res/android" 

android:layout_width="fill_parent" 

android:layout_height="fill_parent" 

android:orientation="vertical" 

android:padding="10dp"> 
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<Button 

android:id="@+id/btnHome" 

android:layout_width="match_parent" 

android:layout_height="wrap_content" 

android:text="@string/sbthome" 

android:onClick="tampilPesan"/> 

 

<Button 

android:id="@+id/btnHelp" 

android:layout_width="match_parent" 

android:layout_height="wrap_content" 

android:text="@string/sbthelp" 

android:drawableLeft="@drawable/help" 

android:onClick="tampilPesan"/> 

 

<ImageButton 

 android:id="@+id/btnExit" 

 android:layout_width="match_parent" 

 android:layout_height="wrap_content" 

 android:src="@drawable/exit" 

android:onClick="tampilPesan"/> 

 

</LinearLayout> 

Langkah 5 Menambahkan Kode Program 
MainActivity.java 

Selanjutnya pada file java, definisikan kode program 
seperti berikut. Perhatikan pada notasi program hanya dibuat 
satu buah method dengan nama tampilPesan( ), dengan 
melewatkan satu buah parameter bernama tombol dari Class 
View.  
/src/com.example.guibutton3/MainActivity.java 

package com.example.guibutton3; 

 

import android.app.Activity; 

import android.os.Bundle; 

 

import android.widget.Button; 

import android.widget.ImageButton; 

import android.widget.Toast; 

import android.view.View; 

 

publicclass MainActivity extends Activity { 

 Button btnHome, btnHelp; 

 ImageButton btnExit; 
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protectedvoid onCreate(Bundle savedInstanceState) { 

super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

btnHome = (Button) findViewById(R.id.btnHome); 

btnHelp = (Button) findViewById(R.id.btnHelp); 

btnExit = (ImageButton) findViewById(R.id.btnExit); 

    } 

 

publicvoid tampilPesan(View tombol){ 

 switch(tombol.getId()){ 

 case R.id.btnHome: 

 Toast.makeText(MainActivity.this, "Tombol Home 

Diklik", 

   Toast.LENGTH_LONG).show(); 

  break; 

 case R.id.btnHelp: 

 Toast.makeText(MainActivity.this, "Tombol Help 

Diklik", 

   Toast.LENGTH_LONG).show(); 

  break; 

 case R.id.btnExit: 

 Toast.makeText(MainActivity.this, "Tombol Exit 

Diklik", 

   Toast.LENGTH_LONG).show(); 

  break; 

 default: 

  break; 

 } 

    }    

} 

Langkah 6 Menjalankan Aplikasi 
Dari kode program terlihat teknik untuk menjalankan Toast 

dengan menampilkan pesan bagi setiap tombol yang diklik. 
Selanjutnya ketika program dijalankan maka akan diperoleh 
tampilan seperti Gambar 4.7. 
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(a) Tombol Home      (b) Tombol Help    (c) Tombol Exit 

Gambar 4.7 Respon Event Klik pada Tombol Modifikasi 

4.7 MENGGUNAKAN TEKS ISIAN 

Teks isian lazim digunakan sebagai kontrol masukan untuk 
melakukan proses input data yang dilakukan oleh user. Teks 
isian merupakan kontrol yang akan banyak dipakai oleh user 
untuk berinteraksi dengan aplikasi Android. Teks isian yang 
sering digunakan adalah EditText, AutoCompleteTextView, 

dan MultiCompleteTextView. EditText merupakan control yang 

menjadi subclass dari TextView. Property penting yang perlu 

diperhatikan adalah inputType untuk menentukan jenis tipe 

data yang akan dimasukkan melalui TextView. Property 

lainnya yang juga penting adalah singleLine yang mengatur 

supaya data yang diinput hanya satu baris saja. Sedangkan 
property textMultiLine untuk mengatur supaya teks isian 

dapat menampung beberapa baris data. 

Kontrol AutoCompleteTextVew adalah sebuah control yang 

memiliki fungsinalitas auto-complete, yang artinya pada saat 
user mengisi teks isian akan diberi saran daftar isian yang 
dapat dipilih oleh user. Daftar isian yang diberikan oleh 
Android berasal dari daftar isian yang telah diatur oleh 
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programmer. Ketika potongan data yang dimasukkan oleh 
user terdapat dalam daftar isian yang ditentukan oleh 
programmer, maka daftar isian yang disarankan oleh Android 
akan ditampilkan. Selanjutnya user tinggal memilih salah satu 
saran yang diberikan tersebut. Sedangkan 
MultiAutoCompleteTextVew merupakan perluasan dari 

AutoCompleteTextVew yang dapat memberikan saran data, 

sehingga dapat dipilih oleh oleh user dengan input data yang 
jumlahnya lebih dari satu dan dipisahkan dengan tanda koma. 

Berikut merupakan contoh project bagaimana 
mengimplementasikan beragam kontrol teks isian. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiText, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 

3. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, 
editText, AutoCompleteTextView, dan Multi 
AutoCompleteTextView 

4. Mengubah isi 
src/com.example.guitext/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiText 
Project Name : guiText 
Package Name : com.example.guitext 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 
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Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

 

    <string name="app_name">guiText</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="action_settings">Settings</string> 

 

</resources> 

Langkah 3 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
teks isian dengan menggunakan jenis layout relative, 
kemudian layout file  XML berisi kode program seperti berikut. 

/res/layout/activity_main.xml 

<RelativeLayout 

xmlns:android="http://schemas.android.com/apk/res/android

" 

    xmlns:tools="http://schemas.android.com/tools" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    

android:paddingBottom="@dimen/activity_vertical_margin" 

    

android:paddingLeft="@dimen/activity_horizontal_margin" 

    

android:paddingRight="@dimen/activity_horizontal_margin" 

    android:paddingTop="@dimen/activity_vertical_margin" 

    tools:context="com.putriproject10.MainActivity" > 

 

    <TextView 

        android:id="@+id/textView1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:layout_alignParentLeft="true" 

        android:layout_alignParentTop="true" 

        android:layout_marginLeft="24dp" 

        android:layout_marginTop="19dp" 
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        android:text="TextView" /> 

 

    <EditText 

        android:id="@+id/editText1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:layout_alignLeft="@+id/textView2" 

        android:layout_below="@+id/textView1" 

        android:layout_marginLeft="15dp" 

        android:layout_marginTop="15dp" 

        android:ems="10" 

        android:inputType="textPersonName" > 

 

        <requestFocus /> 

    </EditText> 

 

    <TextView 

        android:id="@+id/textView2" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:layout_alignLeft="@+id/textView1" 

        android:layout_below="@+id/editText1" 

        android:layout_marginTop="14dp" 

        android:text="TextView" /> 

 

    <AutoCompleteTextView 

        android:id="@+id/autoCompleteTextView1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:layout_alignLeft="@+id/textView2" 

        android:layout_below="@+id/textView2" 

        android:layout_marginTop="18dp" 

        android:ems="10" 

        android:text="AutoCompleteTextView" /> 

 

    <TextView 

        android:id="@+id/textView3" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        

android:layout_alignLeft="@+id/autoCompleteTextView1" 

        android:layout_below="@+id/autoCompleteTextView1" 

        android:layout_marginTop="20dp" 

        android:text="TextView" /> 

 

    <MultiAutoCompleteTextView 

        android:id="@+id/multiAutoCompleteTextView1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 
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        android:layout_alignLeft="@+id/textView3" 

        android:layout_below="@+id/textView3" 

        android:layout_marginTop="20dp" 

        android:ems="10" 

        android:text="MultiAutoCompleteTextView" /> 

 

</RelativeLayout> 

Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guitext/MainActivity.java dengan 
menambahkan beberapa data array sebagai bagian dari 
daftar isian yang dapat dipilih oleh user. Perhatikan kode 
program berikut. 

/src/com.example.guitext/MainActivity.java 

package com.example.guitext; 

 

import android.app.Activity; 

import android.os.Bundle; 

 

import android.widget.TextView; 

import android.widget.EditText; 

import android.widget.AutoCompleteTextView; 

import android.widget.MultiAutoCompleteTextView; 

import android.widget.ArrayAdapter; 

 

 

 

public class MainActivity extends Activity { 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

         

        TextView tv1 = (TextView) 

findViewById(R.id.textView1); 

        TextView tv2 = (TextView) 

findViewById(R.id.textView2); 

        TextView tv3 = (TextView) 

findViewById(R.id.textView3); 

        TextView et1 = (EditText) 

findViewById(R.id.editText1); 

        AutoCompleteTextView auto1 = 
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(AutoCompleteTextView) 

         

 findViewById(R.id.autoCompleteTextView1); 

        MultiAutoCompleteTextView mauto1 = 

(MultiAutoCompleteTextView) 

         

 findViewById(R.id.multiAutoCompleteTextView1); 

         

        tv1.setText("Nama "); 

        tv2.setText("Jenis Kelamin "); 

        tv3.setText("Hobby "); 

        et1.setText(""); 

        auto1.setText(""); 

        mauto1.setText(""); 

         

        //setting auto complete text view 

        ArrayAdapter<String> aa = new 

ArrayAdapter<String>(this, 

         

 android.R.layout.simple_dropdown_item_1line, 

        new String[] {"Laki - Laki", "Perempuan" }); 

        auto1.setAdapter(aa); 

        //setting multi auto complete text view 

        ArrayAdapter<String> aa2 = new 

ArrayAdapter<String>(this, 

         

 android.R.layout.simple_dropdown_item_1line, 

        new String[] {"Membaca", "Menyanyi", "Memancing", 

"Olahraga", "Musik", "Belanja" }); 

        mauto1.setAdapter(aa2); 

        mauto1.setTokenizer(new 

MultiAutoCompleteTextView.CommaTokenizer()); 

         

    } 

} 

Langkah 5 Menjalankan Aplikasi 

Dari kode program terlihat teknik untuk mengisi data pada 
teks isian dengan mendapatkan saran berupa daftar isian 
yang dapat dipilih oleh pengguna. Selanjutnya ketika program 
dijalankan maka akan diperoleh tampilan seperti Gambar 4.8. 
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Gambar 4.8 Teks Isian dengan Saran Daftar Isian 

4.8 MENGGUNAKAN RADIO BUTTON 

Interaksi antara pengguna dengan aplikasi Android dapat 
dijembatani dengan menyediakan sejumlah pilihan yang 
dapat dipilih oleh pengguna. Sejumlah pilihan ini dapat 
dijadikan validasi data dengan membatasi sejumlah item data 
yang sudah ditentukan. Beberapa kontrol yang masuk ke 
dalam kontrol pilihan diantaranya radio button, check box, 
toggle button, spinner dan picker.  

Radio button digunakan untuk melakukan input data 
dengan memilih salah satu dari item data yang disediakan. 
Cukup memilih satu dari sekian banyak item data tersebut. 
Misalnya untuk memilih jenis kelamin antara laki-laki dan 
perempuan. Memilih antara ya dan tidak, dan informasi 
serupa lainnya. Di Android, dapat menggunakan class 
android.widget.RadioButton, untuk membuat elemen layout 

radio button. Radio Button di Android biasanya 
digrup/dibungkus lagi dengan kelas 
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android.widget.RadioGroup, supaya apabila satu RadioButton 

di dalam RadioGroup sudah dipilih/dicentang, maka 
RadioButton yang lainnya akan otomatis state nya berubah 
menjadi unselected/tidak terpilih. 

Berikut merupakan tahapan yang berisi langkah-langkah 
yang dapat digunakan untuk membuat proyek aplikasi berisi 
kontrol Radio Button. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiPilihan, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 

3. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, 
Radio Button, dan Button. 

4. Mengubah isi 
src/com.example.guipilihan/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiPilihan 
Project Name : guiPilihan 
Package Name : com.example.guipilihan 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 
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/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 
<resources> 
 
    <string name="app_name">guiPilihan</string> 
    <string name="hello_world">Hello world!</string> 
    <string name="action_settings">Settings</string> 
    <string name="stv_sex">Pilih Jenis Kelamin : </string> 
    <string name="srb_laki">Laki - Laki</string> 
    <string name="srb_perempuan">Perempuan</string> 
    <string name="sbt_submit">Submit</string> 
 
</resources> 

Langkah 3 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
Radio Button yang dibungkus dengan Radio Group dengan 
menggunakan jenis layout linear, kemudian layout file  XML 
berisi kode program seperti berikut. 

/res/layout/activity_main.xml 

<LinearLayout 
xmlns:android="http://schemas.android.com/apk/res/android" 
    android:layout_width="fill_parent" 
    android:layout_height="fill_parent" 
    android:padding="10dp" 
    android:orientation="vertical" > 
 
    <TextView 
        android:id="@+id/textView1" 
        android:layout_width="wrap_content" 
        android:layout_height="wrap_content" 
        android:text="@string/stv_sex" /> 
 <RadioGroup 
        android:id="@+id/rg_sex" 
        android:layout_width="wrap_content" 
        android:layout_height="wrap_content"> 
  
        <RadioButton 
            android:id="@+id/rb_laki" 
            android:layout_width="wrap_content" 
            android:layout_height="wrap_content" 
            android:checked="true" 
            android:text="@string/srb_laki" /> 
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        <RadioButton 
            android:id="@+id/rb_perempuan" 
            android:layout_width="wrap_content" 
            android:layout_height="wrap_content" 
            android:text="@string/srb_perempuan" /> 
    </RadioGroup> 
    <Button 
        android:id="@+id/bt_submit" 
        android:layout_width="wrap_content" 
        android:layout_height="wrap_content" 
        android:text="@string/sbt_submit" /> 
</LinearLayout> 

Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guipilihan/MainActivity.java dengan 
menambahkan beberapa data array sebagai bagian dari 
daftar isian yang dapat dipilih oleh user. Perhatikan kode 
program berikut. 

/src/com.example.guipilihan/MainActivity.java 

package com.example.guipilihan; 
 
import android.app.Activity; 
import android.os.Bundle; 
import android.widget.Button; 
import android.widget.RadioButton; 
import android.widget.RadioGroup; 
import android.widget.Toast; 
import android.view.View; 
 
 
public class MainActivity extends Activity { 
 
    @Override 
    protected void onCreate(Bundle savedInstanceState) { 
        super.onCreate(savedInstanceState); 
        setContentView(R.layout.activity_main); 
         
        final RadioGroup rgGender = (RadioGroup) 
findViewById(R.id.rg_sex); 
        Button btSubmit = (Button) 
findViewById(R.id.bt_submit); 
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        btSubmit.setOnClickListener(new View.OnClickListener() 
{ 
            @Override 
            public void onClick(View view) { 
                int id = rgGender.getCheckedRadioButtonId(); 
                switch (id){ 
                    case R.id.rb_laki : 
                        Toast.makeText(MainActivity.this,"Anda 
Memilih: "+((RadioButton)findViewById(id)).getText(), 
Toast.LENGTH_SHORT).show(); 
                        break; 
                    case R.id.rb_perempuan : 
                        Toast.makeText(MainActivity.this,"Anda 
Memilih: "+((RadioButton)findViewById(id)).getText(), 
Toast.LENGTH_SHORT).show(); 
                        break; 
                } 
            } 
        }); 
    } 
} 
 

Langkah 5 Menjalankan Aplikasi 

Dari kode program terlihat teknik untuk memilih salah satu 
item yang disediakan oleh radio button. Ketika pilihan sudah 
ditentukan, kemudian pada saat pengguna mengklik tombol 
Submit akan dimunculkan informasi sesuai dengan pilihan 
yang sudah ditentukan. Selanjutnya ketika program dijalankan 
maka akan diperoleh tampilan seperti Gambar 4.9. 
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Gambar 4.9 Menggunakan Radio Button 

4.9 MENGGUNAKAN CHECK BOX 

Kontrol checkbox merupakan jenis input data bagi 
pengguna untuk memilih dengan lebih dari satu pilihan item. 
Berbeda dengan radio button yang hanya dibatasi untuk 
memilih satu saja dari sejumlah item pilihan yang disediakan. 

Berikut merupakan tahapan dalam membuat aplikasi 
Android yang mengimplementasikan Checkbox. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiCheck, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 
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3. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, 
Check Box, dan Button. 

4. Mengubah isi 
src/com.example.guicheck/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiCheck 
Project Name : guiCheck 
Package Name : com.example.guicheck 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

 

    <string name="app_name">guiCheck</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="action_settings">Settings</string> 

    <string name="stv_ormawa">Organisasi Kemahasiswaan: </string> 

    <string name="scb_rohis">Kerohanian Islam</string> 

    <string name="scb_seni">Seni dan Budaya</string> 

    <string name="scb_lpm">Lembaga Pers Mahasiswa</string> 

    <string name="scb_bugar">Olah Raga dan Kebugaran</string> 

    <string name="scb_robotika">Robotika Cerdas</string> 

    <string name="sbt_pilih">Pilihan Anda</string> 

 

</resources> 
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Langkah 3 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
Check Box dengan menggunakan jenis layout linear vertical, 
kemudian layout file  XML berisi kode program seperti berikut. 

/res/layout/activity_main.xml 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android

" 

    android:layout_width="fill_parent" 

    android:layout_height="fill_parent" 

    android:padding="10dp" 

    android:orientation="vertical" > 

 

    <TextView 

        android:id="@+id/textView1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/stv_ormawa" /> 

 

    <CheckBox 

        android:id="@+id/cb_rohis" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/scb_rohis" /> 

 

    <CheckBox 

        android:id="@+id/cb_seni" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/scb_seni" /> 

 

    <CheckBox 

        android:id="@+id/cb_lpm" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/scb_lpm" /> 

 

    <CheckBox 

        android:id="@+id/cb_bugar" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/scb_bugar" /> 

 

    <CheckBox 

        android:id="@+id/cb_robotika" 

        android:layout_width="wrap_content" 
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        android:layout_height="wrap_content" 

        android:text="@string/scb_robotika" /> 

 

    <Button 

        android:id="@+id/button1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/sbt_pilih" /> 

 

    <TextView 

        android:id="@+id/textView2" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="TextView" /> 

 

</LinearLayout> 

Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guicheck/MainActivity.java dengan 
menambahkan beberapa data array sebagai bagian dari 
daftar isian yang dapat dipilih oleh user. Perhatikan kode 
program berikut. 

/src/com.example.guicheck/MainActivity.java 

package com.example.guicheck; 

 

import android.app.Activity; 

import android.os.Bundle; 

import android.view.View; 

import android.widget.Button; 

import android.widget.CheckBox; 

import android.widget.TextView; 

 

 

public class MainActivity extends Activity { 

 CheckBox vcb_rohis; 

 CheckBox vcb_seni; 

 CheckBox vcb_lpm; 

 CheckBox vcb_bugar; 

 CheckBox vcb_robotika; 

 Button btnPilih; 

 TextView txtHasil; 

 StringBuilder str; 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 
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        setContentView(R.layout.activity_main); 

        vcb_rohis = (CheckBox)findViewById(R.id.cb_rohis); 

        vcb_seni = (CheckBox)findViewById(R.id.cb_seni); 

        vcb_lpm = (CheckBox)findViewById(R.id.cb_lpm); 

        vcb_bugar = (CheckBox)findViewById(R.id.cb_bugar); 

        vcb_robotika = (CheckBox)findViewById(R.id.cb_robotika); 

        btnPilih = (Button)findViewById(R.id.button1); 

        txtHasil = (TextView)findViewById(R.id.textView2); 

         

        btnPilih.setOnClickListener(new View.OnClickListener() { 

         @Override 

         public void onClick(View arg0) { 

         str = new StringBuilder(); 

         if(vcb_rohis.isChecked()){ 

          str.append("Kerohanian Islam, "); 

         } 

         if(vcb_seni.isChecked()){ 

          str.append("Seni dan Budaya, "); 

         } 

         if(vcb_lpm.isChecked()){ 

          str.append("Lembaga Pers Mahasiswa, "); 

         } 

         if(vcb_bugar.isChecked()){ 

          str.append("Olahraga dan Kebugaran, "); 

         } 

         if(vcb_robotika.isChecked()){ 

          str.append("Robitika Cerdas "); 

         } 

         txtHasil.setText(str); 

        } 

        }); 

    } 

} 

 

Langkah 5 Menjalankan Aplikasi 

Dari kode program terlihat teknik untuk memilih salah satu 
item yang disediakan oleh Check Box. Ketika pilihan sudah 
ditentukan, kemudian pada saat pengguna mengklik tombol 
‘Pilihan Anda’ akan dimunculkan informasi sesuai dengan 
pilihan yang sudah ditentukan yang ditempatkan pada control 
TextView tepat di bawah tombol. Selanjutnya ketika program 
dijalankan maka akan diperoleh tampilan seperti Gambar 
4.10. 
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Gambar 4.10 Menggunakan Check Box 

4.10 MENGGUNAKAN SPINNER 

Spinner merupakan salah satu kontrol yang sering 
digunakan dalam aplikasi Android. Spinner merupakan jenis 
daftar dropdown seperti combobox, berisi daftar item yang 
dapat dipilih. Spinner dapat menghemat tempat bagi layout 
aplikasi Android. Spinner biasa digunakan untuk 
memudahkan pengguna memilih salah satu value dari sebuah 
list/array yang disajikan dengan cepat. 

Property penting yang perlu diperhatikan pada control 
spinner adalah entries yang lazimnya mengambil data array 
baik secara statis yang ditempatkan pada file 
/res/values/strings.xml, maupun secara dinamis dengan 
mendefinisikan array pada kode program java di MainActivity. 
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Berikut merupakan langkah-langkah dalam membuat 
aplikasi Android yang mengimplementasikan Spinner dalam 
menampung data dan ditampilkan pada saat dijalankan. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiSpinner, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 

3. Ubah isi dari res/layout/activity_main.xml untuk 
menambahkan komponen textview, Spinner, 
dan Button. 

4. Mengubah isi 
src/com.example.guispinner/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiSpinner 
Project Name : guiSpinner 
Package Name : com.example.guispinner 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

 

    <string name="app_name">guiSpinner</string> 

    <string name="hello_world">Hello world!</string> 
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    <string name="action_settings">Settings</string> 

    <string name="stv_bulan">Nama Bulan: </string> 

    <string name="sbtn_submit">Submit </string> 

 <string-array name="nama_bulan"> 

     <item>Januari</item> 

     <item>Februari</item> 

     <item>Maret</item> 

     <item>April</item> 

     <item>Mei</item> 

     <item>Juni</item> 

     <item>Juli</item> 

     <item>Agustus</item> 

     <item>September</item> 

     <item>Oktober</item> 

     <item>Nopember</item> 

     <item>Desember</item> 

 </string-array> 

</resources> 

 

Langkah 3 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
Spinner dengan menggunakan jenis layout linear vertical, 
kemudian layout file  XML berisi kode program seperti berikut. 

/res/layout/activity_main.xml 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android

" 

    android:layout_width="fill_parent" 

    android:layout_height="fill_parent" 

    android:padding="10dp" 

    android:orientation="vertical" > 

 

    <TextView 

        android:id="@+id/textView1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/stv_bulan" /> 

 

    <Spinner 

        android:id="@+id/spinner1" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:entries="@array/nama_bulan" /> 
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    <Button 

        android:id="@+id/button1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/sbtn_submit" /> 

 

</LinearLayout> 

Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guispinner/MainActivity.java dengan 
menambahkan beberapa data array sebagai bagian dari 
daftar isian yang dapat dipilih oleh user. Perhatikan kode 
program berikut. 

/src/com.example.guispinner/MainActivity.java 

package com.example.guispinner; 

 

import android.app.Activity; 

import android.os.Bundle; 

 

import android.view.View; 

import android.widget.Button; 

import android.widget.Spinner; 

import android.widget.Toast; 

 

 

public class MainActivity extends Activity { 

 private Spinner spn_bulan; 

 private Button btn_submit; 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

         

        spn_bulan = (Spinner) findViewById(R.id.spinner1); 

        btn_submit = (Button) findViewById(R.id.button1); 

        btn_submit.setOnClickListener(new View.OnClickListener() 

{ 

            @Override 

            public void onClick(View view) { 

                Toast.makeText(MainActivity.this, "Pilihan: "+ 

spn_bulan.getSelectedItem().toString(), 

Toast.LENGTH_SHORT).show(); 

            } 

        }); 

    } 

} 
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Langkah 5 Menjalankan Aplikasi 

Scenario yang dihasilkan dari aplikasi Android adalah 
ketika pengguna memilih salah satu item data yang ada di 
Spinner, selanjutnya dapat mengklik tombol Submit. 
Selanjutnya sebuah Toast akan ditampilkan untuk 
memberitahu item data yang telah dipilih. Selanjutnya ketika 
program dijalankan maka akan diperoleh tampilan seperti 
Gambar 4.11. 

 
Gambar 4.11 Tampilan Kontrol Spinner 

4.11 MENGGUNAKAN TOGGLE BUTTON 

Toggle Button merupakan salah satu jenis kontrol input 
data yang dapat dipilih oleh pengguna dengan dua buah 
kondisi seperti saklar yaitu kondisi hidup dan mati, ON dan 
OFF. Status dari label yang dimiliki oleh Toggle button dapat 
dimodifikasi sehingga dapat digunakan untuk berbagai 
keperluan. 
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Berikut merupakan tahapan yang berisi langkah-langkah 
untuk mengimplementasikan toggle button. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiToggle, minimal required 
SDK API 14, target dan compile with 
menggunakan API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml 

3. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen textview, 
Toggle Button, dan Button. 

4. Mengubah isi 
src/com.example.guitoggle/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiToggle 
Project Name : guiToggle 
Package Name : com.example.guitoggle 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

 

    <string name="app_name">guiToggle</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="action_settings">Settings</string> 

    <string name="stv_toogle">Menggunakan Toggle Button</string> 
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    <string name="sbt_toogle">Cek Status Toggle</string> 

    <string name="stg_nyala">MENYALA</string> 

    <string name="stg_mati">MATI</string> 

 

</resources> 

Langkah 3 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
Toggle dengan menggunakan jenis layout linear vertical, 
kemudian layout file  XML berisi kode program seperti berikut. 

/res/layout/activity_main.xml 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android

" 

    android:layout_width="fill_parent" 

    android:layout_height="fill_parent" 

    android:gravity="center_horizontal|center_vertical" 

    android:orientation="vertical" > 

 

    <TextView 

 android:layout_width="wrap_content" 

 android:layout_height="wrap_content" 

 android:text="@string/stv_toogle" /> 

  

    <ToggleButton 

        android:id="@+id/tgl_1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" /> 

  

    <ToggleButton 

        android:id="@+id/tgl_2" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content"         

        android:textOff="@string/stg_mati" 

        android:textOn="@string/stg_nyala" /> 

  

    <Button 

        android:id="@+id/bt_toggle" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/sbt_toogle" /> 

 

</LinearLayout> 
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Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guitoggle/MainActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.guitoggle/MainActivity.java 

package com.example.guitoggle; 

 

import android.app.Activity; 

import android.os.Bundle; 

 

import android.widget.Button; 

import android.widget.ToggleButton; 

import android.view.View; 

import android.widget.Toast; 

 

 

public class MainActivity extends Activity { 

 ToggleButton toggleButton1, toggleButton2; 

    Button btState; 

     

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

         

        toggleButton1 = (ToggleButton) 

findViewById(R.id.tgl_1); 

        toggleButton2 = (ToggleButton) 

findViewById(R.id.tgl_2); 

        btState = (Button) findViewById(R.id.bt_toggle); 

  

        btState.setOnClickListener(new 

View.OnClickListener() { 

            @Override 

            public void onClick(View view) { 

                StringBuilder result = new 

StringBuilder(); 

                result.append("Status toggleButton1 : 

").append(toggleButton1.isChecked()); 

                result.append("\nStatus toggleButton2 : 

").append(toggleButton2.isChecked()); 

  

                Toast.makeText(MainActivity.this, 

result.toString(), 

                        Toast.LENGTH_SHORT).show(); 
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            } 

        }); 

    } 

} 

 

Langkah 5 Menjalankan Aplikasi 

Skenario yang dihasilkan dari aplikasi Android adalah 
ketika pengguna mengubah state dari Toggle, pada kontrol 
Toggle bagian atas tetap menggunakan label bawaan. 
Sedangkan pada Toggle bagian bawah menggunakan label 
yang sudah dimodifikasi. Selanjutnya sebuah Toast akan 
ditampilkan untuk memberitahu status/kondisi Toggle yang 
melekat pada masing-masing kontrol. Selanjutnya ketika 
program dijalankan maka akan diperoleh tampilan seperti 
Gambar 4.12. 

 
Gambar 4.12 Tampilan Kontrol Toggle 
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4.12 MENGGUNAKAN DATE DAN TIME PICKER 

Kontrol Date dan Time Picker akan banyak digunakan 
pada aplikasi Android yang berhubungan dengan tanggal dan 
waktu. Kontrol ini penting untuk melakukan validasi input 
data, mengingat format tanggal dan waktu berhubungan 
dengan database management system dan formatnya 
berbeda antar Negara. 

Berikut merupakan tahapan dalam mengimplementasikan 
Date Picker dan Time Picker dalam aplikasi Android. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiPicker, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml. 

3. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen Date Picker, 
Time Picker, dan Button. 

4. Mengubah isi 
src/com.example.guipicker/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiPicker 
Project Name : guiPicker 
Package Name : com.example.guipicker 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 
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Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen yang ada di 
layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

 

    <string name="app_name">guiPicker</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="action_settings">Settings</string> 

    <string name="sbt_tampil">Tampilkan Tanggal dan 

Waktu</string> 

 

</resources> 

Langkah 3 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini berupa 
Date Picker dan Time Picker dengan menggunakan jenis 
layout linear ScrollView, kemudian layout file  XML berisi kode 
program seperti berikut. 

/res/layout/activity_main.xml 

<ScrollView 

xmlns:android="http://schemas.android.com/apk/res/android

" 

    android:id="@+id/scrollView1" 

    android:layout_width="fill_parent" 

    android:layout_height="fill_parent" > 

 

    <LinearLayout 

        android:layout_width="match_parent" 

        android:layout_height="match_parent" 

        android:gravity="center_horizontal" 

        android:orientation="vertical" > 

         

    <DatePicker 

        android:id="@+id/datePicker1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:layout_alignParentLeft="true" 

        android:layout_below="@+id/textView1" 

        android:layout_marginTop="46dp" 

        android:calendarViewShown="false" /> 
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    <TimePicker 

        android:id="@+id/timePicker1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:layout_alignParentLeft="true" 

        android:layout_below="@+id/textView1" 

        android:layout_marginLeft="14dp" 

        android:layout_marginTop="30dp" /> 

     

    <Button 

        android:id="@+id/btnOK" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:layout_alignParentLeft="true" 

        android:layout_below="@+id/datePicker1" 

        android:layout_marginLeft="15dp" 

        android:text="@string/sbt_tampil" /> 

     

    </LinearLayout> 

 

</ScrollView> 

Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guipicker/MainActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.guipicker/MainActivity.java 

package com.example.guipicker; 

 

import android.app.Activity; 

import android.os.Bundle; 

import android.view.View; 

import android.view.View.OnClickListener; 

import android.widget.Button; 

import android.widget.DatePicker; 

import android.widget.TimePicker; 

import android.widget.TimePicker.OnTimeChangedListener; 

import android.widget.Toast; 

 

 

 

public class MainActivity extends Activity { 

    DatePicker dp; 

    Button tombolOK; 

    OnClickListener listenerDate; 

    TimePicker tp; 
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    OnTimeChangedListener listenerTime; 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

        dp = (DatePicker) findViewById(R.id.datePicker1); 

        tombolOK = (Button) findViewById(R.id.btnOK); 

        tp = (TimePicker) findViewById(R.id.timePicker1); 

 

        //listener jika dilakukan klik pada tombol OK 

        listenerDate = new OnClickListener() { 

            @Override 

            public void onClick(View arg0) { 

                Toast.makeText(MainActivity.this,"Tanggal: 

"+dp.getDayOfMonth()+ 

                                "-"+(dp.getMonth()+1)+ 

                                "-"+dp.getYear(), 

                        Toast.LENGTH_SHORT).show(); 

            } 

        }; 

 

        //menerapkan listener pada Button 

        tombolOK.setOnClickListener(listenerDate); 

         

      //listener jika terjadi perubahan isi TimePicker 

        listenerTime = new OnTimeChangedListener() { 

            @Override 

            public void onTimeChanged(TimePicker view, int 

hourOfDay, 

                                      int minute) { 

                Toast.makeText(MainActivity.this,"Set Waktu: 

"+hourOfDay+":"+minute, 

                        Toast.LENGTH_SHORT).show(); 

            } 

        }; 

        //Menerapkan listener pada TimePicker tp 

        tp.setOnTimeChangedListener(listenerTime); 

    } 

} 

 

Langkah 5 Menjalankan Aplikasi 

Skenario yang dihasilkan dari aplikasi Android adalah 
ketika pengguna memilih tanggal yang sudah ditentukan pada 
Date Picker, maka ketika tombol di bagian bawah ditekan 
akan dimunculkan nilai tanggal yang dipilih dari menu Toast. 
Sedangkan pada kontrol Time Picker, ketika pengguna 
menentukan nilai waktu, maka secara otomatis akan 
ditampilkan Toast berisi informasi waktu yang sudah dipilih. 
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Selanjutnya ketika program dijalankan maka akan diperoleh 
tampilan seperti Gambar 4.13. 

  
Gambar 4.13 Tampilan Date Picker dan Time Picker 
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BAB 5 
MENU DAN DIALOG 

5. 1 KONSEP MENU 

Menu adalah daftar perintah-perintah suatu perangkat 
lunak (program) yang apabila dieksekusi akan menjalankan 
suatu perintah tertentu dari aplikasi. Menu digunakan sebagai 
alternatif dari antarmuka perintah baris. Pilihan yang diberikan 
oleh menu dapat dipilih dengan menggunakan kursor atau 
antarmuka pengguna. 

5. 2 MEMBUAT MENU 

Option Menu merupakan tampilan yang muncul ketika 
ditekan tombol menu pada device Android. Option Menu ini 
menampilkan menu yang sesuai dengan Activity yang sedang 
di tampilkan. Misalnya pada Activity Messenger, Option Menu 
yang mungkin ada yaitu menu setting, help, dan New 
Message. Pada praktikum kali ini kita akan membuat sebuah 
menu dengan struktur seperti Gambar 5.1. 

File

About

Exit

Data Mahasiswa

Input Data

Edit Data

Hapus Data

Cari Data

Tampil Data
 

Gambar 5.1 Struktur Item Menu  
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Berikut merupakan tahapan yang dapat dilakukan untuk 
mengimplementasikan menu dalam aplikasi Android. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama guiMenu, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml. 

3. Persiapkan item data sebagai struktur dari 
menu. Perlu diperhatikan bahwa dalam 
pembuatan menu terdapat 2 item sebagai induk 
(File, Data Mahasiswa) dan struktur item menu 
dengan mengubah file /res/menu/main.xml. 

4. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen menu option. 

5. Mengubah isi 
src/com.example.guimenu/MainActivity.java 

6. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : guiMenu 
Project Name : guiMenu 
Package Name : com.example.guimenu 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan pada beberapa komponen item menu 
yang ada di layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 
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    <string name="app_name">guiMenu</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="action_settings">Settings</string> 

    <string name="action_file">File</string> 

    <string name="action_about">About</string> 

    <string name="action_exit">Exit</string> 

    <string name="action_data">Data Mahasiswa</string> 

    <string name="action_input">Input Data</string> 

    <string name="action_edit">Edit Data</string> 

    <string name="action_hapus">Hapus Data</string> 

    <string name="action_cari">Cari Data</string> 

    <string name="action_tampil">Tampil Data</string> 

 

</resources> 

Langkah 3 Mendefinisikan Item Menu 

Langkah ini digunakan untuk menyediakan komponen item 
menu yang ada di layout xml pada Activity. 

/res/menu/main.xml 

<menu xmlns:android="http://schemas.android.com/apk/res/android" 

    xmlns:tools="http://schemas.android.com/tools" 

  tools:context="com.example.putriproject62.MainActivity"> 

    <item 

        android:id="@+id/action_settings" 

        android:orderInCategory="100" 

        android:showAsAction="never" 

        android:title="@string/action_settings"/> 

 <item 

     android:id="@+id/action_file" 

     android:orderInCategory="1" 

     android:enabled="true" 

     android:visible="true" 

     android:showAsAction="always" 

     android:title="@string/action_file"> 

     <menu> 

     <item 

     android:id="@+id/action_about" 

     android:orderInCategory="1"  

     android:showAsAction="never" 

     android:title="@string/action_about"/> 

     <item 

     android:id="@+id/action_exit" 

     android:orderInCategory="2"  

     android:showAsAction="never" 

     android:title="@string/action_exit"/> 

</menu> 

</item> 

   <item 

     android:id="@+id/action_data" 

     android:orderInCategory="2" 

     android:enabled="true" 



154 
 

     android:visible="true" 

     android:showAsAction="always" 

     android:title="@string/action_data"> 

     <menu> 

     <item 

     android:id="@+id/action_input" 

     android:orderInCategory="1"  

     android:showAsAction="never" 

     android:title="@string/action_input"/> 

     <item 

     android:id="@+id/action_edit" 

     android:orderInCategory="2"  

     android:showAsAction="never" 

     android:title="@string/action_edit"/> 

     <item 

     android:id="@+id/action_hapus" 

     android:orderInCategory="3"  

     android:showAsAction="never" 

     android:title="@string/action_hapus"/> 

     <item 

     android:id="@+id/action_cari" 

     android:orderInCategory="4"  

     android:showAsAction="never" 

     android:title="@string/action_cari"/> 

     <item 

     android:id="@+id/action_tampil" 

     android:orderInCategory="5"  

     android:showAsAction="never" 

     android:title="@string/action_tampil"/> 

     </menu> 

   </item>  

</menu> 

Langkah 4 Mendefinisikan Layout 

Layout yang digunakan dalam contoh aplikasi ini tidak 
dilakukan modifikasi, file  XML berisi kode program seperti 
berikut. 

/res/layout/activity_main.xml 

<RelativeLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

    xmlns:tools="http://schemas.android.com/tools" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    android:paddingBottom="@dimen/activity_vertical_margin" 

    android:paddingLeft="@dimen/activity_horizontal_margin" 

    android:paddingRight="@dimen/activity_horizontal_margin" 

    android:paddingTop="@dimen/activity_vertical_margin" 

    tools:context="com.example.guimenu.MainActivity" > 

 

    <TextView 

        android:layout_width="wrap_content" 
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        android:layout_height="wrap_content" 

        android:text="@string/hello_world" /> 

 

</RelativeLayout> 

Langkah 5 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.guipicker/MainActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.guipicker/MainActivity.java 

package com.example.guimenu; 

 

import android.app.Activity; 

import android.os.Bundle; 

import android.view.Menu; 

import android.view.MenuItem; 

import android.app.AlertDialog; 

import android.content.DialogInterface; 

import android.content.Context; 

import android.widget.Toast; 

 

 

public class MainActivity extends Activity { 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

    } 

 

    @Override 

    public boolean onCreateOptionsMenu(Menu menu) { 

        // Inflate the menu; this adds items to the action bar if 

it is present. 

        getMenuInflater().inflate(R.menu.main, menu); 

        return true; 

    } 

 

    @Override 

    public boolean onOptionsItemSelected(MenuItem item) { 

        // Handle action bar item clicks here. The action bar 

will 

        // automatically handle clicks on the Home/Up button, so 

long 

        // as you specify a parent activity in 

AndroidManifest.xml. 

        int id = item.getItemId(); 

        if (id == R.id.action_about) { 

         Context kondisi = getApplicationContext(); 

         CharSequence pesan ="Menu About Dipilih"; 
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         int durasi = Toast.LENGTH_LONG; 

         Toast dialog = Toast.makeText(kondisi, pesan, durasi); 

         dialog.show(); 

            return true;     

        } 

        else if (id == R.id.action_input){ 

         Context kondisi = getApplicationContext(); 

         CharSequence pesan ="Menu Input Dipilih"; 

         int durasi = Toast.LENGTH_LONG; 

         Toast dialog = Toast.makeText(kondisi, pesan, durasi); 

         dialog.show(); 

            return true;     

        } 

        else if (id == R.id.action_exit){ 

         AlertDialog.Builder builder = new 

AlertDialog.Builder(this); 

         builder.setMessage("Mau Keluar Aplikasi?") 

         .setCancelable(false) 

 

         .setPositiveButton("Yes",new 

DialogInterface.OnClickListener() { 

          public void onClick(DialogInterface dialog, int 

id){ 

           finish(); 

          } 

         }) 

         .setNegativeButton("No",new 

DialogInterface.OnClickListener() { 

          public void onClick(DialogInterface dialog, int 

id){ 

           dialog.cancel(); 

          } 

         }).show(); 

         return true; 

         } 

        return super.onOptionsItemSelected(item); 

    } 

} 

Langkah 6 Menjalankan Aplikasi 

Skenario yang dihasilkan dari aplikasi Android adalah 
pengguna dapat memilih option Menu yang ada pada bagian 
atas kanan. Pada 2 item menu, yaitu About dan Input akan 
menampilkan pesan Toast bahwa menu tersebut dipilih. 
Sedangkan ketika pengguna mengklik menu Exit, maka aka 
nada Dialog untuk memilih apakah akan Keluar atau tidak. 
Selanjutnya ketika program dijalankan maka akan diperoleh 
tampilan seperti Gambar 5.2. 
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Gambar 5.2 Tampilan Item Menu 
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BAB 6 
ACTIVITY DAN INTENT 

6.1 HUBUNGAN ACTIVITY DAN INTENT 

Dalam pengembangan aplikasi Android, seringkali 
dijumpai penggunaan activity lebih dari satu. Karena 
pertukaran data antar activity menjadi bagian dari aplikasi 
yang kompleks. Activity adalah komponen terkecil penyusun 
aplikasi Android yang berisi satu kegiatan yang dapat 
dilakukan oleh pengguna. 

Untuk menghubungkan antar activity dapat digunakan 
intent.  Intent adalah fasilitas untuk menghubungkan satu 
activity ke activity yang lain, baik untuk activity di dalam 
aplikasi yang sama maupun antar aplikasi yang berbeda.  
Intent juga digunakan untuk notifikasi event misalnya saat SD 
card dimasukkan, SMS masuk dan lain-lain. 

6.2 MENJALANKAN ACTIVITY LAIN MENGGUNAKAN INTENT 

Intent dapat digunakan untuk memanggil sebuah activity, 
misalnya pada saat sebuah tombol ditekan, maka sebuah 
activity akan tampil. Perhatikan scenario pada Gambar 6.1. 

PROGRAM INTENT

<LinearLayout> Orientation:vertical

Tampilkan Activity 2

INI MERUPAKAN ACTIVITY 2

<LinearLayout> Orientation:vertical

MainActivity.java TurunanActivity.java

 

Gambar 6.1 Bagan Pemanggilan Activity Menggunakan Intent 
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Berikut merupakan tahapan dalam mengimplementasikan 
pemanggilan Activity lain menggunakan sebuah Intent.  

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama Intent1, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml dengan menambahkan 
3 baris kode dengan nama stv_judul dan 
sbtn_panggil serta stv_activity2. 

3. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen menu option. 

4. Menambahkan Acivity Turunan, sebagai 
activity yang akan dipanggil menggunakan 
Intent. 

5. Menambahkan Resource Layout untuk Activity 
Turunan yang yang telah dibuat pada langkah 4. 

6. Ubah isi dari /res/layout/activity_turunan.xml 
untuk menambahkan komponen yang 
diperlukan. 

7. Mengubah isi 
src/com.example.intent1/MainActivity.java 

8. Mengubah isi 
src/com.example.intent1/TurunanActivity.java 

9. Memodifikasi file AndroidManifest.xml supaya 
file Activity yang baru dikenali oleh Android. 

10. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : Intent1 
Project Name : Intent1 
Package Name : com.example.intent2 
Min. Required SDK : API 14 
Target SDK : API 16 
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Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks yang 
nantinya digunakan layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

 

    <string name="app_name">PutriProject50</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="action_settings">Settings</string> 

    <string name="stv_judul">PROGRAM INTENT</string> 

    <string name="sbtn_panggil">Tampilkan Activity 2</string> 

    <string name="stv_activity2">INI MERUPAKAN ACTIVITY 

2</string> 

     

 

</resources> 

Langkah 3 Mendefinisikan Layout 

Layout yang digunakan adalah file  XML berisi kode 
program seperti berikut. Perhatikan pada bagian penting 
adalah property android:onClick, yang akan menampung 
nama method dan dieksekusi pada saat diklik oleh pengguna. 

/res/layout/activity_main.xml 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android

" 

    android:layout_width="fill_parent" 

    android:layout_height="fill_parent" 

    android:padding="10dp" 

    android:orientation="vertical" > 

     

    <TextView  

        android:id="@+id/textView1" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:gravity="center_horizontal" 

        android:text="@string/stv_judul" 

        /> 

    <Button 

        android:id="@+id/button1" 
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        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:onClick="tampilkan" 

        android:text="@string/sbtn_panggil" /> 

</LinearLayout> 

Perhatikan hasil dari modifikasi layout yang diberikan, 
akan terdapat desain seperti Gambar 6.2. 

 

Gambar 6.2 Desain Layout Main Activity 

Langkah 4 Mendefinisikan Activity Turunan 

Langkah ini digunakan untuk menambahkan Activity baru 
sebagai activity yang akan dipanggil melalui intent. Langkah 
yang perlu dilakukan adalah dari folder src→klik kanak→pilih 
New→pilih Class, seperti diperlihatkan pada Gambar 6.3. 

 

Gambar 6.3 Penambahan Class Baru dalam Project 



162 
 

Beri nama class dengan TurunanActivity, kemudian pada 
bagian superclass pilih android.app.Activity, setelah itu klik 
tombol Finish. Perhatikan Gambar 6.4 informasi yang harus 
diisi pada proses pembuatan Class. 

 

Gambar 6.4 Pembuatan Activity Baru 

Langkah 5 Menambahkan Resource File Sebagai Layout 
Untuk Activity Turunan 

Langkah ini digunakan untuk menambahkan Resource 
sebagai Layout bagi TurunanActivity, sebagai activity yang 
akan dipanggil melalui intent. Selajutnya perlu ditambahkan 
layout untuk acitivity yang baru, klik kanan nama project→pilih 
New→pilih Android XML File, seperti diperlihatkan pada 
Gambar 6.5. 
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Gambar 6.5 Penambahan Resource Layout XML 

Selanjutnya pada menu penambahan Resource, 
masukkan nama file activity_turunan.xml, dan pilih linear 
layout sebagai jenis layout yang akan ditambahkan dalam file 
seperti diperlihatkan pada Gambar 6.6. klik tombol Finish 
setelah proses penambahan selesai dilaksanakan. 

 

Gambar 6.6 Pemberian Nama Layout XML 
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Langkah 6 Mengubah Layout activity_turunan.xml 

Layout activity_turunan.xml perlu diubah, supaya 
skenario pemanggilan Activity dapat dilanjutkan. 

/res/layout/activity_turunan.xml 

<?xml version="1.0" encoding="utf-8"?> 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android

" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    android:padding="10dp" 

    android:orientation="vertical" > 

     

    <TextView 

        android:id="@+id/textView1" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:gravity="center_horizontal" 

        android:text="@string/stv_activity2" /> 

</LinearLayout> 

Layout dari activity_turunan.xml sekarang tampak seperti 
pada Gambar 6.7. 

 

Gambar 6.6 Desain Layout Turunan Activity 

Langkah 7 Menambahkan Kode Program Pada 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.intent1/MainActivity.java dengan 
menambahkan kode program berikut. 
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/src/com.example.intent1/MainActivity.java 

package com.example.intent1; 

 

import android.app.Activity; 

import android.content.Intent; 

import android.os.Bundle; 

import android.view.View; 

 

 

public class MainActivity extends Activity { 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

    } 

 

    public void tampilkan(View v) { 

     Intent halaman2 = new Intent(this,TurunanActivity.class); 

     startActivity(halaman2); 

    } 

} 

Langkah 8 Menambahkan Kode Program Pada 
TurunanActivity.java 

Tahap selanjutnya pada file 
/src/com.example.intent1/TurunanActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.intent1/TurunanActivity.java 

package com.example.intent1; 

 

import android.app.Activity; 

import android.os.Bundle; 

 

public class TurunanActivity extends Activity{ 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_turunan); 

    } 

} 

Langkah 9 Mengubah Kode Program Pada 
AndroidManifest.xml 

Supaya activity yang baru saja ditambahkan dikenali oleh 
sistem, maka perlu menambahkan segment activity ke dalam 



166 
 

AndroidManifest.xml. Perhatikan segmen program pada 
activity yang mengacu pada .TurunanActivity. Jika tahapan 
ini tidak dijalankan, maka akan menghasilkan error pada saat 
program dijalankan. 

<activity> 
…  
</activity > 

/AndroidManifest.xml 

<?xml version="1.0" encoding="utf-8"?> 

<manifest 

xmlns:android="http://schemas.android.com/apk/res/android" 

    package="com.example.intent1" 

    android:versionCode="1" 

    android:versionName="1.0" > 

 

    <uses-sdk 

        android:minSdkVersion="14" 

        android:targetSdkVersion="16" /> 

 

    <application 

        android:allowBackup="true" 

        android:icon="@drawable/ic_launcher" 

        android:label="@string/app_name" 

        android:theme="@style/AppTheme" > 

        <activity 

            android:name=".MainActivity" 

            android:label="@string/app_name" > 

            <intent-filter> 

                <action android:name="android.intent.action.MAIN" 

/> 

 

                <category 

android:name="android.intent.category.LAUNCHER" /> 

            </intent-filter> 

        </activity> 

        <activity  

            android:name=".TurunanActivity" 

            android:label="Activity Ke-2"> 

        </activity> 

    </application> 

 

</manifest> 

Langkah 10 Menjalankan Aplikasi 

Skenario yang dihasilkan dari aplikasi Android adalah 
pengguna menekan tombol pada MainActivity, kemudian 
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akan ditampilkan TurunanActivity. Selanjutnya ketika program 
dijalankan maka akan diperoleh tampilan seperti Gambar 6.7. 

  

Gambar 6.7 Hasil Menjalankan Intent 

6.3 MENGIRIMKAN DATA ANTAR ACTIVITY 

Jika pada program sebelumnya, Intent hanya digunakan 
untuk memanggil Activity lain, maka dalam sub bab ini akan 
dipaparkan bagaimana mengirimkan data antar satu activity 
ke activity yang lain.  

Selanjutnya kita akan memodifikasi supaya program 
sebelumnya dapat mengirimkan data dari activity utama ke 
activity ke-2, dengan tahapan sebagai berikut. 

Langkah Keterangan 

1. Mengubah isi 
src/com.example.intent1/MainActivity.java 

2. Mengubah isi 
src/com.example.intent1/TurunanActivity.java 

3. Menjalankan Aplikasi 
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Langkah 1 Menambahkan Kode Program Pada 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.intent1/MainActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.intent1/MainActivity.java 

package com.example.intent1; 

 

import android.app.Activity; 

import android.content.Intent; 

import android.os.Bundle; 

import android.view.View; 

 

 

public class MainActivity extends Activity { 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

    } 

 

    public void tampilkan(View v) { 

     Intent halaman2 = new Intent(this,TurunanActivity.class); 

     halaman2.putExtra("data1", "Ini merupakan data yang 

dikirimkan dari activity utama"); 

     startActivity(halaman2); 

    } 

} 

Langkah 2 Menambahkan Kode Program Pada 
TurunanActivity.java 

Tahap selanjutnya pada file 
/src/com.example.intent1/TurunanActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.intent1/TurunanActivity.java 

package com.example.intent1; 

 

import android.app.Activity; 

import android.content.Intent; 

import android.os.Bundle; 

import android.widget.TextView; 

 

public class TurunanActivity extends Activity{ 

 @Override 

    protected void onCreate(Bundle savedInstanceState) { 



 

169 
 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_turunan); 

    } 

 public void onStart(){ 

  super.onStart(); 

  Intent inTurunan = getIntent(); 

  String pesan = 

inTurunan.getStringExtra("data1"); 

  TextView textView1 = (TextView) 

findViewById(R.id.textView1); 

  textView1.setText(pesan); 

 } 

} 

 

Langkah 3 Menjalankan Aplikasi 

Skenario yang dihasilkan dari aplikasi Android adalah 
pengguna menekan tombol pada MainActivity, kemudian 
akan ditampilkan TurunanActivity. Tampak pada hasil 
menjalankan aplikasi bahwa data yang dikirimkan berupa 
variable data1, dapat ditampilkan hasilnya pada Activity yang 
ke-2. Selanjutnya ketika program dijalankan maka akan 
diperoleh tampilan seperti Gambar 6.8. 

  
Gambar 6.8 Hasil Menjalankan Modifikasi Intent 
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6.4 PERTUKARAN DATA ANTAR ACTIVITY 

Untuk mengirimkan dan menerima data dari activity, dapat 
digunakan  method startActivityForResult.Sebagai contoh, 
kita akan membuat activity yang memanggil activity lain, 
pengguna mengisi data pada activity tersebut dan 
mengirimkannya kembali ke activity utama. 

Berikut langkah-langkah yang dapat dilakukan untuk 
berkirim data antar Activiry. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama Intent2, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Mendefinisikan string untuk judul setiap 
komponen yang terdapat pada 
/res/values/strings.xml. 

3. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan komponen menu option. 

4. Menambahkan Acivity Kedua, sebagai activity 
yang akan dipanggil menggunakan Intent. 

5. Menambahkan Resource Layout untuk Activity 
Turunan yang yang telah dibuat pada langkah 
4. 

6. Ubah isi dari /res/layout/activity_kedua.xml 
untuk menambahkan komponen yang 
diperlukan. 

7. Mengubah isi 
src/com.example.intent2/MainActivity.java 

8. Mengubah isi 
src/com.example.intent2/KeduaActivity.java 

9. Memodifikasi file AndroidManifest.xml supaya 
file Activity yang baru dikenali oleh Android. 

10. Menjalankan Aplikasi 
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Langkah 1 Membuat Project 

Application Name : Intent2 
Project Name : Intent2 
Package Name : com.example.intent2 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Nilai String 

Langkah ini digunakan untuk menyediakan judul teks 
yang nantinya digunakan layout xml pada Activity. 

/res/values/strings.xml 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

 

    <string name="app_name">intent2</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="action_settings">Settings</string> 

    <string name="stv1_caption">Masukkan Nama Anda</string> 

    <string name="stv2_caption">Nama Anda (Edit Activity 

2)</string> 

    <string name="sbtn1_caption">Kirim ke Activity 2</string> 

    <string name="sbtn2_caption">Kirim ke Activity Utama</string> 

 

</resources> 

Langkah 3 Mendefinisikan Layout 

Layout yang digunakan adalah file XML berisi kode 
program seperti berikut. Perhatikan pada bagian penting 
adalah property android:onClick diisi dengan kirim1, yang 
akan menampung nama method dan dieksekusi pada saat 
diklik oleh pengguna. 

/res/layout/activity_main.xml 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

    android:layout_width="fill_parent" 

    android:layout_height="fill_parent" 

    android:padding="15dp" 

    android:orientation="vertical" > 

     

    <TextView 
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        android:id="@+id/textView1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/stv1_caption" /> 

    <EditText  

        android:id="@+id/editText1" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:ems="10" 

        android:inputType="textPersonName" > 

        <requestFocus /> 

        </EditText> 

         

    <Button  

        android:id="@+id/button1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:onClick="kirim1" 

        android:text="@string/sbtn1_caption" /> 

         

</LinearLayout> 

Perhatikan hasil dari modifikasi layout yang diberikan, 
akan terdapat desain seperti Gambar 6.9. 

 

Gambar 6.9 Desain Layout Main Activity 

Langkah 4 Mendefinisikan Activity Kedua 

Langkah ini digunakan untuk menambahkan Activity baru 
sebagai activity yang akan dikirim data melalui intent. 
Langkah yang perlu dilakukan adalah dari folder src→klik 
kanak→pilih New→pilih Class, beri nama class dengan 
KeduaActivity, kemudian pada bagian superclass pilih 
android.app.Activity, setelah itu klik tombol Finish. 
Perhatikan Gambar 6.10 informasi yang harus diisi pada 
proses pembuatan Class. 
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Gambar 6.10 Pembuatan Activity Kedua 

Langkah 5 Menambahkan Resource File Sebagai Layout 
Untuk Activity Kedua 

Langkah ini digunakan untuk menambahkan Resource 
sebagai Layout bagi KeduaActivity, sebagai activity yang 
akan dikirim data melalui intent. Selajutnya perlu ditambahkan 
layout untuk acitivity yang baru, klik kanan nama project→pilih 
New→pilih Android XML File. 

Selanjutnya pada menu penambahan Resource, 
masukkan nama file activity_kedua.xml, dan pilih linear layout 
sebagai jenis layout yang akan ditambahkan dalam file seperti 
diperlihatkan pada Gambar 6.11. klik tombol Finish setelah 
proses penambahan selesai dilaksanakan. 
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Gambar 6.11 Pemberian Nama Layout XML 

Langkah 6 Mengubah Layout activity_kedua.xml 

Layout activity_kedua.xml perlu diubah, supaya skenario 
pengiriman data antar Activity dapat dilakukan. 

/res/layout/activity_kedua.xml 

<?xml version="1.0" encoding="utf-8"?> 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

    android:layout_width="match_parent" 

    android:layout_height="match_parent" 

    android:padding="15dp" 

    android:orientation="vertical" > 

     

    <TextView 

        android:id="@+id/textView1" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="@string/stv2_caption" 

        /> 

    <EditText  

        android:id="@+id/editText1" 

        android:layout_width="match_parent" 
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        android:layout_height="wrap_content" 

        android:ems="10" 

        android:inputType="textPersonName" > 

        <requestFocus /> 

        </EditText> 

     <Button  

         android:id="@+id/button1" 

         android:layout_width="wrap_content" 

         android:layout_height="wrap_content" 

         android:onClick="kirim2" 

         android:text="@string/sbtn2_caption" 

         />   

 

</LinearLayout> 

Layout dari activity_kedua.xml sekarang tampak seperti 
pada Gambar 6.12. 

 

Gambar 6.12 Desain Layout Kedua Activity 

Langkah 7 Menambahkan Kode Program Pada 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.intent2/MainActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.intent2/MainActivity.java 

package com.example.intent2; 

 

import android.app.Activity; 

import android.content.Intent; 

import android.os.Bundle; 

import android.view.View; 

import android.widget.EditText; 
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public class MainActivity extends Activity { 

 private EditText editText1; 

 

    @Override 

    protected void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.activity_main); 

        editText1 = (EditText)findViewById(R.id.editText1); 

    } 

    public void kirim1 (View v) { 

     Intent halaman2 = new Intent(this, KeduaActivity.class); 

     String pesan = editText1.getText().toString(); 

     halaman2.putExtra("data1", pesan); 

     startActivityForResult(halaman2,1); 

    } 

    public void onActivityResult(int requestCode,int resultCode, 

Intent data){ 

     if ((requestCode==1) && (resultCode==RESULT_OK)) { 

      String pesan = data.getStringExtra("data2"); 

      editText1.setText(pesan); 

     } 

    } 

} 

Langkah 8 Menambahkan Kode Program Pada 
KeduaActivity.java 

Tahap selanjutnya pada file 
/src/com.example.intent2/KeduaActivity.java dengan 
menambahkan kode program berikut. 

/src/com.example.intent2/KeduaActivity.java 

package com.example.intent2; 

 

import android.app.Activity; 

import android.content.Intent; 

import android.os.Bundle; 

import android.view.View; 

import android.widget.EditText; 

 

 

public class KeduaActivity extends Activity { 

private EditText editText1; 

 @Override 

 protected void onCreate(Bundle saveInstanceState) { 

  super.onCreate(saveInstanceState); 

  setContentView(R.layout.activity_kedua); 

  editText1 = 

(EditText)findViewById(R.id.editText1); 

 } 

 public void onStart() { 

 super.onStart(); 
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 Intent dataku = getIntent(); 

 String pesan = dataku.getStringExtra("data1"); 

 editText1.setText(pesan); 

 } 

 public void kirim2(View v){ 

  Intent halaman1 = getIntent(); 

  String pesan = editText1.getText().toString(); 

  halaman1.putExtra("data2", pesan); 

  setResult (RESULT_OK,halaman1); 

  finish(); 

 } 

 

} 

 

Langkah 9 Mengubah Kode Program Pada 
AndroidManifest.xml 

Supaya activity yang baru saja ditambahkan dikenali oleh 
sistem, maka perlu menambahkan segment activity ke dalam 
AndroidManifest.xml. Perhatikan segmen program pada 
activity yang mengacu pada .TurunanActivity. Jika tahapan 
ini tidak dijalankan, maka akan menghasilkan error pada saat 
program dijalankan. 

<activity> 
…  
</activity > 

/AndroidManifest.xml 

<?xml version="1.0" encoding="utf-8"?> 

<manifest 

xmlns:android="http://schemas.android.com/apk/res/android" 

    package="com.example.intent2" 

    android:versionCode="1" 

    android:versionName="1.0" > 

 

    <uses-sdk 

        android:minSdkVersion="14" 

        android:targetSdkVersion="16" /> 

 

    <application 

        android:allowBackup="true" 

        android:icon="@drawable/ic_launcher" 

        android:label="@string/app_name" 

        android:theme="@style/AppTheme" > 

        <activity 

            android:name=".MainActivity" 

            android:label="@string/app_name" > 

            <intent-filter> 
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                <action android:name="android.intent.action.MAIN" 

/> 

 

                <category 

android:name="android.intent.category.LAUNCHER" /> 

            </intent-filter> 

        </activity> 

        <activity 

            android:name=".KeduaActivity" 

            android:label="@string/app_name"> 

        </activity> 

    </application> 

 

</manifest> 

Langkah 10 Menjalankan Aplikasi 

Skenario yang dihasilkan dari aplikasi Android adalah 
pengguna mengisi data pada teks isian, kemudian menekan 
tombol pada MainActivity, kemudian akan ditampilkan 
datanya pada KeduaActivity. Selanjutnya pada KeduaActivity 
data tersebut dapat diubah, dan dikirim kembali ke 
MainActivity. Selanjutnya ketika program dijalankan maka 
akan diperoleh tampilan seperti Gambar 6.13. 

  

 

Gambar 6.13 Hasil Berkirim Data Antar Intent 
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BAB 7 
MEMPROSES DATA ARRAY 

7.1 KONSEP DATA ARRAY 

Array adalah sebuah variabel yang dapat menyimpan 
banyak data dalam satu variabel. Array menggunakan indeks 
untuk memudahkan akses terhadap data yang disimpannya. 

ArrayAdapter adalah ListAdapter yang mengelola data 
dari objek array. ArrayAdapter terdapat dalam class 
android.widget.Adapter.  

7.2 MENGIMPLEMENTASIKAN DATA ARRAY 

Berikut merupakan langkah-langkah yang dapat diikuti 
untuk mengimplementasikan data array di Android. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama dataArray, minimal required SDK 
API 14, target dan compile with menggunakan 
API 16. 

2. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan beberapa komponen yang 
diperlukan. 

3. Menambahkan class baru untuk identitas dari 
data array yang diproses. 

4. Mengubah isi 
src/com.example.dataarray/MainActivity.java 

5. Menjalankan Aplikasi 

Langkah 1 Membuat Project 

Application Name : dataArray 
Project Name : dataArray 
Package Name : com.example.dataarray 
Min. Required SDK : API 14 
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Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Layout 

Langkah ini digunakan untuk mendefinisikan beberapa 
komponen yang ada di layout xml pada Activity. 

/res/layout/activity_main.xml 

<?xml version="1.0" encoding="utf-8"?> 

<RelativeLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

 

 android:layout_width="wrap_content" 

 android:layout_height="wrap_content"> 

 

 <TableLayout android:id="@+id/details" 

  android:layout_width="fill_parent" 

  android:layout_height="wrap_content" 

  android:layout_alignParentBottom="true" 

  android:stretchColumns="1"> 

  

 <TableRow> 

  <TextView android:text="Nama :" /> 

  <EditText android:id="@+id/nama" /> 

 </TableRow> 

 

 <TableRow> 

  <TextView android:text="Jenis Kelamin:" /> 

  <RadioGroup android:id="@+id/jekel"> 

  <RadioButton  

      android:id="@+id/pria" 

   android:text="Pria"/> 

  <RadioButton  

      android:id="@+id/perempuan" 

   android:layout_width="wrap_content" 

   android:text="Perempuan"/> 

  </RadioGroup> 

  </TableRow> 

 

 <TableRow> 

  <TextView android:text="Alamat:" /> 

  <EditText android:id="@+id/alamat" /> 

 </TableRow> 

 <Button  

     android:id="@+id/save" 

  android:layout_width="fill_parent" 

  android:layout_height="wrap_content" 

  android:text="Save"/> 

 </TableLayout> 

 

<ListView  

    android:id="@+id/identitas" 
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 android:layout_width="fill_parent" 

 android:layout_height="wrap_content" 

 android:layout_alignParentTop="true" 

 android:layout_above="@id/details"/> 

 

</RelativeLayout> 

Langkah 3 Menambahkan Class 

Selanjutnya klik kanan nama package>pilih New>pilih 
Class. Perhatikan pada kolom isian Name, berilah nama 
identitas. Setelah itu klik tombol Finish. Perhatikan Gambar 
7.1. 

 

Gambar 7.1 Penambahan Class Identitas 

Kemudian ubah isi file identitas.java menjadi seperti 
berikut. 

/src/com.example.dataarray/identitas.java 

package com.example.dataarray; 

 

public class identitas { 
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 private String nama=""; 

 private String alamat=""; 

 private String jekel=""; 

  

 public String getNama() { 

  return(nama); 

 } 

  

 public void setNama(String nama) { 

  this.nama=nama; 

 } 

  

 public String getAlamat() { 

  return(alamat); 

 } 

  

 public void setAlamat(String alamat) { 

  this.alamat=alamat; 

 } 

  

 public String getJekel() { 

  return(jekel); 

 } 

  

 public void setJekel(String jekel) { 

  this.jekel=jekel; 

 } 

  

 public String toString() { 

  return(getNama()); 

 } 

} 

Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.dataarray/MainActivity.java dengan 
menambahkan beberapa data array sebagai bagian dari 
daftar isian yang dapat dipilih oleh user. Perhatikan kode 
program berikut. 

/src/com.example.dataarray/MainActivity.java 

package com.example.dataarray; 

 

import android.app.Activity; 

import android.os.Bundle; 

import android.view.View; 

import android.widget.ArrayAdapter; 

import android.widget.Button; 

import android.widget.EditText; 
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import android.widget.ListView; 

import android.widget.RadioGroup; 

import java.util.ArrayList; 

import java.util.List; 

 

public class MainActivity extends Activity { 

 List<identitas> model=new ArrayList<identitas>(); 

 ArrayAdapter<identitas> adapter=null; 

  

 @Override 

 public void onCreate(Bundle savedInstanceState) { 

  super.onCreate(savedInstanceState); 

  setContentView(R.layout.activity_main); 

  Button save=(Button)findViewById(R.id.save); 

  save.setOnClickListener(onSave); 

  ListView 

list=(ListView)findViewById(R.id.identitas); 

  adapter=new ArrayAdapter<identitas>(this, 

   

 android.R.layout.simple_list_item_1, model); 

  list.setAdapter(adapter); 

 } 

 

 private View.OnClickListener onSave=new 

View.OnClickListener() { 

  public void onClick(View v) { 

   identitas r=new identitas(); 

   EditText 

nama=(EditText)findViewById(R.id.nama); 

   EditText 

alamat=(EditText)findViewById(R.id.alamat); 

   r.setNama(nama.getText().toString()); 

  

 r.setAlamat(alamat.getText().toString()); 

   RadioGroup 

jekel=(RadioGroup)findViewById(R.id.jekel); 

   switch 

(jekel.getCheckedRadioButtonId()) { 

   case R.id.pria: 

    r.setJekel("pria"); 

    break; 

   case R.id.perempuan: 

    r.setJekel("perempuan"); 

    break; 

   } 

   adapter.add(r); 

  } 

 }; 

  

  

} 
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Langkah 5 Menjalankan Aplikasi 

Selanjutnya ketika program dijalankan maka akan 
diperoleh tampilan seperti Gambar 7.2. Pengguna cukup 
memasukkan serangkaian data, kemudian akan disimpan 
dalam array. Selanjutnya data array akan ditampilkan 
menggunakan sebuah List. 

 

Gambar 7.2 Tampilan Implementasi Data Array 
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BAB 8 
AKSES DATA MYSQL 

8.1 MEMBUAT DATABASE MYSQL 

Pada sub bab ini akan dikupas bagaimana aplikasi 
Android dapat mengakses database MySQL. Langkah 
pertama yang harus dilakukan adalah memastikan bahwa 
Web Server dan Database server sudah terinstal di komputer. 

Kemudian disiapkan database yang nantinya dapat 
diakses oleh aplikasi Android. 

1. Sebelum menggunakan MySQL terlebih dahulu di dalam 
sistem operasi telah diinstall bundel AppServ ataupun 
Xampp. Kemudian buka browser dan masuk ke alamat 
http://localhost/phpmyadmin kemudian login dengan user 
id dan password yang telah disetting pada saat instalasi. 
Perhatikan Gambar 8.1. 

 

Gambar 8.1 Login Ke MySQL 

2. Setelah login berhasil, maka akan ditampilkan window 
halaman utama phpmyadmin, pada kolom isian Create 
new database isi dengan dbpolsri, setelah itu klik tombol 
Create. Seperti diperlihatkan pada Gambar 8.2. 

http://localhost/phpmyadmin
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Gambar 8.2 Proses Pembuatan Database 

3. Setelah proses pembuatan database berhasil dilakukan, 
maka proses berikutnya buat tabel dengan nama 
tbmahasiswa dengan perintah SQL, kemudian klik tombol 
Go. Perhatikan Gambar 8.3. 

 

Gambar 8.3 Proses Pembuatan Tabel 

4. Jika proses pembuatan tabel berhasil, maka akan 
ditampilkan window proses pembuatan tabel berhasil dan 
ditampilkan tabel yang dibuat di bagian bawah. Perhatikan 
Gambar 8.4 

 

Gambar 8.4 Eksekusi Pembuatan Tabel 
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5. Kemudian masukkan perintah untuk input data mahasiswa 
seperti gambar berikut. Setelah dimasukkan perintah SQL 
klik tombol Go. Perhatikan Gambar 8.5. 

 

Gambar 8.5 Memasukkan Data Tabel Tabel 

6. Aktifkan data dengan memilih Browse pada bagian atas 
menu, maka seluruh data yang telah dimasukkan akan 
ditampilkan. Perhatikan Gambar 8.6. 

 

Gambar 8.6 Browse Data Tabel 

8.2 MENYIAPAKAN SCRIPT PHP 

Untuk dapat berhubungan dengan MySQL, maka 
diperlukan script PHP dan disimpan di lokasi yang dikenali 
oleh web server. 
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1. Buat folder dbpolsri di alamat C:\AppServ\www\dbpolsri 
atau (sesuaikan dengan konfigurasi web server). 
Kemudian dari browser ketikkan alamat 
http://localhost/dbpolsri sehingga diperoleh tampilan 
seperti Gambar 8.7. 

 

Gambar 8.7 Tampilan Halaman Localhost 

2. Setelah tabel dan data sudah selesai,langsung saja kita 
membuat koneksi yang berfungsi untuk menghubungkan 
ke database, koneksi disini saya menggunakan bahasa 
pemrograman php dan contohnya seperti dibawah ini. 
Simpan file dengan nama connection.php tempatkan di 
alamat C:/Appserv/www/dbpolsri dan sesuaikan 
password (teks xxx) dengan konfigurasi sistem yang telah 
dilakukan. 

 

3. Kemudian dengan cara yang sama, buat file simpan.php 
dan tempatkan pada lokasi yang sama dengan file 
connection.php. 

 

http://localhost/dbpolsri
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4. Sekarang sudah terdapat 2 buah file di dalam web server. 

 

Gambar 8.8 Tampilan Halaman Web 

5. Sampai tahap ini persiapan untuk database server sudah 
selesai. Selanjutnya dilakukan proses untuk pembuatan 
aplikasi Android. 

8.3 MEMBUAT PROJECT ANDROID  

Berikut merupakan tahapan yang berisi langkah-langkah 
pembuatan aplikasi Android yang dapat digunakan untuk 
mengakses database MySQL. 

Langkah Keterangan 

1. Buat sebuah project menggunakan Eclipse IDE 
dengan nama aksesMysql, minimal required 
SDK API 14, target dan compile with 
menggunakan API 16. 

2. Ubah isi dari res/layout/activity_main.xml 
untuk menambahkan beberapa komponen yang 
diperlukan. 

3. Menambahkan class baru untuk identitas dari 
data array yang diproses. 

4. Mengubah isi src/com.example.aksesmysql/ 
MainActivity.java 

5. Menjalankan Aplikasi 
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Langkah 1 Membuat Project 

Application Name : aksesmysql 
Project Name : aksesmysql 
Package Name : com.example.aksesmysql 
Min. Required SDK : API 14 
Target SDK : API 16 
Compile With : API 16 

Langkah 2 Mendefinisikan Layout 

Langkah ini digunakan untuk mendefinisikan beberapa 
komponen yang ada di layout xml pada Activity. 

/res/layout/activity_main.xml 

<LinearLayout 

xmlns:android="http://schemas.android.com/apk/res/android" 

    android:layout_width="fill_parent" 

    android:layout_height="fill_parent" 

    android:padding="10dp" 

    android:orientation="vertical" > 

 

    <TextView 

        android:id="@+id/textView1" 

        android:layout_width="wrap_content" 

        android:layout_height="35dp" 

        android:layout_gravity="center_horizontal" 

        android:text="FORM INPUT MAHASISWA" /> 

 

    <TextView 

        android:id="@+id/textView2" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="Masukkan NIM" /> 

 

    <EditText 

        android:id="@+id/editText1" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:ems="10" > 

 

        <requestFocus /> 

 

    </EditText> 

 

    <TextView 

        android:id="@+id/textView3" 

        android:layout_width="wrap_content" 

        android:layout_height="wrap_content" 

        android:text="Masukkan Nama Mahasiswa" /> 
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    <EditText 

        android:id="@+id/editText2" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:ems="10"  

        android:inputType="textPersonName" /> 

 

    <Button 

        android:id="@+id/button1" 

        android:layout_width="match_parent" 

        android:layout_height="wrap_content" 

        android:text="Simpan" /> 

 

</LinearLayout> 

Langkah 3 Menambahkan Class 

Selanjutnya klik kanan nama package>pilih New>pilih 
Class. Perhatikan pada kolom isian Name, berilah nama 
CustomHttpClient. Setelah itu klik tombol Finish. Perhatikan 
Gambar 8.9. 

 

Gambar 8.9 Penambahan Class Identitas 



192 
 

Kemudian ubah isi file identitas.java menjadi seperti 
berikut. 

/src/com.example.aksesmysql/CustomHttpClient.java 

package com.example.aksesmysql; 

 

import java.io.BufferedReader; 

import java.io. IOException; 

import java.io. InputStreamReader; 

import java.net.URI; 

import java.util.ArrayList; 

 

import org.apache.http.HttpResponse; 

import org.apache. http. NameValuePair; 

import org.apache.http.client.HttpClient; 

import org.apache.http.client.entity.UrlEncodedFormEntity; 

import org.apache.http.client.methods.HttpGet; 

import org.apache.http.client.methods.HttpPost; 

import org.apache.http.conn.params.ConnManagerParams; 

import org.apache.http.impl.client.DefaultHttpClient; 

import org.apache.http.params.HttpConnectionParams; 

import org.apache.http.params.HttpParams; 

 

public class CustomHttpClient { 

  

 /** The time it takes for our client to timeout */ 

 public static final int HTTP_TIMEOUT = 30 * 1000; // 

milliseconds 

  

  /** Single instance of our HttpClient */ 

  private static HttpClient mHttpClient; 

   

  /** 

   * Get our single instance of our HttpClient 

object. 

   * 

   * @return an HttpClient object with connection 

parameters set 

   */ 

  private static HttpClient getHttpClient() { 

   if (mHttpClient == null) { 

    mHttpClient = new 

DefaultHttpClient(); 

    final HttpParams params = 

mHttpClient.getParams(); 

   

 HttpConnectionParams.setConnectionTimeout(params, 

HTTP_TIMEOUT); 

   

 HttpConnectionParams.setSoTimeout(params, HTTP_TIMEOUT); 

   

 ConnManagerParams.setTimeout(params, HTTP_TIMEOUT); 

   } 

   return mHttpClient; 

  } 
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 /** 

  * Performs an HTTP Post request to the specified url 

with the 

  * specified parameters. 

  * 

  * @param url The web address to post the request to 

  * @param postParameters The parameters to send via the 

request 

  * @return The result of the request 

  * @throws Exception 

  */ 

  public static String executeHttpPost(String url, 

ArrayList<NameValuePair> postParameters) 

    throws Exception { 

   BufferedReader in = null; 

   try { 

    HttpClient client = 

getHttpClient(); 

    HttpPost request = new 

HttpPost(url); 

    UrlEncodedFormEntity formEntity 

= new UrlEncodedFormEntity(postParameters); 

    request.setEntity(formEntity); 

    HttpResponse response = 

client.execute(request); 

    in = new BufferedReader(new 

InputStreamReader(response.getEntity().getContent())); 

    StringBuffer sb = new 

StringBuffer(""); 

    String line = ""; 

    String NL = 

System.getProperty("line.separator"); 

    while ((line = in.readLine()) 

!= null) { 

     sb.append(line + NL); 

    } 

    in.close(); 

    String result = sb.toString(); 

    return result; 

   } finally { 

    if (in != null) { 

     try { 

      in.close(); 

     } catch (IOException 

e) { 

     

 e.printStackTrace(); 

     } 

    } 

   } 

  } 

   

  /** 

   * Performs an HTTP GET request to the specified 

url. 
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   * 

   * @param url The web address to post the 

request to 

   * @return The result of the request 

   * @throws Exception 

   */ 

  public static String executeHttpGet(String url) 

throws Exception { 

   BufferedReader in = null; 

   try { 

    HttpClient client = 

getHttpClient(); 

    HttpGet request = new 

HttpGet(); 

    request.setURI(new URI(url)); 

    HttpResponse response = 

client.execute(request); 

    in = new BufferedReader(new 

InputStreamReader(response.getEntity().getContent())); 

    StringBuffer sb = new 

StringBuffer(""); 

    String line = ""; 

    String NL = 

System.getProperty("line.separator"); 

    while ((line = in.readLine()) 

!= null) { 

     sb.append(line + NL); 

    } 

    in.close(); 

    String result = sb.toString(); 

    return result; 

   } finally { 

    if (in != null) { 

     try { 

      in.close(); 

     } catch (IOException 

e) { 

     

 e.printStackTrace(); 

     } 

    } 

   } 

  } 

} 

Langkah 4 Menambahkan Kode Program 
MainActivity.java 

Tahap selanjutnya pada file 
/src/com.example.aksesmysql/MainActivity.java dengan 
menambahkan beberapa data array sebagai bagian dari 
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daftar isian yang dapat dipilih oleh user. Perhatikan kode 
program berikut. 

/src/com.example.aksesmysql/MainActivity.java 

package com.example.aksesmysql; 

 

import java.util.ArrayList; 

import org.apache.http.NameValuePair; 

import org.apache.http.message.BasicNameValuePair; 

import android.app.Activity; 

import android.os.Bundle; 

import android.os.StrictMode; 

import android.view.View; 

import android.widget.Button; 

import android.widget.EditText; 

import android.widget. Toast; 

import android.app. AlertDialog; 

 

 

 

public class MainActivity extends Activity { 

 

EditText nim, nama; 

Button btnsubmit; 

 

public void onCreate(Bundle savedInstanceState) { 

 super.onCreate(savedInstanceState); 

 setContentView(R.layout.activity_main); 

  

 nim=(EditText) findViewById(R.id.editText1); 

 nama=(EditText) findViewById(R.id.editText2); 

 btnsubmit=(Button) findViewById(R.id.button1); 

  

 btnsubmit.setOnClickListener(new View.OnClickListener() { 

 public void onClick(View v) { 

  //validasi input data 

  if(nim.getText().toString().equals("")){ 

   Toast.makeText(MainActivity.this, 

"Input NIM Masih Kosong", Toast.LENGTH_LONG).show(); 

  return; 

  } else if(nama.getText().toString().equals("")) 

{ 

   Toast.makeText(MainActivity.this, 

"Input Nama Masih Kosong", Toast.LENGTH_LONG).show(); 

   return;  

  } 

  //validasi 

   

  ArrayList<NameValuePair> postParameters = new 

ArrayList<NameValuePair>(); 

  postParameters.add(new BasicNameValuePair("nim", 

nim.getText().toString())); 

  postParameters.add(new 

BasicNameValuePair("nama", nama.getText().toString())); 
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  String response = null; 

  try { 

   StrictMode.ThreadPolicy policy = new 

StrictMode.ThreadPolicy.Builder().permitAll().build(); 

   StrictMode.setThreadPolicy(policy); 

   response = 

CustomHttpClient.executeHttpPost("http://10.0.2.2:80/dbpolsri/sim

pan.php", postParameters); 

    

    String res = 

response.toString(); 

    res = res.trim(); 

    res = res.replaceAll("\\s+", 

""); 

     

   

 Toast.makeText(MainActivity.this, res, 

Toast.LENGTH_LONG).show(); 

    if(res.equals("1")) { 

    

 //Toast.makeText(MainActivity.this, "Data tersimpan Ke 

Server",Toast.LENGTH_LONG).show(); 

     AlertDialog.Builder 

peringatan = new AlertDialog.Builder(MainActivity.this); 

    

 peringatan.setTitle("Proses Transaksi"); 

    

 peringatan.setMessage("Data Tersimpan"); 

    

 peringatan.setNeutralButton("OK", null); 

     peringatan.show(); 

     kosong(); 

    }else{ 

    

 //Toast.makeText(MainActivity.this, "Data tersimpan Ke 

Server",Toast.LENGTH_LONG).show(); 

     AlertDialog.Builder 

peringatan = new AlertDialog.Builder(MainActivity.this); 

    

 peringatan.setTitle("Proses Transaksi"); 

    

 peringatan.setMessage("Data Tersimpan Ke Server"); 

    

 peringatan.setNeutralButton("OK", null); 

     peringatan.show(); 

     kosong();} 

    } 

    catch (Exception e) { 

    

 Toast.makeText(MainActivity.this, e.toString(), 

Toast.LENGTH_LONG).show(); 

     

    } 

   } 

  }); 

} 
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//untuk mengosongkan teks isian 

 public void kosong(){ 

  nim.setText(""); 

  nama.setText(""); 

  nama.requestFocus(); 

  

 } 

} 

 

Langkah 5 Menjalankan Aplikasi 

Sebelum menjalankan program pastikan tambahkan satu 
baris perintah berikut pada AndroidManifest.xml. 
 
<uses-permission android:name="android.permission.INTERNET"/> 

 
Selanjutnya ketika program dijalankan maka akan 

diperoleh tampilan seperti Gambar 8.10, kondisi dimana 
belum ada proses penambahan data. Pengguna cukup 
memasukkan teks isian, kemudian dapat melihat item data 
yang dimasukkan ke database MySQL.  

Kemudian Gambar 8.11 menunjukkan bagaimana proses 
penyimpanan data ke MySQL telah berhasil dilakukan, dan 
ketika dicek pada database MySQL, maka data yang telah 
ditambahkan berhasil tersimpan ke database. 

  

 

Gambar 8.10 Tampilan Awal Akses MySQL 
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Gambar 8.11 Tampilan Setelah Penambahan Data 

  



 

199 
 

DAFTAR PUSTAKA 
 

 

Cinar, Onur. 2012. Android Apps With Eclipse; New York: 
Apress. 

Lee, Meng, Wei. 2011. Beginning Android Application 
Development. Canada: Wiley Publishing  

Hashimi, Y. Sayed; Komatineni, Satya. 2009. Pro Android. 
New York: Apress 

Shah, Sanjay; Abd Rahman, Khirulnizam. 2013. Android 
Development Tools for Eclipse. Birmingham: Packt 
Publishing. 

Steele, James; To, Nelson. 2011. The Android Develeper’s 
Cookbook, Building Application with Android SDK. 
Boston: Addison Wesley. 

https://developer.android.com/guide/topics/ui/controls/spinner.
html 

 

 

 



200 
 

RIWAYAT HIDUP PENULIS 

M. Miftakul Amin, S. Kom., M. Eng., 
menyelesaikan pendidikan S1 dan S2 
bidang Software Engineering, saat ini 
merupakan dosen tetap di Jurusan Teknik 
Komputer Politeknik Negeri Sriwijaya 
Palembang. Selain sebagai dosen, penulis 
juga merupakan seorang programmer yang 

cukup berpengalaman mengembangkan perangkat lunak.  

Adi Sutrisman, S. Kom, M. Kom., 
menyelesaikan pendidikan S1 dan S2 
Bidang Sistem Informasi, saat ini 
merupakan dosen tetap di Jurusan Teknik 
Komputer, Politeknik Negeri Sriwijaya 
Palembang.  

 

Deris Stiawan, Ph.D, menyelesaikan 
pendidikan S1, S2 dan S3 Bidang Network 
Engineering, saat ini merupakan dosen 
tetap di Jurusan Teknik Komputer, 
Fakultas Ilmu Komputer, Universitas 
Sriwijaya Palembang.  

 

Dr. Ermatita, menyelesaikan pendidikan 
S1, S2 dan S3 Bidang Ilmu Komputer, saat 
ini merupakan dosen tetap di Jurusan 
Sistem Informasi, Fakultas Ilmu Komputer, 
Universitas Sriwijaya Palembang.  

 
 

 



 

201 
 

 

 

Buku ini mencakup pembahasan antara lain: 

✓ Pengantar Pemrograman Android 

✓ Membuat Project Android 

✓ Manajemen Layout 

✓ Pemrograman GUI dan Event 

✓ Menu dan Dialog 

✓ Activity dan Intent 

✓ Memproses Data Array 

✓ Akses Data MySQL 

 

Pemrograman Aplikasi Mobile 
Menggunakan Eclipse ADT 

Buku ini sangat cocok digunakan 

oleh mahasiswa Teknologi Informasi, Ilmu Komputer, 

Teknik Informatika, Sistem Informasi, Manajemen 

Informatika, Teknik Elektro, dan jurusan lain yang sedang 

atau hendak mempelajari tentang topik pemrograman 

aplikasi Android.  

 

Perangkat lunak yang digunakan untuk pengembangan 

aplikasi mobile dalam buku ini adalah Eclipse, karena telah 

disediakan sebuah bundle aplikasi dimana Eclipse telah 

terintegrasi dengan Android Development Tools (ADT) dan 

Android Sorftware Development Kit (SDK), sehingga 

proses instalasi dan konfigurasi dapat dilakukan dengan 

mudah. Di sisi lain salah satu faktor penting dalam 

pengembangan aplikasi mobile menggunakan Android 

adalah pemahaman terhadap konsep pemrograman 

berorientasi objek dengan bahasa pemrograman Java yang 

menjadi tulang punggung teknik penulisan kode program 

Android.  


